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Safety Notices

Read all product manuals and consult with Beckman Coulter-trained personnel before attempting 
to operate the instrument. Do not attempt to perform any procedure before carefully reading all 
instructions. Always follow product labeling and manufacturer’s recommendations. If in doubt as 
to how to proceed in any situation, contact us.

Beckman Coulter, Inc. urges its customers to comply with all national health and safety standards 
such as the use of barrier protection. This may include, but it is not limited to, protective eyewear, 
gloves, and suitable laboratory attire when operating or maintaining this or any other automated 
laboratory analyzer.

This manual assumes that users have basic knowledge of the Windows operating system, as well as 
experience working with laboratory testing technology. Users are invited to consult the 
appropriate documentation for such information.

Alerts for Danger, Warning, and Caution

DANGER

DANGER indicates an imminently hazardous situation which, if not avoided, will 

result in death or serious injury.

WARNING

WARNING indicates a potentially hazardous situation which, if not avoided, could 

result in death or serious injury.

CAUTION

CAUTION indicates a potentially hazardous situation, which, if not avoided, may 

result in minor or moderate injury. It may also be used to alert against unsafe 

practices.
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Safety Notices

Safety Precautions  
Safety Precautions

WARNING

Risk of operator injury if:

 • All doors, covers and panels are not closed and secured in place prior to and 

during instrument operation.

 • The integrity of safety interlocks and sensors is compromised.

 • Instrument alarms and error messages are not acknowledged and acted upon.

 • You contact moving parts.

 • You mishandle broken parts.

 • Doors, covers and panels are not opened, closed, removed and/or replaced 

with care.

 • Improper tools are used for troubleshooting.

To avoid injury:

 • Keep doors, covers and panels closed and secured in place while the 

instrument is in use.

 • Take full advantage of the safety features of the instrument.

 • Acknowledge and act upon instrument alarms and error messages.

 • Keep away from moving parts.

 • Report any broken parts to your Beckman Coulter Representative.

 • Open/remove and close/replace doors, covers and panels with care.

 • Use the proper tools when troubleshooting.

CAUTION

System integrity could be compromised and operational failures could occur if:

 • This equipment is used in a manner other than specified. Operate the 

instrument as instructed in the Product Manuals.

 • You introduce software that is not authorized by Beckman Coulter into your 

computer. Only operate your system's computer with software authorized by 

Beckman Coulter.

 • You install software that is not an original copyrighted version. Only use 

software that is an original copyrighted version to prevent virus 

contamination.

CAUTION

If you purchased this product from anyone other than Beckman Coulter or an 

authorized Beckman Coulter distributor, and, it is not presently under a Beckman 

Coulter service maintenance agreement, Beckman Coulter cannot guarantee that 

the product is fitted with the most current mandatory engineering revisions or 

that you will receive the most current information bulletins concerning the 

product. If you purchased this product from a third party and would like further 

information concerning this topic, contact us.
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Safety Notices

Symbol Explanations  
CAUTION

Risk of instrument damage. This device is intended for indoor use only. To avoid 

device damage, do not install the instrument outdoors.

WARNING

Risk of personal injury. Safety protection can be impaired if used in a manner not 

specified by the manufacturer. To avoid personal injury, use the instrument 

according to the manufacturer's instructions only.

Symbol Explanations

Symbol Warning Condition Action

Biohazard Symbol Consider all materials (specimens, reagents, 

controls, and monoclonal antibodies) and areas 

these materials come into contact with as being 

potentially infectious.

Wear appropriate barrier protection and follow 

safe laboratory procedures when handling any 

material in the laboratory.

Caution To indicate that caution is necessary when 

operating the device or control close to where 

the symbol is placed, or to indicate that the 

current situation needs operator awareness or 

operator action in order to avoid undesirable 

consequences. 

Caution, Risk of Electric 

Shock

To indicate hazards arising from dangerous 

voltages.

Warning, Sharp 

elements

To warn of sharp element.

Warning, Crushing of 

hands

To warn of a closing motion of mechanical parts 

of equipment.
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Safety Notices

Symbol Explanations  
Recycling Symbol

WEEE Wheeled Bin 

Symbol

The symbol of a crossed-out wheeled bin on the 

product is required in accordance with the 

Waste Electrical and Electronic Equipment 

(WEEE) Directive of the European Union. The 

presence of this marking on the product 

indicates:

1. that the device was put on the European 

Market after August 13, 2005 and 

2. that the device is not to be disposed via the 

municipal waste collection system of any 

member state of the European Union.

For products under the requirement of WEEE 

directive, please contact your dealer or local 

Beckman Coulter office for the proper 

decontamination information and take-back 

program which will facilitate the proper 

collection, treatment, recovery, recycling, and 

safe disposal of device.

For the Japan market:

This system is considered an industrial waste, 

subject to special controls for infectious waste. 

Before disposal of the system, refer to the 

Waste Disposal and Public Cleaning Law for 

compliance procedures.

Laser Radiation The laser radiation symbol indicates that there 

can be laser light radiation in the area. Take 

precautions to prevent exposure.

RoHS Caution Symbol This label indicates that the electronic 

information product contains certain toxic or 

hazardous substances. The center number is 

the Environmentally Friendly Use Period (EFUP) 

date, and indicates the number of calendar 

years the product can be in operation. Upon the 

expiration of the EFUP, the product must be 

immediately recycled. The circling arrows 

indicate the product is recyclable. The date 

code on the label or product indicates the date 

of manufacture. 

Laser Compliance This label indicates that the product is a Class 1 

Laser Product and is in compliance with 

international standard and US requirements.

Laser Class I This label indicates that this product is a Class I 

Laser product. Take precautions to prevent 

exposure.

Symbol Warning Condition Action

CLASS  1 LASER PRODUCCLASS  1 LASER PRODUCT
PRODUIT LASER CLASSE 1
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Safety Notices

Symbol Explanations  
Consider all materials 

(specimens, controls, 

monoclonal antibodies, 

and so forth) as being 

potentially infectious.

Wear standard laboratory attire and follow safe 

laboratory procedures when handling any 

material in the laboratory.

EC Representative Indicates the Authorized representative in the 

European Community.

European Conformity 

(CE Mark) Regulatory 

Mark

A "CE" mark indicates that a product has been 

assessed before being placed on the market, 

and has been found to meet European Union 

safety, health, and/or environmental protection 

requirements.

UKCA Mark A "UKCA" mark indicates that a product has 

been assessed before being placed in UK 

market, and has been found to meet UK safety, 

health, and/or environmental protection 

requirements.

TUV symbol This test mark is proof of compliance with 

Canadian National standards and U.S. National 

standards. It demonstrates an electrical product 

has been successfully tested and certified by a 

Certification Body accredited by the Standards 

Council of Canada (SCC) and by a Nationally 

Recognized Testing Laboratory (NRTL) 

accredited by the Occupational Safety and 

Health Administration (OSHA).

Off (power) To indicate disconnection from the mains, at 

least for mains switches or their positions, and 

all those cases where safety is involved.

On (power) To indicate connection to the mains, at least for 

mains switches or their positions, and all those 

cases where safety is involved.

Fuse To identify fuse boxes or their location

Manufacturer Indicates the medical device manufacturer, as 

defined in EU Directives 90/385/EEC, 93/42/EEC 

and 98/79/EC.

Consult the 

Instructions for Use 

Symbol

Indicates the need for the user to consult the 

instructions for use. 

Symbol Warning Condition Action
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Safety Notices

Symbol Explanations  
Date of Manufacture Indicates the date when the medical device was 

manufactured.

Serial Number Indicates the manufacturer’s serial number so 

that specific medical device can be identified.

Model Number Indicates the model number or type number of 

a product.

RCM Symbol The “RCM” (Regulatory Compliance Mark) is 

depicted as a triangle with a partial circle and 

check. The mark is applied to products that 

comply with the EMC requirements of the 

Australian Communications Media Authority 

(ACMA) for use in Australia and New Zealand.

California Proposition 

65

This product can expose you to chemicals 

known to the State of California to cause Cancer 

and Reproductive Harm. For more information 

go to https://www.P65Warnings.ca.gov.

Symbol Warning Condition Action
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Safety Notices

Electromagnetic Compatibility (EMC)  
Electromagnetic Compatibility (EMC)

This device complies with the emissions and immunity requirements as specified in the EN/IEC 
61326 series of Product Family Standards for a “basic electromagnetic environment”. Such 
equipment is supplied directly at low voltage from public mains network. This equipment is not 
intended for residential use.

CAUTION

This device generates, uses, and can radiate unintentional radio-frequency (RF) 

energy. If this device is not installed and operated correctly, this RF energy can 

cause interference with other equipment. It is the responsibility of the end user to 

be sure that a compatible electromagnetic environment for the device can be 

maintained so that the device operates as intended.

In addition, other equipment can radiate RF energy to which this device is 

sensitive. If one suspects interference between this device and other equipment, 

Beckman Coulter recommends the following actions to correct the interference:

1. Evaluate the electromagnetic environment before installation and operation 

of this device.

2. Do not operate this device close to sources of strong electromagnetic 

radiation (for example: unshielded intentional RF sources), as these can 

interfere with proper operation. Examples of unshielded intentional radiators 

are handheld radio transmitters, cordless phones, and cellular phones.

3. Do not place this device near medical electrical equipment that can be 

susceptible to malfunctions caused by close-proximity to electromagnetic 

fields. 

4. This device has been designed and tested to CISPR 11, Class A emission limits. 

In a domestic environment, this device may cause radio interference, in which 

case, you may need to take measures to mitigate the interference.
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Introduction

Overview

This is an introductory chapter that gives a brief description of each document. It contains the 
following topics presented in this order:

 • How to Use Your Manual

 • About this Manual

 • Conventions

 • Graphics

 • Advancing Your Skills

How to Use Your Manual

Your CytoFLEX mosaic Spectral Detection Module includes the manuals listed below:

 • Use this Instructions for Use manual for information on the day-to-day operation of your 
CytoFLEX flow cytometer equipped with the CytoFLEX mosaic Spectral Detection Module. You 
can find detailed step-by-step procedures for Daily Startup and Quality Control, running 
samples, analyzing data, and performing Startup and Shutdown. This manual also contains 
physical and system specifications, safety and troubleshooting information, as well as 
information about what your CytoFLEX mosaic Spectral Detection Module does and the 
methods guiding operation. It also contains procedures for cleaning and maintenance.

 • The CytoFLEX Platform Instructions for Use manual provides information on the day-to-day 
operation of your CytoFLEX flow cytometer not equipped with a CytoFLEX mosaic Spectral 
Detection Module.

NOTE To switch between Spectral Mode and Conventional Mode, refer to CHAPTER 12, Switching 

between Spectral Mode and Conventional Mode.

About this Manual

The information in the Instructions for Use manual is organized as follows:

CHAPTER 1, System Overview

Provides information regarding the individual components of the CytoFLEX flow cytometer and the 
CytoFLEX mosaic Spectral Detection Module, and the corresponding functions of these 
components.
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Introduction

About this Manual  
CHAPTER 2, Using the CytExpert for Spectral Software

Provides an overview of each aspect of the software’s functions.

CHAPTER 3, Operation Principles

Describes how the instrument measures scattered light and fluorescence as cells pass through the 
laser beam.

CHAPTER 4, Daily Startup

Provides instructions for starting your CytoFLEX flow cytometer equipped with a CytoFLEX mosaic 
Spectral Detection Module and navigating to the sample testing standby state.

CHAPTER 5, Instrument Quality Control and Standardization

Provides instructions for performing daily quality control (QC) on your CytoFLEX flow cytometer 
equipped with a CytoFLEX mosaic Spectral Detection Module to confirm the instrument is working 
correctly and to ensure accurate experimental data measurement. Quality control allows you to 
determine whether your instrument can provide adequate signal strength and precision.

CHAPTER 6, Data Acquisition and Sample Analysis

Provides instructions for operating the instrument, including data acquisition, analyzing and 
exporting results.

CHAPTER 7, Unmixing

Describes how to create an spectral unmixing experiment and automatically calculate unmixing 
values after acquiring the single color data. It also explains how to use these calculations for other 
experiments.

CHAPTER 8, Data Review

Describes how to use the Analysis screen to analyze data that has already been acquired. 

CHAPTER 9, Daily Shutdown

Describes how to keep the instrument in optimal condition through daily cleaning during the 
shutdown procedure.

CHAPTER 10, Troubleshooting

Describes some common problems and their solutions in a basic troubleshooting matrix.

CHAPTER 11, Cleaning Procedures

Describes how to carry out certain routine and nonscheduled cleaning procedures.

CHAPTER 12, Replacement/Adjustment Procedures

Describes how to carry out certain routine and nonscheduled replacement and adjustment 
procedures. 

APPENDIX A, Instrument Installation

Provides the instrument installation procedures for your CytoFLEX flow cytometer.

APPENDIX B, CytExpert for Spectral Electronic Record Management

Provides the instructions for using the CytExpert Electronic Record Management software option.

APPENDIX C, Sample Injection Mode Control Kit

Provides the instructions for using the CytoFLEX Sample Injection Mode Control Kit.
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Introduction

Conventions  
APPENDIX D, Deep Well Plate

Provides a list of deep well plates suggested for use on the Plate Loader DW.

APPENDIX E, Cyber Security

Provides instructions for cyber security.

APPENDIX F, Table of Hazardous Substances

Provides the table of hazardous substances with the hazardous substance name and concentration.

Conventions

This document uses the following conventions:

 • Bold face font indicates buttons or selections that appear on the workstation screen.

 • The term “select” is used to indicate the following action:

— To click with a mouse.

NOTE The verb “press” is reserved for mechanical buttons, such as keys on the keyboard.

 • The software path to a specific function or screen appears with the greater than (>) symbol 
between screen options.

 • Links to information in another part of the document for additional information are in blue and 
are underlined. To access the linked information, select the blue, underlined text.

 • The information in your Instructions for Use manual applies to the CytoFLEX S instruments 
equipped with and without a plate loader, and the CytoFLEX LX, unless otherwise specified.

NOTE When information in this document only applies to the plate loader configuration, it is marked 

[With Plate Loader]. When information in this document only applies to the configuration not 

equipped with a plate loader, it is marked [Without Plate Loader]. 

When information in this document only applies to one instrument in the platform, it is marked either 

[CytoFLEX S] or [CytoFLEX LX]. 

When information in this document only applies to the CytoFLEX mosaic Spectral Detection Module, 

it is marked [CytoFLEX mosaic Spectral Detection Module]. When information in this document only 

applies to one type of the CytoFLEX mosaic Spectral Detection Module, it is marked either [CytoFLEX 

mosaic 63] or [CytoFLEX mosaic 88]. 

NOTE There are two kinds of plate loaders, the standard CytoFLEX Plate Loader and the CytoFLEX Plate 

Loader Deep Well (DW). The CytoFLEX Plate Loader DW (hereinafter called as Plate Loader DW) is 

compatible with CytoFLEX S and CytoFLEX LX instruments. When information in this document only 

applies to one plate loader, it is marked either [Plate Loader DW] or [Standard Plate Loader].

 • The CytExpert for Spectral Electronic Record Management software installation screens are 
shown in all instances unless otherwise specified.
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Graphics  
IMPORTANT IMPORTANT is used for comments that add value to the step or procedure being performed. 

Following the advice in the IMPORTANT adds benefit to the performance of a piece of equipment or to a 

process.

NOTE NOTE is used to call attention to notable information that should be followed during use, or 

maintenance of this equipment.

Graphics

All graphics, including screens and printouts, are for illustration purposes only and must not be 
used for any other purpose. For example, software screens that show the CytoFLEX for Spectral 
software in the background may not depict the latest production version of the system.

Advancing Your Skills

To learn more about using your CytoFLEX mosaic Spectral Detection Module system, e-Learnings 
are available through the Beckman Coulter Learning Center.

 • Instructor-Led Coursed

— CytoFLEX mosaic In-Person Training

— CytoFLEX mosaic Remote Training

 • E-Learning Modules 

— CytoFLEX mosaic Basic Operator Training

For further information about the available courses, visit the Beckman Coulter Learning Center at 
http://www.beckman.com/service/training, and enter CytoFLEX mosaic in the Search field or 
contact us.
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CHAPTER 1

System Overview

Overview

This chapter describes the individual components of the CytoFLEX flow cytometer, CytoFLEX 
mosaic Spectral Detection Module and the corresponding functions of these components. 

This chapter contains information on:

 • Product Description

 • Main Components

 • Optical Components

 • Fluidics System

 • Sample Station

 • Plate Loader Components

 • System Configuration

 • Consumables and Supplies

 • Instrument Specifications

 • Performance Characteristics

 • Reagent Limitations

 • Safety Data Sheets (SDS/MSDS)

Product Description

The CytoFLEX mosaic Spectral Detection Module is an optional accessory which can be attached to 
the CytoFLEX S and CytoFLEX LX flow cytometers to switch the cytometers from Conventional 
Mode to Spectral Mode. Spectral Mode enables the spectral flow functionality and allows users to 
run more complex assays and use spectral unmixing technology for spectral overlap correction.

The CytoFLEX S and CytoFLEX LX flow cytometers equipped with a CytoFLEX mosaic Spectral 
Detection Module are used for the qualitative and quantitative measurement of biological and 
physical properties of cells and other particles. These properties are measured when the cells pass 
through one or multiple laser beams in a single-file.

For Research Use Only. Not for use in diagnostics procedures.
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System Overview

Main Components  
Main Components

CAUTION

Risk of instrument damage and/or instrument stability. Do not place any objects 

on top of the instrument, as this could cause warping of the top cover or affect the 

stability of the optical path. 

The instrument consists of four main components: Fluid Containers/Cubitainers, Cytometer, the 
Workstation and CytoFLEX mosaic Spectral Detection Module.

Figure 1.1  Main Components [CytoFLEX S Without Plate Loader] 

1. CytoFLEX mosaic 63. Provides signal collection with up to 63 channels using a CytoFLEX S 

configuration. 

NOTE To switch between Spectral Mode and Conventional Mode, refer to CHAPTER 12, Switching 

between Spectral Mode and Conventional Mode.

NOTE Refer to the CytoFLEX Platform Instructions for Use manual if the instrument is being used 

without the CytoFLEX mosaic Spectral Detection Module connected.

2. Fluid Containers. Accommodates sheath fluid and waste liquid as required for operation of the 

instrument.

3. Cytometer. Provides signal generation.

4. Workstation. Displays the content of the workstation and data generated by the Cytometer.

Sheath SheathWaste
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System Overview

Main Components  1
Figure 1.2  Main Components [CytoFLEX LX]

1. CytoFLEX mosaic 88. Provides signal collection with up to 88 channels using a CytoFLEX LX configuration. 

NOTE To switch between Spectral Mode and Conventional Mode, refer to CHAPTER 12, Switching between Spectral 

Mode and Conventional Mode.

NOTE Refer to the CytoFLEX Platform Instructions for Use manual if the instrument is being used without the 

CytoFLEX mosaic Spectral Detection Module connected.

2. Cytometer. Provides signal generation.

3. Fluid Cubitainers. Accommodates sheath fluid and waste liquid as required for operation of the instrument.

NOTE The CytoFLEX LX does not have a fluid container holder.

4. Workstation. Displays and manipulates the contents of the Workstation and displays data generated by the 

Cytometer.

Cyto FLEX

Sheath Fluid
D17052AA   1-3



System Overview

Optical Components  
Optical Components

NOTE If you are using Conventional Mode, refer to the CytoFLEX Platform Instructions for Use manual, 

CHAPTER 1, Optical Components for detailed instructions.

NOTE To switch between Spectral Mode and Conventional Mode, refer to CHAPTER 12, Switching between 

Spectral Mode and Conventional Mode.

Wavelength Division Multiplexer (WDM)

Each WDM corresponds to a different laser, or in some cases two lasers. The WDMs are contained 
within the CytoFLEX mosaic Spectral Detection Module and cannot be altered to change filter 
configuration. Note that the CytoFLEX S equipped with a CytoFLEX mosaic 63 allows for up to 63 
channel while the CytoFLEX LX equipped with a CytoFLEX mosaic 88 allows for 88 channels.

NOTE If you are using Conventional Mode, refer to the CytoFLEX Platform Instructions for Use manual, 

CHAPTER 1, Wavelength Division Multiplexer (WDM) for detailed instructions.

NOTE To switch between Spectral Mode and Conventional Mode, refer to CHAPTER 12, Switching between 

Spectral Mode and Conventional Mode.

Optical Fiber

CAUTION

Risk of data integrity damage.

 • During use, verify that the optical fibers are securely connected between the 

fiber intake bracket at the back of the instrument and the back of the 

CytoFLEX mosaic Spectral Detection Module. A loose connection can alter the 

optical path and affect fluorescence detection.

 • Take care when disconnecting the fibers as this could contaminate the tip and 

weaken the signal. Always ensure the fiber is reconnected right away. 

 • Do not kink the optical fibers.

NOTE If you are using Conventional Mode, refer to the CytoFLEX Platform Instructions for Use manual, 

CHAPTER 1, Optical Fiber for detailed instructions.

NOTE To switch between Spectral Mode and Conventional Mode, refer to CHAPTER 12, Switching between 

Spectral Mode and Conventional Mode.
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System Overview

Optical Components  1
Fluorescence emitted by laser-excited fluorochromes is picked up and delivered by each optical 
fiber to the corresponding detector module. CytoFLEX S optical fiber has a colored ring on the end 
that connects to the WDM, indicating the color of the corresponding laser. CytoFLEX LX optical 
fiber has a numbered label on the end that connects to the WDM, indicating the number of the 
corresponding laser. Ensure that the correct fiber is properly connected to the corresponding 
WDM.

1. Violet laser fiber

2. NUV or UV laser fiber

3. Red laser fiber

4. Yellow laser fiber

5. Blue laser fiber

6. Infrared laser fiber
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System Overview

Fluidics System  
Fluidics System

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 1, Fluidics System for detailed 
instructions.

Fluid Containers/Cubitainers

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 1, Fluid Containers/Cubitainers 
for detailed instructions.

Fluidics Module

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 1, Fluidics Module for detailed 
instructions.

Sample Station

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 1, Sample Station for detailed 
instructions.

Sample Tube Holder Positions

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 1, Sample Tube Holder 
Positions for detailed instructions.

Plate Loader Components

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 1, Plate Loader Components for 
detailed instructions.

Plate Holder Components

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 1, Plate Holder Components for 
detailed instructions.
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System Configuration  1
System Configuration

CAUTION

Risk of data loss and/or instrument damage. Never shut off the power or 

disconnect a data cable while the instrument is in the process of performing a 

task. This could cause data loss or damage to the system.

System Configuration [CytoFLEX S]

Figure 1.3  System Connections

1. Monitor

2. Mouse

3. Keyboard

4. Computer

5. Cytometer

6. Fluid Container holder

7. CytoFLEX mosaic 63

FSC5 4 3 1
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System Overview

System Configuration  
Figure 1.4  Power Entry Module

Figure 1.5  Front of Cytometer [CytoFLEX S Without Plate Loader Shown]

1. Power switch. Turns Cytometer on and off. An indicator light glows when the power is on. 

2. Fuse. Protects the internal system from damage by high electrical current.

3. Power line socket. Supplies the power to the Cytometer.

1. Load button. In addition to the software controls, this button can be used for automatic sample loading 

and data recording.

NOTE This function is not available in the Plate Loader sample injection mode.

FSC5 4 3 1

WARNING
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System Overview

System Configuration  1
System Configuration [CytoFLEX LX]

IMPORTANT The fluid cubitainers must be on the same level as the Cytometer. Do not place the fluid 

cubitainers on the floor.

Figure 1.6  System Connections

1. Monitor

2. Keyboard

3. Mouse

4. Computer

5. Cytometer

6. Fluid Cubitainers

7. CytoFLEX mosaic 88

电压：100-240VAC
频率：50Hz/60Hz

WARNING

REACTIVE INGREDIENTS: Anti-microbial compound

A nonionic, non-flourescent, and azide free sheath fluid 
for use on Beckman Coulter CytoFLEX flow cytometers.

10 L

Cyto FLEX
Sheath Fluid
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System Overview

System Configuration  
Figure 1.7  Power Input Module

Figure 1.8  Front of Cytometer

1. Power switch. Turns Cytometer on and off. An indicator light glows when the power is on. 

2. Fuse. Protects the internal system from damage by high electrical current.

3. Power line socket. Supplies the power to the Cytometer.

1. Load button. In addition to the software controls, this button can be used for automatic sample loading 

and data recording.

NOTE This function is not available in the Plate Loader sample injection mode.

电压：100-240VAC
频率：50Hz/60Hz

WARNING

b
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System Overview

System Configuration  1
System Configuration [CytoFLEX mosaic Spectral Detection Module]

Figure 1.9  Front and Left Sides of the CytoFLEX mosaic Spectral Detection Module

1. Soft button. In addition to the Turn Off CytoFLEX mosaic in the Cytometer menu on the software, this 

button can be used to turn the CytoFLEX mosaic Spectral Detection Module on/off. An indicator light 

glows when the power is on. 

NOTE To fully remove the instrument from power, the power switch on the left side of the instrument 

must be in the off position.

2. Power switch. Turns the CytoFLEX mosaic Spectral Detection Module on and off. An indicator light 

glows when the power is on. 

3. Power line socket. Supplies the power to the Cytometer.

100-240V~50/60Hz

T 5A L250VAC
D17052AA   1-11



System Overview

Consumables and Supplies  
Figure 1.10  Back Cover Connections of the CytoFLEX mosaic Spectral Detection Module

Consumables and Supplies

Reagents

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 1, Reagents for detailed 
instructions.

NOTE The CytoFLEX Daily QC Fluorospheres are not intended to be used with the CytoFLEX mosaic Spectral 

Detection Module.

Ordering Information

Your instrument may be upgraded to a more highly configured model. For information on specific 
upgrades, replacement parts, or supplies, visit: 

 • www.beckman.com/supplies/cytoflex-platform-upgrades

 Otherwise, contact us.

1. Optical fiber connectors. Connects to the optical fibers.

2. Ethernet connector. Connects to the Ethernet cable of the workstation.

3. FSC cable connector. Connects to the FSC cable.

3

6
4
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2

5

100-2
40V~

50/60H
z

T 5A L
250VA

C
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Instrument Specifications  1
Instrument Specifications

Dimensions [CytoFLEX S]

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 1, Dimensions [CytoFLEX S] for 
detailed instructions.

Dimensions [CytoFLEX LX]

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 1, Dimensions [CytoFLEX LX] 
for detailed instructions.

Dimensions [CytoFLEX mosaic Spectral Detection Module]

Installation Category

Installation Category 2

Maximum Altitude

Do not operate at an altitude greater than 2000 m (6561 ft). Beckman Coulter assumes no 
responsibility for any problems resulting from operating instrument at an altitude greater than 
2000 m (6561 ft).

Pollution Degree

Pollution Degree 2

Acoustic Noise Level

Measure Level: <65 dBA

Dimensions

Instrument 

dimensions (Length x 

Width x Height)

CytoFLEX mosaic 63 42.5 cm x 34.5 cm x 53.5 cm

CytoFLEX mosaic 88 42.5 cm x 34.5 cm x 53.5 cm

Weight CytoFLEX mosaic 63 30 kg

CytoFLEX mosaic 88 33 kg
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Instrument Specifications  
Electrical Ratings

Voltage: AC 100-240 V ± 10%

Frequency: 50/60 Hz 

Power:

 • CytoFLEX mosaic Spectral Detection Module: 450 VA

 • CytoFLEX S: 250 VA

 • CytoFLEX LX: 300 VA

Cytometer

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 1, Cytometer for detailed 

instructions.

CytoFLEX mosaic Spectral Detection Module

Optics

Excitation optics The optical system is alignment free. The laser delays are automatically 

adjusted by the daily QC system, if required. No user intervention is 

required to ensure optimum system performance.

CytoFLEX S: The system can be configured with up to four 

spatially-separated lasers. 

CytoFLEX LX: The system can be configured with up to six 

spatially-separated lasers. 

Emission optics Alignment-free integrated optics quartz flow cell design with >1.3 NA.

Flow Cell dimensions: 430 μm x 180 μm internal diameter.
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Instrument Specifications  1
Laser devices CytoFLEX S standard 

wavelengths

Violet laser

 • Wavelength: 405 nm, 80 mW

 • Beam spot size: 5 μm x 80 μm

Blue laser

 • Wavelength: 488 nm, 50 mW

 • Beam spot size: 5 μm x 80 μm

Yellow laser

 • Wavelength: 561 nm, 30 mW

 • Beam spot size: 5 μm x 80 μm

Red laser

 • Wavelength: 638 nm, 50 mW

 • Beam spot size: 5 μm x 80 μm

CytoFLEX LX standard 

wavelengths

Ultraviolet (UV) laser

 • Wavelength: 355 nm, 20 mW

 • Beam spot size: 5 μm x 80 μm

Near Ultraviolet (NUV) laser

 • Wavelength: 375 nm, 60 mW

 • Beam spot size: 5 μm x 80 μm

Violet laser

 • Wavelength: 405 nm, 80 mW

 • Beam spot size: 5 μm x 80 μm

Blue laser

 • Wavelength: 488 nm, 50 mW

 • Beam spot size: 5 μm x 80 μm

Yellow laser

 • Wavelength: 561 nm, 30 mW

 • Beam spot size: 5 μm x 80 μm

Red laser

 • Wavelength: 638 nm, 50 mW

 • Beam spot size: 5 μm x 80 μm

Infrared (IR) laser

 • Wavelength: 808 nm, 60 mW

 • Beam spot size: 5 μm x 80 μm

Forward scatter detection Silicon photodiode with built-in 488/8 band-pass filter.

Fluorescence and side 

scatter detection

Fluorescence and side scatter light collected by the objective lens is 

delivered by fiber optics to a patent-pending design with high 

performance, solid-state, high efficiency, low-noise detector array.

Reflective optics with a single transmission band-pass filter in front of each 

detector.

Side scatter (SSC) 

configuration 

The system offers the ability to collect side scatter lights from each laser 

to better resolve particles from noise.

Optics
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Performance Characteristics

Performance Characteristics [CytoFLEX S]

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 1, Performance Characteristics 
[CytoFLEX S] for detailed instructions.

Performance Characteristics [CytoFLEX LX]

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 1, Performance Characteristics 
[CytoFLEX LX] for detailed instructions.

Electronics

Signal processing 7 decade data display

Digital sampling rate 6.25 MHz

Signal Pulse area and height for every channel, width for two selectable channels

Data Management 

Software CytExpert for Spectral software

Language English

FCS format FCS 3.1 and FCS 3.0 

Operating system Windows 10 Enterprise LTSC 2019 64 bit

Minimum 

workstation/

computer 

requirements 

[CytoFLEX S and 

CytoFLEX LX]

Processor Intel Core i7-11700K Processor, 3.6GHz

Memory 64 GB RAM

Storage 1 TB SSD

Ethernet 2 Ethernet interface

USB 4 USB 3.0 ports

Monitor resolution 1920 x 1080 or 2560 x 1440
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Performance Characteristics [CytoFLEX mosaic Spectral Detection Module]

Performance

Sensitivity MESF FITC: <30 molecules of equivalent soluble fluorochrome 

(MESF-FITC) 

PE: <10 molecules of equivalent soluble fluorochrome 

(MESF-PE) 

PB450: <50 molecules of equivalent soluble 

fluorochrome (MESF-PB450)

APC: <25 molecules of equivalent soluble fluorochrome 

(MESF-APC) 

Fluorescence 

detection 

configuration 

Detection range Ultraviolet (UV) laser: 

 • Detectors: 20

 • Wavelength: 365-950 nm

Near Ultraviolet (NUV) laser

 • Detectors: 18

 • Wavelength: 420-950 nm

Violet laser: 

 • Detectors: 20

 • Wavelength: 420-950 nm

Blue laser: 

 • Detectors: 16

 • Wavelength: 498-950 nm

Yellow laser: 

 • Detectors: 12

 • Wavelength: 567-950 nm 

Red laser:

 • Detectors: 10

 • Wavelength: 649-950 nm

Infrared (IR) laser: 

 • Detectors: 3

 • Wavelength: 830-950 nm

Fluorescence 

detection

Up to 79 fluorescent detectors are designed to cover a broad wavelength of 

spectrum

Fluorescence 

resolution

rCV <3%

The CytoFLEX Flow cytometer is capable of achieving <3% rCV. Using CytoFLEX 

Daily QC Fluorospheres, CytoFLEX Ready to Use Daily QC Fluorospheres or Daily 

IR QC Fluorospheres (for 808 nm Laser) for daily QC, the pass criteria is ≤5% for 

the Violet, Blue, Yellow, and Red lasers while the pass criteria is ≤7% for NUV, UV 

and IR lasers.
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Reagent Limitations

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 1, Reagent Limitations for 
detailed instructions.

Safety Data Sheets (SDS/MSDS)

To obtain an SDS or MSDS for CytoFLEX Platform reagents used on the CytoFLEX Platform systems:

1. On the Internet, go to www.beckman.com:
a. Select Safety Data Sheets (SDS/MSDS) from the Support menu.
b. Follow the instructions on the screen.
c. Contact us if you have difficulty locating the information.

2. If you do not have Internet access, contact us.

Blue/Yellow/Red/

Infrared/Ultraviolet/

Near Ultraviolet side 

scatter resolution

<300 nm

Violet side scatter 

resolution

80 nm relative to polystyrene particles

Forward and blue side 

scatter resolution

Scatter performance is optimized for resolving lymphocytes, monocytes, and 

granulocytes as well as nanoparticles.

Carryover Single Tube Loader 

format

≤1.0%

Signal acquisition 

speed

30,000 events/second

Performance
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CHAPTER 2

Using the CytExpert for Spectral Software

Overview

The CytExpert for Spectral software is a full-feature software package that controls the instrument 
operation, collection of experiment data, and analysis of the results. This chapter will explain the 
software functions and features.

NOTE The CytExpert for Spectral software only applies to the CytoFLEX S and CytoFLEX LX instruments 

equipped with the CytoFLEX mosaic Spectral Detection Module. If your CytoFLEX instrument is not 

equipped with a CytoFLEX mosaic Spectral Detection Module or if you are using Conventional Mode, 

please use the CytExpert software. Refer to the CytoFLEX Platform Instructions for Use manual for 

detailed instructions on using the CytExpert software.

IMPORTANT The CytExpert software and the CytExpert for Spectral software can be installed on the same 

computer, but you cannot use the CytExpert for Spectral software and the CytExpert software together.

This chapter contains information on:

 • Launching the Software

 • Main Software Screen

 • User Management

 • Role Management

 • Account Policies

 • User Management Operation Log

 • Graphic and Gating Styles

 • Software Settings

Launching the Software

Select the desktop shortcut  to launch the CytExpert for Spectral software.

If there is no desktop shortcut, run the “CytExpert.exe” software directly from the software 
installation directory. The default installation path is C:/Program Files/CytExpert for Spectral. Or, 

select > All Programs > CytExpert for Spectral.

Refer to CHAPTER 4, Logging into the Software, for detailed instructions on opening the software 
and confirming the connection status.
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Using the CytExpert for Spectral Software

Main Software Screen  
Main Software Screen

Hover your cursor over any button to display a text pop-up of the button’s function. 

Start Page

The login window automatically opens after the software has been launched. The start page 
automatically opens after logging into the software.
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Using the CytExpert for Spectral Software

Main Software Screen  2
The following operations can be selected from the start page:

 • New Experiment. For creating a new experiment. The process creates a file with the .xit 
extension and a folder with the same file name where the data (.fcs files) are kept.

 • New Experiment from Template. For creating an experiment using a template saved from a 
previously saved experiment.

 • New Spectral Unmixing. For creating a new spectral unmixing experiment. The process creates 
a file with the .xitsp extension and a folder with the same file name where the data (.fcs files) 
are kept.

 • Open Experiment. For opening a previously created experiment.

 • Open Spectral Unmixing. For opening a previously created spectral unmixing experiment.

 • Exit. For exiting CytExpert for Spectral.

The Experiment, Template, and Spectral Unmixing tabs below give you the option of opening one 
of the 10 most recently opened experiments.
D17052AA   2-3



Using the CytExpert for Spectral Software

Main Software Screen  
Acquisition Screen

Selecting New Experiment, New Experiment from Template, or Open Experiment automatically opens 

the Acquisition screen. The Acquisition screen can be accessed by selecting  on the left side of 
the page.

1. Navigation. Gives the option of accessing the Acquisition screen or Analysis screen.

2. Menu. Allows you to configure settings for sample acquisition, instrument operation, and software 

options.

3. Instrument operation controls. Controls sample loading/unloading and data acquisition and 

recording.

4. Collection. Establishes control over data recording options, displays the acquisition status, and 

controls the sample flow rate.

5. Test tubes. Allows you to configure and duplicate sample tubes, set display attributes, manage 

experimental data and unmixing.

NOTE The Tube section of the screen can be expanded or retracted by dragging the top border of 

the Tube section of the screen. Expanding this section covers other elements of the screen, 

including: Events to Display, Events/Sec, and the Acquisition buttons.

6. Plot area. Includes plot and gating controls, as well as an area for creating plots and generating 

graphs. There are two worksheets display in this area, Raw worksheet and Unmixed worksheet.

7. Status bar. Displays instrument connection status and system information.
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Acquisition Screen Navigation

The Acquisition screens have two navigation icons, one for the Acquisition screen and the other for 
the Analysis screen.

1. Acquisition screen icon. Accesses the Acquisition screen.

2. Analysis screen icon. Accesses the Analysis screen.
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Collection

Standby state Initialized state

1. Acquisition control. Controls sample loading/unloading and data acquisition and recording.

2. Acquisition status. Displays such information as the acquisition rate (Events/Sec), event count, 

duration, and abort (%).

3. Acquisition conditions. Sets the necessary conditions for recording data.

4. Sample flow rate. Sets the acquisition rate for data collection.

NOTE High acquisition rate may increase the abort rate and measurement CVs.

Custom: The flow rate can be adjusted in 1 μL increments.
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Collection [With Plate Loader]

Standby state Initialized state

1. Acquisition control. Controls sample loading/unloading and data acquisition and recording.

2. Acquisition status. Displays such information as the acquisition rate (Events/Sec), event count, 

duration, and abort (%).

3. Acquisition conditions. Sets the necessary conditions for recording data.

4. Sample flow rate. Sets the acquisition rate for data collection.

NOTE High acquisition rate may increase the abort rate and measurement CVs.
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Test Tubes

1. Tube management controls. Manages sample tubes. Used to add, copy, or delete attributes, and 
open the tube property.

2. Test tube status indication. Displays a colored symbol in front of each tube indicating the status 
of the tube processing.

 •  indicates that the tube data was not acquired.

 •  indicates that the tube data was acquired by selecting Run, and the tube data can be 
overwritten.

 •  indicates that the tube data was acquired by selecting Record or Auto Record, and the 
tube data cannot be overwritten.

 •  indicates that the tube data was imported from FCS file.

 •  indicates that the tube data was not acquired, and the unmixed data was imported from 
FCS file.

 •  indicates that the tube data imported from FCS file is damaged.

 •  indicates that the tube data was not acquired, and the unmixed data imported from FCS 
file is damaged.

 •  indicates that tube data was not acquired, and was linked to the Acquisition Catalog.

 •  indicates that the tube data was acquired by selecting Run, and was linked to the 
Acquisition Catalog. 

 •  indicates that the tube data was acquired by selecting Record or Auto Record, and was 
linked to the Acquisition Catalog. 

 •  indicates that the tube data was acquired by selecting Run, and the tube data was 
saturated.

Manual/Semi-Automatic Sample Injection Mode Plate Loader Sample Injection Mode Test Tube Status
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 •  indicates that the tube data was acquired by selecting Record or Auto Record, and the 
tube data was saturated.

NOTE In spectral unmixing experiments,  to the right of the test tube status indication symbol 

indicates that there is an unmixing gap.

NOTE Icons to the left of the test tube status indication symbol indicates the test tube’s unmixing and 

fine adjustment status.

 •  indicates that the tube data does not contain the unmixing matrix. 

 • indicates that the unmixing matrix was not applied to the tube.

 •  indicates that the unmixing matrix and fine adjustment matrix were not applied to the tube.

 •  indicates that the unmixing matrix was applied to the tube, but the unmixing matrix is 

missing.

 •  indicates that the unmixing matrix and fine adjustment matrix were applied to the tube, 

but the unmixing matrix is missing.

 • indicates that the unmixing matrix was applied to the tube.

 •  indicates that the unmixing matrix and fine adjustment matrix were applied to the tube.

3. Test tube list. Displays the sample tubes used in the experiment. Right-click a tube in the list to 
perform additional operations.

NOTE In the Plate Loader Sample Injection mode the well number displays at the end of the tube name.

Test Tube Management Module

NOTE The  is only available if the CytExpert for Spectral User Management software option is installed. 

Select  to open a previously created experiment.

New Experiment Test Tube Management Module [Manual/Semi-Automatic Sample Injection Mode]

New Experiment Test Tube Management Module [Plate Loader Sample Injection Mode]

New Spectral Unmixing Experiment Test Tube Management Module [Manual/Semi-Automatic Sample 

Injection Mode]
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New Spectral Unmixing Experiment Test Tube Management Module [Plate Loader Sample Injection 

Mode]

Plot Area

The CytExpert for Spectral software supports two types of worksheets, Raw worksheet and 
Unmixed worksheet. Select the Raw or Unmixed tab in the bottom of the screen to switch between 
worksheets. Refer to Figure 2.1 and Figure 2.2.

Figure 2.1  Plot Area [Raw Worksheet Shown]

1. Plot controls. For creating single or multiple plots, such as dot plots, histograms, density plots, 
pseudo color plots, contour plots and spectrum plots.

2. Statistics and hierarchy controls. For creating statistical and hierarchical charts.

3. Graphical gating controls. For creating graphical gates.

4. Zoom controls. For zooming in and out within a plot.

5. Pan axis display controls. For scaling axis ranges in the plots.

6. Gain adjustment control. For increasing and lowering gain adjustments on the plots.

NOTE The gain adjustment control only works when a sample is running.

7. Threshold control. For setting the minimum particle size limit, scatter value, or fluorescence 
intensity that acquisition will allow.
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8. Undo and redo controls. For undoing or redoing an action in the drawing area.

9. Display controls. For controlling how plots and tables are aligned and arranged.

10. Rearrange. For restoring the plots to the default positions.

11. Printing controls. For printing and previewing the plot area.

12. Plot area. For creating plots and displaying statistics and hierarchy tables.

13. Raw worksheet. For editing and displaying raw data, and exporting or printing the results.

14. Unmixed worksheet. For editing and displaying unmixed data, and exporting or printing the 
results.

Figure 2.2  Plot Area [Unmixed Worksheet Shown]

1. Plot controls. For creating single or multiple plots, such as dot plots, histograms, density plots, 
pseudo color plots, and contour plots.

2. Statistics and hierarchy controls. For creating statistical and hierarchical charts.

3. Graphical gating controls. For creating graphical gates.

4. Zoom controls. For zooming in and out within a plot.

5. Pan axis display controls. For scaling axis ranges in the plots.

6. Auto scaling control. For scaling axis ranges in the plots automatically.

7. Fine Adjustment control. For using fine adjustment functions.

8. Undo and redo controls. For undoing or redoing an action in the drawing area.

9. Display controls. For controlling how plots and tables are aligned and arranged.

10. Rearrange. For restoring the plots to the default positions.

11. Printing controls. For printing and previewing the plot area.
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12. Plot area. For creating plots and displaying statistics and hierarchy tables.

13. Raw worksheet. For editing and displaying raw data, and exporting or printing the results.

14. Unmixed worksheet. For editing and displaying unmixed data, and exporting or printing the 
results.

Status Bar

1. Communication connection status. Displays whether the Cytometer and the Workstation are 
connected. 

2. Instrument status information. Displays the status of the Cytometer.

3. CytoFLEX mosaic status information. Displays the status of the CytoFLEX mosaic Spectral 
Detection Module.

4. Sampler status. Displays the sample injection mode state. There are two sample injection 
modes: Semi-automatic sample injection mode and manual sample injection mode. 

NOTE CytoFLEX Cytometers equipped with a plate loader have three sample injection modes: 

Semi-automatic sample injection mode, manual sample injection mode, and plate loader sample 

injection mode.

5. Fluid status information. Displays the liquid level of the Fluid Containers/Cubitainers.
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Analysis Screen

The Analysis screen is similar to the Acquisition screen, without the acquisition control modules.

NOTE Only the unmixed data can be analyzed in the analysis screen.

The Tube management module cannot add new sample tubes. Return to the Acquisition screen to 
add new sample tubes.

Tube Management

NOTE The  is only available if you have the User Management software option installed. Select  to 

open a previously created experiment.
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Drawing controls (see Figure 2.3) include the multi-data histograms and graphical display data 
controls.

Figure 2.3  Drawing Controls Toolbar (Top of Screen)

Spectral Unmixing Experiment Screen

The Spectral Unmixing Experiment screen appears when you open or create a new Spectral 
Unmixing experiment.

Plots
Scale

Statistics
Auto Scaling

Hierarchy
Fine Adjustment

Gates
Select Sample

Zoom
Undo/Redo

1. Tube management. Displays sample tubes required for the spectral unmixing experiment.

NOTE The Tube management section of the screen can import saved data (.fcs) files for 

computational purposes.

2. Plot area. Displays plots and spectrum plot used for preview, and unmixing plots and gating.

NOTE When the unmixing matrix is generated and applied, unmixing plots appear.
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Spectral Unmixing Controls

The control area includes the spectral unmixing controls, coordinate pan axis display controls, gain 
adjustment controls, fine adjustment controls, and the undo and redo controls. The spectral 
unmixing controls gives you the option of calculating the spectral unmixing value, displaying the 
spectral unmixing matrix, or changing the spectral unmixing parameters.

Spectral Unmixing Adjust Gain

Unmixing Matrix Threshold

Spectral Unmixing Setup
Auto Fine 

Adjustment

Zoom
Fine 

Adjustment

Pan Undo/Redo

Single Side Pan Alignment

Auto Scaling Print
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QC Experiment Screen

The Quality Control (QC) Experiment screen appears when you access a QC experiment.

QC Report Screen

Before starting the QC routine, a Settings screen appears.

Figure 2.4  QC Report Screen

1. Menu. Allows you to configure settings related to QC experiments.

2. Acquisition control. Controls sample loading/unloading and data recording. 

3. Lot selection. Allows you to select the lot number of the QC reagent. 

4. QC results list area. Displays the time and results of completed QC runs. 

5. QC reports area. Displays detailed reports for the selected QC experiment.
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QC Experiment Screen

When acquiring QC samples, the software opens the QC screen.

QC Screen Navigation

The Analysis screens have two navigation icons, one for the QC screen and the other for the 
Levey-Jennings (LJ) charts. Refer to CHAPTER 5, Creating Levey-Jennings Charts.

1. QC experiment progress indicator. Displays the QC stage.

2. Plot area. Displays the QC plots.

1. QC screen icon. Accesses the QC screen.

2. LJ screen icon. Accesses the Levey-Jennings (LJ) screen.

c

b
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Software Menu

The CytExpert for Spectral software contains the following selectable menu items:

Figure 2.5  Software Menu Tree* 

* The menu options for File, Cytometer, Settings, and QC/Standardization change when you select Start QC/

Standardization. Refer to Figure 2.6.

✝ Boost is only active in the Manual Sample Injection mode.

‡ Plate Type Library is only an option if the Plate Loader module is installed and the Plate Loader Sample Injection mode 

is selected.

** Plate Loader is only an option if the Plate Loader module is installed.

*** Only available when the spectral unmixing experiment is open.

†† Only available when a standard experiment is open.

‡‡ These options are only available if the CytExpert for Spectral Electronic Record Management software option is 

installed.

††† These options are only available on the CytoFLEX LX flow cytometer.

The  icon is hyper linked to the Cytobank spotlight page where you can login to the Cytobank Premium 

server, request a 30-day free trial and access additional information. The Cytobank platform allows you to analyze, 

manage, and securely share flow cytometry data. FCS files can be uploaded to the platform with the related 

attachments such as PDF files. 
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Figure 2.6  QC Software Menu Tree

✝ Boost is only active in the Manual Sample Injection mode.

‡ Plate Type Library is only an option if the Plate Loader module is installed and the Plate Loader Sample Injection mode 

is selected.

** Plate Loader is only an option if the Plate Loader module is installed.

‡‡ These options are only available if the CytExpert for Spectral Electronic Record Management software option is 

installed.

††† These options are only available on the CytoFLEX LX flow cytometer.

The  icon is hyper linked to the Cytobank spotlight page where you can login to the Cytobank Premium 

server, request a 30-day free trial and access additional information. The Cytobank platform allows you to analyze, 

manage, and securely share flow cytometry data. FCS files can be uploaded to the platform with the related 

attachments such as PDF files. 
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Acquisition and Analysis Screen Menu

File Menu

For creating new experiments, opening existing experiments, saving new experiments and data, 
and importing/exporting FCS data files.

CytExpert for Spectral - User Management 

CytExpert for Spectral - Electronic Record Management

User Management Electronic Record Management
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Cytometer Menu

For configuring Cytometer settings and controlling Cytometer functions. Depending on the 
Cytometer state, certain functions may not be available.

NOTE The Turn On, Turn Off, Turn On CytoFLEX mosaic and Turn Off CytoFLEX selections are only 

available on the CytoFLEX LX.

NOTE If the software restarts, the Turn On CytoFLEX mosaic selection is not available when the Cytometer 

is on and the CytoFLEX mosaic Spectral Detection Module is off.

Cytometer On and CytoFLEX 

mosaic Spectral Detection 

Module On

Cytometer On and CytoFLEX 

mosaic Spectral Detection 

Module Off

Cytometer On and CytoFLEX 

mosaic Spectral Detection 

Module Power Off
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Cytometer Off and CytoFLEX 

mosaic Spectral Detection 

Module On

Cytometer Off and CytoFLEX 

mosaic Spectral Detection 

Module Off

Cytometer Off and CytoFLEX 

mosaic Spectral Detection 

Module Power Off
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NOTE If the software restarts, the Turn On CytoFLEX mosaic selection is not available when the Cytometer 

is power off and the CytoFLEX mosaic Spectral Detection Module is turned off.

Cytometer Power Off and 

CytoFLEX mosaic Spectral 

Detection Module On

Cytometer Power Off and 

CytoFLEX mosaic Spectral 

Detection Module Off

Cytometer Power Off and 

CytoFLEX mosaic Spectral 

Detection Module Power Off
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Settings Menu

Used to select and/or change software options and settings.

QC/Standardization Menu

Select Start QC/Standardization from the QC/Standardization menu to start the QC routine.

NOTE The QC/Standardization menu is the same for the CytExpert for Spectral User Management and the 

CytExpert for Spectral Electronic Record Management software options.

User Management  Electronic Record Management 
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Advanced Menu

Used to access advanced settings for experienced users. Includes laser time delay settings.

NOTE To restore the Cytometer and CytoFLEX mosaic Spectral Detection Module configuration file, refer to 

APPENDIX A, Restoring the Cytometer and CytoFLEX mosaic Spectral Detection Module Configuration 

File.

Account Menu

Used to for user account management settings.

NOTE The Account menu is the same for the CytExpert for Spectral User Management and the CytExpert for 

Spectral Electronic Record Management software options.

User Management - Semi-Automatic/Manual 

Sample Injection Mode

User Management - Plate Loader Sample 

Injection Mode

Electronic Record Management - 

Semi-Automatic/Manual Sample Injection Mode

Electronic Record Management - Plate Loader 

Sample Injection Mode
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Log Menu

Used to access logs including the Experiment Operation Log, the System Operation Log, and the 
User Management Operation Log.

Signature Menu

Used to sign experiment and view signature details.

NOTE The Signature menu is only available in the CytExpert for Spectral Electronic Record Management 

software option.

Backup/Restore Menu

Used to backup/restore databases. Refer to CHAPTER 10, Backup and Restore.

Help Menu

For displaying software version information and system Instructions for Use.

NOTE The Help menu is the same for the CytExpert for Spectral User Management and CytExpert for 

Spectral Electronic Record Management software options.

User Management Electronic Record Management 

User Management Electronic Record Management 
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User Management

IMPORTANT Only the Initial Administrator or authorized users can manage users. 

User Management is used to create and manage user accounts.

Select Account > User Manager. The User Manager window appears.

Figure 2.7  User Manager (Card View)

Figure 2.8  User Manager (Grid View)

1. Search text box. Filters users by username and display name.
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2. View drop-down. Toggles between Card View (see Figure 2.7) and Grid View (see Figure 2.8).

3. New. Used to create a new user profile.

4. Modify. Used to modify an existing user profile.

5. Delete. Used to delete an existing user profile.

6. Unlock. Used to unlock an existing account that has been locked.

NOTE An account locks after 3 failed password attempts. The number of attempts can be changed by 

the administrator. Refer to Account Policies.

NOTE An account automatically unlocks after 30 minutes. The duration can be changed by the 

administrator. Refer to Account Policies.

7. Reset password. Used to reset an existing user password to a random password.

8. Close. Closes the User Manager window.

Creating, Deleting, and Modifying Users in User Manager

The initial system administrator indicating with  in the username cannot be deleted or 
modified.

Creating a New User in User Manager

1 Select New in the User Manager window. The New window appears.

2 Fill in the new user information.

a. Enter the Username.

b. Enter the Full Name.

c. Select the User Role.

d. Select the Enabled checkbox to enable the user.

NOTE The Enabled checkbox can only be changed by an administrator.
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3 Select OK. The Create User Result window appears.

NOTE Select  to copy the username and password to a 

clipboard and inform the user of the change. The user is required to change the new password 

immediately upon the initial login.

4 Select OK. 

5 Select Close.

Deleting Users in User Manager

IMPORTANT If an account has been used and log information has been generated related to it, the account 

cannot be deleted, but it can be disabled.

1 Select the user to be deleted in the User Manager window then select Delete.

2 The following message appears: Are you sure to you want to delete the user? Select Yes to confirm.

3 Select Close to exit the User Manager window.
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Modifying Users in User Manager

IMPORTANT If an account has been used and log information has been generated related to it, the 

username cannot be modified.

1 Select Modify in the User Manager window. The Modify window appears.

NOTE The Initial System Administrator is a system default user and you can only modify its Full Name.

2 Modify the user information as necessary.

NOTE Uncheck the enabled box to disable a user.

3 Select OK.

4 Select Close to exit the User Manager window.

Unlocking a User Account

Select a Locked user in the User Manager window and select Unlock. 

NOTE You cannot unlock an active user.
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Resetting a User Password

IMPORTANT Only the administrator or authorized users can reset a password. 

1 Select the user to be reset in the User Manager window and select Reset Password.

The confirm window appears.
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2 Select Yes. The Reset Password Result window appears. A new random password is 

automatically generated.

NOTE Select  to copy the username and password to a 

clipboard and inform the user of the change. The user is required to change the new password 

immediately upon the initial login.

3 Select OK.

4 Select Close to exit the User Manager window.

Changing a User Password

Beckman Coulter recommends changing your password on a regular basis.

1 Select Account > Change Password. The Change Password window appears.

2 Enter the current password, the new password, and confirm the new password.
D17052AA   2-32



Using the CytExpert for Spectral Software

User Management  2
3 Select OK.

Forgot Username or Password

The Forgot username or password function allows only the initial system administrator to reset a 
password using the system administrator credential file. If you are a common user and forget your 
password, contact the administrator to reset a password for you. For instructions, refer to Resetting 
a User Password.

IMPORTANT The initial system administrator password cannot be reset without the system administrator 

credential file. Beckman Coulter is not responsible for and will not be able to recover your initial system 

administrator account if the system administrator password is forgotten and the credential file is lost. For 

instructions on exporting the credential file, refer to Exporting the Credential File. 

1 Select Forgot username or password on the login window.

The Reset Password window appears.
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IMPORTANT Find the system administrator credential file from the backup folder when installing the 

CytExpert or Spectral software. You can also export the credential file by selecting Export Credential File 

from the Account menu if you are logged in. Refer to Exporting the Credential File.

2 Navigate to the system administrator credential file and select Open.

3 Select OK. The Change Password window appears.
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4 Enter the new password, and confirm the new password.

NOTE The new password must contain at least ten digits and at least three of the following character 

types by default:

 • Uppercase characters of European languages (A through Z, with diacritic marks, Greek and 

Cyrillic characters);

 • Lowercase characters of European languages (a through z, sharp-s, with diacritic marks, Greek 

and Cyrillic characters);

 • Base 10 digits (0 through 9);

 • Non-alphabetic characters (for example, !, $, #, %);

 • Any Unicode character recognized as an alphabetic character but not uppercase or lowercase.

5 Select OK.

Exporting the Credential File

1 Select Account > Export Credential File. The Export Credential File window appears.

2 Select  and browse to the desired backup directory to export the credential file. 

3 Select OK. The following system prompt appears. 
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4 Select OK.

Role Management

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 2, Role Management.

Creating, Deleting, and Modifying User Roles in Role Manager

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 2, Creating, Deleting, and 
Modifying User Roles in Role Manager.

Account Policies

IMPORTANT Only an Administrator or an account has the Access account policies permission can manage 

account policies.

Account policies is used to define the default properties for the password policy, account lockout 
policy, and application inactivity policy.

Select Account > Account Policies. The Account Policies window appears.
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Figure 2.9  Account Policies - Password Policy

NOTE The allowable range for each entry is as follows:

 • Password History: 12-24 times

 • Password Length: 10-12 characters

 • Minimum Age for Password: 0-89 days

 • Password Expiration: 1-90 days

 • Reminder for Expiration: 1-90 days
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Figure 2.10  Account Policies - Account Lockout Policy

NOTE The allowable range for each entry is as follows:

 • Invalid Login Attempts: 3-5 times

 • Lockout Duration: 30-1440 minutes

Figure 2.11  Account Policies - Application Inactivity Policies

NOTE The allowable range for each entry is as follows:

 • Inactivity Duration: 1-15 minutes
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User Management Operation Log

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 2, User Management Operation 
Log.

Graphic and Gating Styles

Plots

The CytExpert for Spectral software offers a variety of plot formats including:

 • Single-parameter plots and histogram overlays

 • Dual-parameter plots: dot plots, density plots, pseudo color plots, contour plots, and dot plot 
overlays

 • Spectrum plots

NOTE Histogram Overlays and Dot Plot Overlays can only be created from multiple samples in the 

Analysis screen. A maximum of 10 samples can be overlaid.

NOTE  Spectrum option is only an option in the Raw worksheet.

Histogram Multi-sample histogram overlays

Dot plot Density plot
D17052AA   2-39



Using the CytExpert for Spectral Software

Plate Type Library  
Gates

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 2, Gates.

NOTE Gating is not available in spectrum plots.

Plate Type Library

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 2, Plate Type Library.

Adding a Plate Type

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 2, Adding a Plate Type.

Editing a Plate Type

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 2, Editing a Plate Type.

Duplicating a Plate Type

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 2, Duplicating a Plate Type.

Pseudo color plot Contour plot Dot plot overlay

Spectrum plot

p
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Deleting a Plate Type

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 2, Deleting a Plate Type.

Fluorescent Tag Library

IMPORTANT The maximum number of fluorescent tags allowed in the Fluorescent Tag Library is 500.

The Fluorescent Tag Library is used to manage fluorescent tags. Fluorescent tag can be added, 
deleted, and edited from the Fluorescent Tag Library.

Select Settings > Fluorescent Tag Library to access the Fluorescent Tag Library. Refer to Figure 2.12.

Figure 2.12  Fluorescent Tag Library

1. Search text box. Filters fluorescent tag by tag name and peak channel.

2. Add. Creates a new fluorescent tag.

3. Delete. Deletes an existing fluorescent tag.

4. Default. Applies the default settings.

5. Export. Exports fluorescent tag files.
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6. Import. Imports fluorescent tag files.

7. OK. Saves the fluorescent tag.

8. Cancel. Cancels the settings.

Adding a Fluorescent Tag

1 Select Settings > Fluorescent Tag Library. The Fluorescent Tag Library window appears. Refer 

to Figure 2.12.

IMPORTANT The maximum number of fluorescent tags allowed in the Fluorescent Tag Library is 500.

2 Select Add. Enter the fluorescent tag name and select the peak channel from the Peak Channel 

drop-down menu.

3 Select OK to exit the Fluorescent Tag Library window.

Deleting a Fluorescent Tag

1 Select Settings > Fluorescent Tag Library. The Fluorescent Tag Library window appears. Refer 

to Figure 2.12.

2 Select the fluorescent tag to be deleted, and select Delete. The following message appears.

NOTE The default fluorescent tags, shown in bold, cannot be deleted from the Fluorescent Tag Library.

3 Select Yes.

4 Select OK to exit the Fluorescent Tag Library window.
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Restoring the Default Settings

1 Select Settings > Fluorescent Tag Library. The Fluorescent Tag Library window appears. Refer 

to Figure 2.12.

2 Select Default. The following message appears.

3 Select Yes.

4 Select OK to exit the Fluorescent Tag Library window.

Exporting Fluorescent Tag Files

1 Select Settings > Fluorescent Tag Library. The Fluorescent Tag Library window appears. Refer 

to Figure 2.12.

2 Select Export to specify a path and filename for the fluorescent tag file you are saving.

3 Select Save.

NOTE The generated file ends in .ft.

4 Select Close.
D17052AA   2-43



Using the CytExpert for Spectral Software

Fluorescent Tag Library  
Importing Fluorescent Tag Files

1 Select Settings > Fluorescent Tag Library. The Fluorescent Tag Library window appears. Refer 

to Figure 2.12.

2 Select Import and locate the path where the fluorescent tag file is saved. Select the 

corresponding fluorescent tag file (.ft) to import. 

NOTE If the fluorescent tag exists in the fluorescent tag library, the importing will overwrite the existing 

fluorescent tag. The system will prompt to ask you to confirm. 

IMPORTANT The import failures could occur if:

 • The number of fluorescent tags exists in the fluorescent tag library and the imported fluorescent tag 

file exceeds 500.

 • The integrity of the imported fluorescent tag file is compromised.

3 Select Open to import.

NOTE The fluorescent channels imported that are not supported by the software are shown in gray.

4 Select Close.
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Editing a Fluorescent Tag

1 Select Settings > Fluorescent Tag Library. The Fluorescent Tag Library window appears. Refer 

to Figure 2.12.

2 Select the fluorescent tag to be edited and select the desired peak channel from the Peak 

Channel drop-down menu.

NOTE The default fluorescent tags’ name, shown in bold, cannot be edited. Select Default to restore 

the default settings. Refer to Restoring the Default Settings.

3 Select Close.

Software Settings

Select Settings > Options to configure the software settings.

In the Experiment settings, you can set the experiment’s default save path.

NOTE The Experiment setting is only available if the CytExpert User Management software option is 

installed.
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In the Tube settings, you can select the columns that display in the tube section of the screen.

In the Plot settings, you can define the background of the graphics display area, configure the 
histograms, and set the default signal parameters to either the channel’s area or the channel’s 
height. The default is Area. You can also set the default axis display range, and set the spectrum plot 
resolution.
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Software Settings  2
In the Gate settings, you can choose to display population percentage on all plots except overlay.

In the Page Setup settings, you can change the page size, orientation, margin size, and display 
options. Select Show page breaks to display page boundaries within the Acquisition or Analysis 
views for simplifying plot arrangement for printing.
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In the Plate Loader settings, you can select the plate type, sampling sequence, mix, and backflush 
settings for the plate loader.

NOTE This setting is only available in the Plate Loader sample injection mode.
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CHAPTER 3

Operation Principles

Overview

This chapter explains how the Cytometer measures scattered light and fluorescence as cells pass 
through the laser beam.

The illustrations in this chapter are not exact representations of the inside of the Cytometer. They 
are for explanatory purposes only.

This chapter contains information on:

 • Sample Flow

 • Laser Beam Shaping

 • Cell Illumination

 • Light Collection, Separation and Measurement

 • Signal Processing

 • Data Storage

 • Automated Software Features

 • Parameters

 • Plot Display

 • Statistics

Sample Flow

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 3, Sample Flow for detailed 
instructions.

Sample Loading

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 3, Sample Loading for detailed 
instructions. 

Hydrodynamic Focusing

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 3, Hydrodynamic Focusing for 
detailed instructions.
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Laser Beam Shaping

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 3, Laser Beam Shaping for 
detailed instructions.

Cell Illumination

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 3, Cell Illumination for detailed 
instructions.

Forward Scatter

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 3, Forward Scatter for detailed 
instructions.

Side Scatter and Fluorescent Light

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 3, Side Scatter and Fluorescent 
Light for detailed instructions.

Light Collection, Separation and Measurement

Forward Scatter Collection

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 3, Forward Scatter Collection 
for detailed instructions.

Side Scatter and Fluorescent Light Collection

Both side scatter and fluorescence are measured 90 degrees from the laser axis.

NOTE If you are using Conventional Mode, refer to the CytoFLEX Platform Instructions for Use manual, 

CHAPTER 3, Side Scatter and Fluorescent Light Collection for detailed instructions.

Side Scatter

The CytoFLEX mosaic Spectral Detection Module collects SS from each individual laser. It is much 
more intense than FL.

Side scatter light collected by the objective lens is delivered by fiber optics to a patent-pending 
design with high performance, solid-state, high efficiency, and low-noise detector arrays.
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Fluorescent Light

Fluorescence and scattered light are transmitted by optical fibers to the Wavelength division 
multiplexer (WDM). Each WDM is a unique detector array that corresponds to a different laser. 
Refer to CHAPTER 1, Wavelength Division Multiplexer (WDM). Each WDM contains optical filters 
and detectors for detecting channel fluorescence or scatter from a particular laser. It is necessary 
to ensure that the filter and software settings match for each channel.

Figure 3.1  Light Path through the WDM with a Single Port

Signal Processing

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 3, Signal Processing for 
detailed instructions.

1. Fiber array photo detectors (FAPD)

2. SSC fiber array photo detector (SSC FAPD)

3. Lens

4. Lens

5. SSC filter

6. ND filter

7. Filters

8. Filter

9. 30-degree reflector

10. Filter

11. Mirror

12. Mirror

13. Lens

14. Light path
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Data Storage

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 3, Data Storage for detailed 
instructions.

NOTE Sample results can be printed out, saved to removable media, saved to a local hard drive or saved to 

a network drive. You can store sample results in Flow Cytometry Standard (FCS 3.1 or FCS 3.0) files.

Automated Software Features

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 3, Automated 
Software Features for detailed instructions.

Parameters

TIME Parameter

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 3, TIME Parameter for detailed 
instructions.

Plot Display

The results of sample analysis appear on the Workstation screen as graphs called plots. Refer to 
CHAPTER 2, Graphic and Gating Styles.
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Statistics

The Statistics Setting window allows you to change the display of the header, statistical elements 
and cell populations included.
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CHAPTER 4

Daily Startup

Overview

IMPORTANT Verify that the two correct USB configuration keys are securely connected to the computer 

USB ports. If the USB configuration keys are not connected, the following error message appears: 

CytExpert cannot find the license. Please check whether the correct USB configuration key has been 

plugged in.

This chapter describes the instrument startup procedure.

Workflow:

This chapter contains information on:

 • Pre-Startup Inspection

 • Turning On the Instrument

 • Logging into the Software

 • Initializing the Instrument

Pre-Startup Inspection

Before using the Cytometer with the CytoFLEX mosaic Spectral Detection Module, perform the 
following system checks.

Checking Waste and Reagent Levels [4 L Fluid Containers]

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 4, Checking Waste and Reagent 
Levels [4 L Fluid Containers] for detailed instructions.

Checking Waste and Reagent Levels [10 L Fluid Cubitainers]

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 4, Checking Waste and Reagent 
Levels [10 L Fluid Cubitainers] for detailed instructions. 

Pre-startup inspection Ô Turn on power Ô Open software Ô Initialize instrument
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Power Source Inspection

Check the power cable located below the power switch on the back of the Cytometer and the 
CytoFLEX mosaic Spectral Detection Module, and verify it is securely connected to the Cytometer, 
the CytoFLEX mosaic Spectral Detection Module and the appropriate power source.

Workstation Connections Inspection

Check that the monitor, mouse, keyboard, the Cytometer, and the CytoFLEX mosaic Spectral 
Detection Module are properly connected to the computer. Refer to Figure 1.3.

Turning On the Instrument 

CAUTION

1. If the Cytometer, CytoFLEX mosaic Spectral Detection Module or Workstation 

fails to start properly, check first to see whether the power cable and 

connection cables are properly connected.

2. Never shut off the power or disconnect a data cable while the instrument is 

performing a task. Doing so can result in data loss or damage to the system.

NOTE If you are using Conventional Mode, refer to the CytoFLEX Platform Instructions for Use manual, 

CHAPTER 4, Turning On the Instrument for detailed instructions.

1 Turn on the main power switch located on the back of the Cytometer.

2 Wait for the Cytometer to finish powering on, then turn on the CytoFLEX mosaic Spectral 

Detection Module using the power switch located on the left side of the CytoFLEX mosaic 
Spectral Detection Module followed by the power button on the front.

3 Wait for the CytoFLEX mosaic Spectral Detection Module to finish powering on, then turn on 

the Workstation.

NOTE The CytoFLEX mosaic Spectral Detection Module takes approximately 40 seconds to power on. 
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Logging into the Software

1 Log in to the Windows operating system and double-click the CytExpert for Spectral desktop 

icon  to open the software, the login window appears.

NOTE The default software shortcut appears on the desktop. If you do not see the icon, the default 

installation path is under C:/Program Files/CytExpert for Spectral. Double-click CytExpert.exe to run 

the software.

2 Enter your username and password.

3 Select .

NOTE The display name of the user that is currently logged in displays in the top, right corner of the 

software screen.
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4 Confirm that the software, the CytoFLEX mosaic Spectral Detection Module and the Cytometer 

are properly connected.

a. Open the software. The Startup screen appears.

b. Verify that the connection indicator light in the lower left corner of the software screen is 
green, and Connected is displayed. The left side shows the connection status, the middle 
shows the instrument status, and the right side shows the status details.

c. Verify that the Sheath and Waste flow indicators in the lower right corner of the software 
screen are green indicating that the fluidics system is normal. 
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d. Verify that the CytoFLEX mosaic Spectral Detection Module status indicator in the lower 
right corner of the software screen has a green checkmark indicating that the CytoFLEX 
mosaic Spectral Detection Module is ready. 

NOTE  indicates that the CytoFLEX mosaic Spectral Detection Module is 

warming up. This process takes approximately 4 minutes.

NOTE

 • A red connection indicator light indicates that there is a faulty connection. Ensure that the 

instrument is properly turned on and connected. If necessary, restart both the Cytometer 

and the Workstation.

 • After the instrument initializes, a warning beep sounds if there is a problem with the fluidics 

system. If a flow indicator is red and blinking, it means that the fluidics system requires 

attention.

 • When the waste fluid sensor is disconnected, the waste flow indicator shows that the waste 

container is full or nearly full.

 • A gray CytoFLEX mosaic Spectral Detection Module status indicator indicates that there is 

a faulty connection. Ensure that the CytoFLEX mosaic Spectral Detection Module is properly 

turned on and connected. If necessary, restart the CytoFLEX mosaic Spectral Detection 

Module.

 • Select the status information in the lower left to open the system log. Send a copy of the 

system log to your Beckman Coulter Representative for support if a service call is 

requested.
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Logging Out of the Software

Select the username displayed in the top-right corner of the software screen and select Log out.

Locking the Account

Select the username displayed in the top-right corner of the software screen and select Lock.

The account locks automatically if it remains inactive for a specified duration. Refer to CHAPTER 2, 
Account Policies - Application Inactivity Policies.

Selecting the Proper Sample Injection Mode

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 4, Selecting the 
Proper Sample Injection Mode for detailed instructions on the following procedures:

 • Using Semi-Automatic Injection Mode

 • Using Manual Injection Mode
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Selecting the Plate Loader Sample Injection Mode [With Plate Loader]

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 4, Selecting the Plate 
Loader Sample Injection Mode [With Plate Loader] for detailed instructions on the following 
procedure:

 • Using Plate Loader Injection Mode

Running the System Startup Program [with the Single Tube Loader]

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 4, Running the 
System Startup Program [with the Single Tube Loader] for detailed instructions.

Running the System Startup Program [With Plate Loader]

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 4, Running the 
System Startup Program [With Plate Loader] for detailed instructions.

Selecting Experiments from the Start Page

Refer to CHAPTER 2, Start Page.

Initializing the Instrument

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 4, Initializing the 
Instrument for detailed instructions.
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CHAPTER 5

Instrument Quality Control and
Standardization

Overview

This chapter provides information on performing daily Quality Control (QC) on the CytoFLEX flow 
cytometer equipped with the CytoFLEX mosaic Spectral Detection Module and how to confirm that 
the instrument is working properly within the specified parameters. Quality Control allows you to 
determine whether your instrument can provide adequate signal strength and precision.

This chapter also provides information on performing standardization. CytoFLEX Ready to Use 
Daily QC Fluorospheres, CytoFLEX Daily IR QC Fluorospheres or any other reference material that is 
relevant for your application(s) may be used as the standardization sample(s). The system can only 
recognize a single peak. 

Standardization can be used to monitor the Median Fluorescent Intensities (MFI), or target values 
for scatter and fluorescent parameters that have been defined and optimized for a specific 
application. All channels in the current configuration, those with/without an assigned QC target, 
can be tracked as necessary via Standardization since this portion of the CytExpert for Spectral 
software is used to assess application specific settings. Standardization, however, does NOT replace 
QC as the Cytometer's optical alignment (rCV statistical analysis), Laser Power and Laser Delay 
outputs are not measured during the run. 

NOTE Beckman Coulter recommends performing QC on a daily basis.

NOTE CytExpert for Spectral QC includes an automated QC routine with Levey-Jennings (LJ) charts tracking 

and logging.

NOTE CytExpert for Spectral Standardization allows for application-specific settings to be established and 

applied to future experiments.

NOTE Perform QC on the same day prior to performing the CytExpert for Spectral standardization. 

QC Workflow:

Standardization Workflow:

Prepare the QC 

sample
Ô

Enter the QC 

experiment
Ô

Select QC 

target values
Ô Acquire data Ô Confirm results

Obtain target 

acquisition settings
Ô

Run standardization 

sample
Ô

Perform 

standardization 
Ô

Apply standardization 

settings 
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Quality Control  
This chapter contains information on:

 • Quality Control

— Preparing the QC Sample

— Preparing the QC Sample [With Plate Loader]

— Importing Lot-Specific Target Values

— Collecting QC Data

— Collecting QC Data [With Plate Loader]

— Confirming Results

 • Standardization

— Preparing the Standardization Sample

— Generating Target Median Values

— Creating a New Standardization Item

— Performing the Standardization

— Applying the Standardized Acquisition Settings

— Standardization Target Library

Quality Control

The QC process verifies important system functions. The system:

1. Measures the laser power of each individual laser and ensures that each laser meets the system 
specifications.

2. Loads the QC sample and begins to acquire data.

3. Verifies that the actual laser delays match those set in the software and will adjust the delay 
accordingly.

4. Notifies you if laser delay is >2 µs from the previous setting. The software automatically 
changes the laser delay setting.

OR

Notifies you if laser delay is >5 µs from the previous setting. Manual laser delay adjustments are 
required. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 12, Setting Laser 
Delay.

5. Verifies and calibrates the gain settings. If any of these parameters are outside of the operating 
limits, the system automatically adjusts these parameters. If the system is unable to adjust 
these parameters to fall within the operating limits, the system notifies you.
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Preparing the QC Sample

Required Materials

The following materials are required to complete the QC process:

 • CytoFLEX Ready to Use Daily QC Fluorospheres

 • CytoFLEX Daily IR QC Fluorospheres (for systems configured with an IR laser)

 • CytoFLEX Sheath Fluid or another nonionic antimicrobial sheath fluid

 • Sample tubes (12 x 75 mm)

 • Vortexer

CytoFLEX Ready to Use Daily QC Fluorospheres Preparation Process

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 5, CytoFLEX Ready to Use Daily 
QC Fluorospheres Preparation Process for detailed instructions.

CytoFLEX Daily IR QC Fluorospheres Preparation Process

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 5, CytoFLEX Daily IR QC 
Fluorospheres Preparation Process for detailed instructions.

Preparing the QC Sample [With Plate Loader]

Required Materials

The following materials are required to complete the QC process:

 • CytoFLEX Ready to Use Daily QC Fluorospheres

 • CytoFLEX Daily IR QC Fluorospheres (for systems configured with an IR laser)

 • CytoFLEX Sheath Fluid or another nonionic sheath fluid

 • Standard 96-well plate

— 96-well flat-bottom

— 96-well V-bottom

— 96-well U-bottom

 • 96-well deep well plate

— 96-well V-bottom

— 96-well U-bottom

 • Vortexer
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Quality Control  
CytoFLEX Ready to Use Daily QC Fluorospheres Preparation Process

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 5, Preparing the QC Sample 
[With Plate Loader], CytoFLEX Ready to Use Daily QC Fluorospheres Preparation Process for detailed 
instructions.

CytoFLEX Daily IR QC Fluorospheres Preparation Process

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 5, Preparing the QC Sample 
[With Plate Loader], CytoFLEX Daily IR QC Fluorospheres Preparation Process for detailed 
instructions.

Importing Lot-Specific Target Values

Import lot-specific target values for each new lot of CytoFLEX Ready to Use Daily QC Fluorospheres, 
or CytoFLEX Daily IR QC Fluorospheres.

NOTE If you are using Conventional Mode, refer to the CytoFLEX Platform Instructions for Use manual, 

CHAPTER 5, Importing Lot-Specific Target Values for detailed instructions.

CAUTION

Risk of erroneous QC results. Different target value information correspond to 

different lot numbers. Selecting the wrong lot number will lead to erroneous QC 

results.

1 Select Start QC/Standardization from the QC/Standardization menu.

2 Select Target Library from the Settings menu. The Target Library window appears. 
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IMPORTANT The Beckman Coulter website may prompt you to select your Region and Country prior to the 

Beckman Coulter Technical Documents and Software page.

3 Select Download Target File. The Beckman Coulter Technical Documents and Software 

Downloads page appears.

NOTE If your CytoFLEX Workstation does not have access to the internet, navigate to https://

www.beckmancoulter.com/wsrportal/page/softwareDownloadSearch using a computer with access 

to the internet and save the file to a USB drive. If the website is not accessible, contact us.

4 If necessary, register and log in to the Beckman Coulter website.

5 In the Search By Product section of the screen, select the following:

a. Select Research & Discovery from the Market Segment drop-down menu.

b. Select Flow Cytometry from the Product Line drop-down menu.

c. Select Instruments from the Product Platform drop-down menu.

d. Select CytoFLEX mosaic from the Product drop-down menu.

e. Select CytoFLEX Ready to Use QC Fluorospheres Target Value, or CytoFLEX Daily IR QC 

Fluorospheres Target Values from the Software Name drop-down menu.

f. Select English from the Language drop-down menu.

6 Select Search.
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Quality Control  
7 The search results appear below the Search By Item/REF Number tab.

8 Select CytoFLEX Daily Ready to Use QC Fluorospheres Target Values, or CytoFLEX Daily IR QC 

Fluorospheres Target Values under the Software Name column. The CmpytoFLEX Daily Ready to 
Use QC Fluorospheres Target Values or CytoFLEX Daily IR QC Fluorospheres Target Values page 
appears.
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9 Select Download next to the correct lot number from the CytoFLEX Daily Ready to Use QC 

Fluorospheres Target Values or CytoFLEX Daily IR QC Fluorospheres Target Values page. 

10 If the File Download pop up window appears, select Save and browse to the desired file path.

11 Select Import from the Target Library window in the CytExpert for Spectral software.

12 Navigate to the file saved in Step 10 and select Open.

13 Select Close to exit the Target Library window.

Collecting QC Data

QC data and reports are saved by default. Select QC/Standardization Setting in the Settings menu to 
change the default save settings or modify the file path these files are saved to.

NOTE If you are using Conventional Mode, refer to the CytoFLEX Platform Instructions for Use manual, 

CHAPTER 5, Collecting QC Data for detailed instructions.

1 Double-click  to start the CytExpert for Spectral software.

a. Ensure that the Connected icon on the Status Bar near the bottom-left side of the display is 
green.

NOTE If the icon is not green, ensure that the Cytometer USB is securely connected to the 

Workstation and restart the Workstation. Refer to Table 10.1, Troubleshooting [With CytoFLEX 

mosaic Spectral Detection Module].
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b. Ensure that the CytoFLEX mosaic icon on the Status Bar near the bottom-right side of the 
display has a green checkmark.

NOTE If the icon doesn’t have a green checkmark, ensure that the network cable is securely 

connected to the Workstation and restart the Workstation. Refer to Table 10.1, Troubleshooting 

[With CytoFLEX mosaic Spectral Detection Module].

2 Verify the laser settings. Refer to CHAPTER 6, Laser Settings.

3 Select Start QC/Standardization in the QC/Standardization menu to access the QC experiment. 

[CytoFLEX LX Shown]

Ensure that the QC bead lot number is selectable in the Lot No. drop down menu. If the lot 
number is not selectable, refer to Importing Lot-Specific Target Values, then select the proper 
lot number.
D17052AA   5-8



Instrument Quality Control and Standardization

Quality Control  5
4 Select Initialize.

5 Insert the prepared QC sample tube (see CytoFLEX Ready to Use Daily QC Fluorospheres 

Preparation Process) into the tube holder.

6 Select Start to load the sample and begin to run the QC procedure.

Completed processes appear on the left. Plots appear on the right. The QC experiment 
sequentially detects the system configuration, laser power, laser delay, signal strength, and 
coefficient of variation.

During QC, the software automatically seeks the CytoFLEX QC Fluorospheres and computes the 
results. The software returns to the QC Report screen after the QC run is complete. 
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7 If the sampling rate is too low, the Cytometer stops the QC run and displays a prompt that the 

QC run fails to reach the required event flow rate. This is not considered a QC failure. If this 
situation occurs, increase the sample concentration by preparing a new tube of CytoFLEX 
Ready to Use Daily QC Fluorospheres (see CytoFLEX Ready to Use Daily QC Fluorospheres 
Preparation Process) and then perform the experiment.

NOTE Mix the fluorospheres dropper bottle thoroughly before dispensing it into a sample tube.

NOTE If the sample flow rate is not correct, calibrate the sample flow rate before running the QC. For 

instructions on calibrating the sample flow rate, refer to the CytoFLEX Platform Instructions for Use 

manual, CHAPTER 12, Calibrating the Sample Flow Rate or CHAPTER 12, Calibrating the Sample Flow 

Rate [With Plate Loader].

8 If the lot number of CytoFLEX QC Fluorospheres is new and QC fails, the following software 

message appears. Select Yes. 

NOTE Target gain values must be established for each new lot number of CytoFLEX QC Fluorospheres. 

QC could fail up to 3 times upon running each new lot number for the first time until target gain 

values are established.

If the lot number of CytoFLEX QC Fluorospheres is NOT new and QC fails, refer to Step 2 of 
CHAPTER 5, Confirming Results, or CHAPTER 10, Troubleshooting.

If QC passes, proceed to Step 9.

9 Run Daily Clean to remove any residual fluorosphere particles if needed. Refer to the CytoFLEX 

Platform Instructions for Use manual, CHAPTER 11, Daily Clean.
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Collecting QC Data [With Plate Loader]

QC data and reports are saved by default. Select QC/Standardization Setting in the Settings menu to 
change the default save settings or modify the file path these files are saved to.

NOTE If you are using Conventional Mode, refer to the CytoFLEX Platform Instructions for Use manual, 

CHAPTER 5, Collecting QC Data [With Plate Loader] for detailed instructions.

1 Double-click  to start the CytExpert for Spectral software.

a. Ensure that the Connected icon on the Status Bar near the bottom-left side of the display is 
green.

NOTE If the icon is not green, ensure that the Cytometer USB is securely connected to the 

Workstation and restart the Workstation. Refer to Table 10.1, Troubleshooting [With CytoFLEX 

mosaic Spectral Detection Module].

b. Ensure that the CytoFLEX mosaic icon on the Status Bar near the bottom-right side of the 
display has a green checkmark.

NOTE If the icon doesn’t have a green checkmark, ensure that the network cable is securely 

connected to the Workstation and restart the Workstation. Refer to Table 10.1, Troubleshooting 

[With CytoFLEX mosaic Spectral Detection Module].

2 Verify the laser settings. Refer to CHAPTER 6, Laser Settings.

IMPORTANT Ensure that the QC bead lot number is selectable in the Lot No. drop-down menu. If the lot 

number is not selectable, refer to CHAPTER 5, Importing Lot-Specific Target Values, then select the 

proper lot number.

3 Select Start QC/Standardization in the QC/Standardization menu to access the QC experiment.
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4 Select Initialize.

5 Select Eject.

6 Insert the prepared QC well plate (see CytoFLEX Ready to Use Daily QC Fluorospheres 

Preparation Process or CytoFLEX Daily IR QC Fluorospheres Preparation Process) into the plate 
holder.

7 Select . The Plate Settings window appears.

IMPORTANT Ensure the well position on the plate matches the well position selected in the software.

8 Select the appropriate QC well.
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9 Select the desired plate type from the Plate Type dropdown menu.

NOTE The available plate types included in the dropdown menu depend on the settings selected in the 

Plate Library. Refer to CHAPTER 2, Plate Type Library.

10 Select the Mix and Backflush settings in the top of the Plate Settings window.

11 Select OK.

12 Select Start to load the sample and begin to run the QC procedure. The message Please confirm 

that the correct plate is placed properly and press OK appears. Select OK.

Completed processes appear on the left. Plots appear on the right. The QC experiment 
sequentially detects configuration, laser power, laser delay, signal strength, and coefficient of 
variation.
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During QC, the software automatically seeks the CytoFLEX QC Fluorospheres, computes the 
results and determines whether the gain setting meets the assay target values. The software 
returns to the QC screen after the QC run is complete.

13 If the sampling rate is too low, the Cytometer stops the QC run and displays a prompt that the 

QC run fails to reach the required event flow rate. This is not considered a QC failure. If this 
situation occurs, increase the sample concentration by preparing a new tube of CytoFLEX 
Ready to Use Daily QC Fluorospheres (see CytoFLEX Ready to Use Daily QC Fluorospheres 
Preparation Process) and then perform the experiment.

NOTE Mix the fluorospheres dropper bottle thoroughly before dispensing it into a sample tube.

NOTE If the sample flow rate is not correct, calibrate the sample flow rate before running the QC. For 

instructions on calibrating the sample flow rate, refer to the CytoFLEX Platform Instructions for Use 

manual, CHAPTER 12, Calibrating the Sample Flow Rate or CHAPTER 12, Calibrating the Sample Flow 

Rate [With Plate Loader].

14 If the lot number of CytoFLEX QC Fluorospheres is new and QC fails, the following software 

message appears. Select Yes. 

NOTE Target gain values must be established for each new lot number of CytoFLEX QC Fluorospheres. 

QC could fail up to 3 times upon running each new lot number for the first time until target gain 

values are established.
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If the lot number of CytoFLEX QC Fluorospheres is NOT new and QC fails, refer to Step 2 of 
CHAPTER 5, Confirming Results, or CHAPTER 10, Troubleshooting.

If QC passes, proceed to Step 15.

15 Run Daily Clean to remove any residual fluorosphere particles. Refer to the CytoFLEX Platform 

Instructions for Use manual, CHAPTER 11, Daily Clean [With Plate Loader].

Confirming Results

Select Start QC/Standardization in the QC/Standardization menu to return to the QC Setting screen 
at any time to review completed experiment results.

1 Select a QC run from the QC Process list on the left and a QC report appears on the right.

NOTE The results column indicates a passing QC result with a  and a failed QC result with . 

QC results must meet the following criteria to pass:

 • The gain differences must be �20% from the target gain. 

 • The median fluorescence intensity (MFI) differences must be �5% from the target MFI.

 • The rCV must be within the target range.
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The report area on the right displays detailed experiment results, including laser power, delay, 

testing conditions, and signal results. The same  and  symbols are used to indicate each 
result. For items that fail, values falling outside the prescribed range are displayed in red font. 
In the Comment area, an explanation appears for each failed item.
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2 If QC fails, follow the procedure below:

NOTE When the Confirm window appears, select Yes if you are sure that the QC failure is caused by the 

QC reagent batch difference or you need to use the adjusted gain.

Otherwise, select No.

a. Verify whether the beads used were within their shelf life and stored in accordance with 
the appropriate instruction manual.

b. Verify whether the allocated sample tube was prepared as required and correctly 
positioned.

c. Prime the Flow Cell, and retest. Refer to the CytoFLEX Platform Instructions for Use manual, 
CHAPTER 12, Priming the Flow Cell.

d. Run the Daily Clean, and retest. Refer to the CytoFLEX Platform Instructions for Use manual, 
CHAPTER 11, Daily Clean.

e. Run the Deep Clean Procedure, and restart. Refer to the CytoFLEX Platform Instructions for 
Use manual, CHAPTER 11, Deep Clean Procedure.

f. Repeat Steps c-d.

NOTE If QC fails two times in a row on the same day after repeating Steps a-f, contact us.

3 If necessary, you can select  (for CSV format) or  (for PDF format) in the top left corner 

of the report area to export the QC results.

4 Select Close QC/Standardization in the File menu to exit the QC screen.
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Creating Levey-Jennings Charts

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 5, Creating Levey-
Jennings Charts for detailed instructions.

QC Result Manager

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 5, QC Result Manager 
for detailed instructions.

Standardization

Ensure that the standardization sample has been run at optimized experiment settings to 
determine the standardization sample threshold setting as well as median values for all relevant 
channels.

Preparing the Standardization Sample

Use Beckman Coulter CytoFLEX Ready to Use Daily QC Fluorospheres or any other reference 
material that is relevant for your application. 

Required Materials

The following materials are required to complete the QC process:

 • CytoFLEX Ready to Use Daily QC Fluorospheres, or other material applicable for your 
application

NOTE Note that the VSSC and NSSC channels are designed for small particle detection. It is not 

recommended to use the CytoFLEX Ready to Use Daily QC Fluorospheres when performing 

standardization for the VSSC and NSSC channels.

 • CytoFLEX Daily IR QC Fluorospheres (for systems configured with an IR laser)

 • CytoFLEX Sheath Fluid

 • Sample tubes (12 x 75 mm)

 • Vortexer

Preparation Process

For procedures, refer to CytoFLEX Ready to Use Daily QC Fluorospheres Preparation Process and/or 
CytoFLEX Daily IR QC Fluorospheres Preparation Process.
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Generating Target Median Values

Generate lot-specific target values for each new lot of standardization beads.

NOTE If you want to generate target median values automatically for all channels from the Acq. Setting 

Catalog using existing settings in the Acq. Setting Catalog, refer to Creating a New Standardization Item 

from Acq. Setting Catalog.

NOTE If you are using Conventional Mode, refer to the CytoFLEX Platform Instructions for Use manual, 

CHAPTER 5, Generating Target Median Values for detailed instructions.

1 Double-click  to start the CytExpert for Spectral software.

a. Ensure that the Connected icon on the Status Bar near the bottom-left side of the display is 
green.

NOTE If the icon is not green, ensure that the Cytometer USB is securely connected to the 

Workstation and restart the Workstation. Refer to Table 10.1, Troubleshooting [With CytoFLEX 

mosaic Spectral Detection Module].

b. Ensure that the CytoFLEX mosaic icon on the Status Bar near the bottom-right side of the 
display has a green checkmark.

NOTE If the icon don’t have a green checkmark, ensure that the network cable is securely 

connected to the Workstation and restart the Workstation. Refer to Table 10.1, Troubleshooting 

[With CytoFLEX mosaic Spectral Detection Module].

2 Select New Experiment to create an experiment.

3 Add a tube and edit the tube name. Refer to the CytoFLEX Platform Instructions for Use manual, 

CHAPTER 6, Changing the Tube Name for detailed instructions. 

4 Select Acq. Setting to input the optimized Gain and Threshold in the relevant channels in the 

Acq. Setting window. Refer to CHAPTER 6, Configuring Acquisition Settings.

NOTE Use the FSC channel as the trigger channel. The threshold may need to be adjusted to visualize 

the QC beads populations. If so, record this value for future reference.

5 Load the sample tube.

NOTE The sample tube holder accommodates 1.5 mL, 2.0 mL, and 12 x 75 mm sample tubes.
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6 Create a FSC/SSC dot plot and gate on the singlet bead population. Refer to CHAPTER 6, 

Creating Plots and Gates.

7 Create histograms for each channel and apply the gate.

8 Select Run.

9 Add a statistics table and right-click the table and select Statistics Setting. The Statistics Setting 

window appears. 
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10 Select the Population tab and select the relevant population for the tube.
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11 Select the Statistics tab then select the Median Fluorescence value for all parameters used and 

select OK. 

NOTE The median values are the target settings that will be used for standardization.

12 Right-click the statistics table and select Export to CSV File.

If Excel is not available, manually record all the median values or take a screen shot. 
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13 Save the experiment.

NOTE Rerun the experiment and create a new standardization file if:

 • You change the standardization fluorosphere used.

 • The Lot number for the standardization fluorosphere is changed.

Creating a New Standardization Item

The standardization item can be created in two ways:

 • Add a new standardization item in the Standardization Target Library using the previously 
generated target median values. Refer to Generating Target Median Values and Adding a New 
Standardization Item.

 • Create a new standardization item from the Acq. Setting Catalog using the previously saved 
acquisition settings. Refer to CHAPTER 6, Exporting Instrument Settings and Creating a New 
Standardization Item from Acq. Setting Catalog.

Adding a New Standardization Item

NOTE If you are using Conventional Mode, refer to the CytoFLEX Platform Instructions for Use manual, 

CHAPTER 5, Adding a New Standardization Item for detailed instructions.

1 Select Start QC/Standardization in the QC/Standardization menu to access the Standardization 

screen.
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2 Select Settings > Standardization Target Library. The Standardization Target Library window 

appears.

3 Select Add. The Add Standardization Target Value window appears.
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4 Enter the Item, Lot No. and Expiration date from the drop-down menu located at the top of the 

Add Standardization Target Value window.

NOTE A single Lot No. can include several Items, but you cannot add duplicate Items under the same 

Lot No.

NOTE If the Lot No. selected already exists, the Expiration date cannot be edited.

5 Select either Manual or Automatic threshold from the Standardization Test Setting or Acquisition 

Setting section of the window.

NOTE If you select Manual threshold, enter a value greater than 0, but less than 1,048,575.

NOTE Keep the threshold setting the same as previous Step 4 in Generating Target Median Values.

NOTE Unchecking the Use the same threshold setting for acquisition setting checkbox allows you to 

specify custom threshold settings and when to save the test item into the Acquisition Setting 

Catalog.

6 Enter the target median values saved in Step 11 in Generating Target Median Values into the 

corresponding channels.

Or copy the median values from the previously exported CSV file in Step 12 in Generating 
Target Median Values and paste into the corresponding median column,

NOTE Do not set the median tolerance range any lower than 5%.

NOTE FSC is a required channel.

NOTE Verify that the target values are entered correctly.
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7 Select OK to save the target value.

The saved results display in the Standardization Target Library window. This item is ready to 
be run through the Standardization experiment. Refer to Performing the Standardization.

8 Select Close to exit the Standardization Target Library window,
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Creating a New Standardization Item from Acq. Setting Catalog

1 Select Start QC/Standardization in the QC/Standardization menu to access the Standardization 

screen.

2 Select Settings > Standardization Target Library. The Standardization Target Library window 

appears.
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3 Select . The Create from Acq. Setting Catalog window appears.
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4 Select  located at the top left of the Create from Acq. Setting Catalog window. The 

Acq. Setting Catalog window appears.

5 Select the desired Item and select OK.

NOTE If the following prompt appears, select Yes to proceed. If you do not want to proceed, select No.

6 Enter the Lot No. and Expiration date from the drop-down menu located at the top of the Create 

from Acq. Setting Catalog window.

NOTE A single Lot No. can include several Items, but you cannot add duplicate Items under the same 

Lot No.

NOTE If the Lot No. selected already exists, the Expiration date cannot be edited.
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7 Select either Manual or Automatic threshold from the Standardization Test Setting or Acquisition 

Setting section of the window.

NOTE If you select Manual threshold, enter a value greater than 0, but less than 1,048,575.

NOTE Unchecking the Use the same threshold setting for acquisition setting checkbox allows you to 

specify custom threshold settings.

8 Select Initialize from the Collect Control Panel and select Record. 

NOTE If you need to set the number of events to record in the Collect Control Panel, enter a value 

between 2,000 and 100,000.

9 Wait for the software to finish recording. The Save as FCS File window appears. 

If you want to export the FCS file, navigate to the desired file path and select Save. If you do not 
want to export the FCS file, select Cancel.
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10 The generated median values display in the Create from Acq. Setting Catalog window. 

11 Select OK to save the target value and exit the Create from Acq. Setting Catalog window.

12 Select Close to exit the Standardization Target Library window.
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Performing the Standardization

NOTE If you are using Conventional Mode, refer to the CytoFLEX Platform Instructions for Use manual, 

CHAPTER 5, Performing the Standardization for detailed instructions.

1 Select Start QC/Standardization in the QC/Standardization menu to access the Standardization 

screen.

2 Select the Standardization radio button.
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3 Select the correct Lot No. from the Lot No. drop-down menu.

NOTE Ensure the Lot No. corresponds to the standardization sample that generated the target median 

values.

4 Select the Items to be standardized.

5 Select Initialize.

6 Select Start. The following software prompt appears. Select Yes.

The Process section of the screen displays the process details.
D17052AA   5-33



Instrument Quality Control and Standardization

Standardization  
Once the process is complete, the standardization results displays in the Process list on the left 
and a Standardization Report displays on the right.

NOTE The result column indicates a passing standardization result with a  and a failed 

standardization result with . 

NOTE The updated Standardization item is added to the Acquisition Catalog automatically and 

overwrites the previously existing standardized settings for this item.
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7 Select Acq. Setting Catalog from the Cytometer menu to verify the gain settings. The Acq. 

Setting Catalog window appears.

NOTE  designates test items from Standardization.

8 Select Close to exit the Acq. Setting Catalog window.

9 Run Daily Clean. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 11, Daily 

Clean. 

10 Select Close QC/Standardization. 

Applying the Standardized Acquisition Settings

NOTE If you are using Conventional Mode, refer to the CytoFLEX Platform Instructions for Use manual, 

CHAPTER 5, Applying the Standardized Acquisition Settings for detailed instructions.

1 Open an experiment.
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2 Select Acq. Setting from the Cytometer menu. The Acq. Setting window appears.

3 Select Import from Catalog. The Acq. Setting Catalog window appears.

4 Browse for the item to import and select Import. 

The standardized settings are applied to the sample tube.
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The Information window appears to notify of the corresponding channels with the changed 
gain as a result of the Standardization. 

5 Select OK.

Standardization Target Library

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 5, Standardization 
Target Library for detailed instructions on the following procedures:

 • Importing a Standardization Item

 • Exporting a Standardization Item

NOTE The standardization items save as .mstgt file. This file can be used to standardize the settings 

between different instruments with the same laser configuration.

 • Editing Standardization Item Parameters

 • Duplicating Standardization Items

 • Deleting Standardization Items
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CHAPTER 6

Data Acquisition and Sample Analysis

Overview

This chapter contains information on how to use your Cytometer with CytoFLEX mosaic Spectral 
Detection Module, including data acquisition, analyzing and exporting results.

Workflow:

This chapter contains information on:

 • Creating an Experiment 

 • Configuring Acquisition Settings

 • Load Sample and Record Data

 • Analyzing and Exporting Data

 • Saving the Experiment

Creating an Experiment

Creating an Experiment [Without Plate Loader]

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 6, Creating an 
Experiment [Without Plate Loader] for detailed instructions.

NOTE CytExpert for Spectral software has two installation options, the CytExpert for Spectral User 

Management software option and the CytExpert for Spectral Electronic Record Management software 

option. 

Create 

experiment
Ô

Adjust instrument 

settings and gates
Ô

Load 

sample 
Ô

Record 

Data
Ô

Analyze and 

export data
Ô

Save 

experiment
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Creating an Experiment [With Plate Loader]

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 6, Creating an 
Experiment [With Plate Loader] for detailed instructions.

Setting Sample Wells

NOTE If you are using Conventional Mode, refer to the CytoFLEX Platform Instructions for Use manual, 

CHAPTER 6, Setting Sample Wells for detailed instructions.

Once the plate protocol is created, the plate window appears. Refer to Figure 6.1.

Figure 6.1  Plate Window [CytoFLEX LX Shown]

Empty well.

The well with color is set as sample well, but is not set for Auto Record.

The well is set as sample well, and is ready for Auto Record. The number labeled at the right 

bottom shows the order of auto record.

Cleaning Agent well.

Deionized water well.
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1 Left-click and drag your mouse to highlight the desired wells or hold the Control key and select 

each desired well.

2 Select  or right-click the selected wells and select Set As Sample Wells. The Set As Sample 

Wells window appears.

NOTE Select  or right-click and select Set As Empty Wells to reset selected wells as empty.

3 Enter the name in the Prefix box in the Naming Rules section of the window.

4 Select the desired Mix and Backflush duration from the Mix/Backflush section of the window. 

A blue check mark means the data is acquired, not recorded.

A green check mark means the data is recorded.

A red cross mark means the data is recorded by Auto Record mode. But the acquisition is 

terminated abnormally. For example, the well is skipped or the acquisition is manually stopped.
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5 Enter the Group Name in the Name box in the Group section of the window.

6 Select the sample well color using the color dropdown under the Group section of the window.

7 Select the desired acquisition settings under the Acq. Setting tab.

NOTE Select Import from File to import the settings from a FCS file.

NOTE If desired, import saved settings/standardization settings from the catalog.
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8 Select the channels and adjust as needed.

9 Set unmixing under the Unmixing Details tab. Refer to CHAPTER 7, Unmixing for detailed 

instructions on setting unmixing.
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10 Select Events to Record, Time to Record, or Volume to Record under the Stopping Rules tab. 

NOTE Beckman Coulter recommends setting an acquisition time limit to stop the acquisition if the event 

limit cannot be reached.

11 Create the desired name and value under the Custom Metadata tab. 
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12 Select OK.

Modifying Well Settings

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 6, Modifying Well 
Settings for detailed instructions on the following procedures: 

 • Copying, Cutting, and Pasting Wells

 • Applying Existing Well Settings to Additional Wells

 • Moving the Location of a Well

Setting the Label

NOTE If you are using Conventional Mode, refer to the CytoFLEX Platform Instructions for Use manual, 

CHAPTER 6, Setting the Label for detailed instructions.

NOTE The Set Label function is not available in spectral unmixing experiments.

NOTE The Set Label function is only available when the tube contains the unmixing matrix. To import 

unmixing matrix, refer to CHAPTER 7, Importing and Exporting Unmixing Matrix.

1 Select Set Label in the Settings menu. The Set Label window appears.

2 In the Set Label window, modify the label as needed.
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3 Select Apply to. The Apply Label Setting window appears.

4 Select the tubes to apply the label settings to and select OK.

NOTE The Select All checkbox allows you to select all of the tubes listed.

5 Select Close to exit the Set Label window.

Creating Plots and Gates

IMPORTANT The maximum number of elements allowed in an experiment is 200. Elements include plots, 

statistics tables, and gate hierarchy tables.

IMPORTANT The maximum number of gates allowed in an experiment is 200.

NOTE If you are using Conventional Mode, refer to the CytoFLEX Platform Instructions for Use manual, 

CHAPTER 6, Creating Plots and Gates for detailed instructions.

1 Use the plotting controls (see Figure 2.3) in the plot area to create plots and gates and to 

generate graphs as shown.

Use the  icons to generate histograms, dot plots, density plots, pseudo color 
plots, contour plots, and spectrum plots.
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The experiment uses scatter plots, histograms, polygon gating, four-quadrant gating, and 
line-segment gating.

a. After selecting a plot, click and drag the mouse to adjust the position and select and drag 
the sizing handles at the edge of the graph to adjust the size of the graph.

b. Select an axis name to change which channel is displayed. An “A” after the channel name 
indicates signal pulse area, while an “H” indicates height. The default setting is “A”. 

NOTE To modify the default settings, select Options in the Settings menu. The Options window 

appears. Select Plot on the left side of the Options window. Under the Signal section of the 

window, change the Main Channel default by selecting the Height or Area.

NOTE When using both Height and Area signals, ensure the gain setting is set to where the Height 

signal does not reach its upper range.

[Raw Worksheet Shown] [Unmixed Worksheet Shown]
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c. Signal width can be used as a tool for doublet discrimination and to differentiate somatic 

cell adhesion. If necessary, select  to open the Acq. Setting window. 

d. Select the Signal tab, and select the channel with the required signal width.
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e. Plot properties can be configured to display axes in Log, Log-Linear, or Linear format.

1) Double-click the plot or right-click the plot and select Property from the drop-down 
menu. The Plot Property screen appears.

2) Select whether to display the axes in logarithmic or linear format for both the X-axis 
and Y-axis. Enter a value for log-linear coefficient if the log-linear view is desired. 

3) Select Close.

Or

Select the logarithmic axis on the plot. The slider appears. Drag the slider along the 
axis to change the log-linear coefficient and view events that are not shown, including 
events with negative values.

NOTE The log-linear slider is also available during data acquisition.

NOTE To reset the axis back to logarithmic, right-click on the axis and select Property. Select 

X Axis Default or Y Axis Default to reset the axis.

Histogram with logarithmic Histogram with log-linear
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f. You can adjust axis ranges using the pan axis display controls located at the top of the 
screen.

 • Select  to zoom-in and define which area of a plot to enlarge. The selected area 
can be magnified to fill the entire graph. By selecting the zoom-out function, you can 
click on the graph and restore the plot to its original appearance before magnification.

 • Select  to shift the axes. The mouse pointer appears as a hand. It allows you to 
drag the graph to reveal the axis segment you need. 

—  Pan: Modifies the axis display range dimensions when panning both axes. 
When the pan control is selected, you can right-click the graph and select which 
axis you need to adjust when dragging. You can also pan directly to the default axis 
range.

—  Single side pan: Modifies the axis display range dimensions when panning one 
axis.

NOTE Only the low end of the axis can be adjusted by the single side pan tool.

Dot plot with logarithmic Dot plot with log-linear 
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 • Select  to scale axis ranges in the plots automatically. 

NOTE This feature is only available in the spectral unmixing experiment and in the unmixed 

worksheet opened in a standard experiment (see Figure 2.2).

 • Double-click the border area of the plot to open the Plot Property window, or 
right-click the plot, then select Property to open the same Plot Property window.

 • In the Plot Property window, manually enter the minimum and maximum display 
values for the X- and Y-axes. You can also select Fit With Sample to let the software 
automatically adjust the lower limit according to the signal and perform the 
corresponding log-linear transformation. The X- and Y-axes Default settings are the 
default parameters. The default parameters are 100-1,000,000. 

NOTE Select Fit With Sample to identify the signal’s lower limit, adjusting automatically as 

warranted. Selecting this item is recommended whenever the signal appears to be 

relatively low.

NOTE Select Auto to automatically set the upper and lower display limits of the axes based on 

the data already collected.

NOTE Select Options in the Settings menu, then select Plot to modify the default setting of 

the axis range under the Axis Default Setting section of the window.
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2 To create gates, use the  control buttons or right-click the plot 

and select the gate type required. Gates can be set according to different requirements to 
differentiate cell populations.

NOTE To add a vertex to a polygon gate:

1. Select the gate.

2. Hover your cursor over the perimeter of the gate until the cursor changes to the hand icon.

3. Select the desired location for the new gate vertex.

NOTE A newly created gate becomes a subset of the plot where it appears. The relationship between 

parent and progeny/daughter gates can be changed when a displayed gate is subsequently 

modified.

The position of the same gate in different sample tubes may vary. To change the position of a gate 

and apply the change to all sample tubes accordingly, you can right-click the gate and select Apply 

to All Tubes.

You can also apply the change to select tubes by selecting Apply to Tubes.
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3 Select the gates to display.

a. Select the heading area of the plot, select the parent population/gate to display in the plot 
from the drop-down menu. The selected parent gate appears in the heading area of the 
plot.

NOTE The CytExpert for Spectral software will not list gates which would create circular gating 

logic.

Figure 6.2 shows all gates defined in the example experiment below. Note that the only gate 

option in plot 1 of Figure 6.3 is P2 for the following reasons:

 • Plot 1 cannot be gated on P1 because P1 is on that plot.

 • Plot 1 cannot be gated on P2 because P2 is gated on P1. 

 • Plot 1 cannot be gated on the P2 OR P1 combo population because the gate logic contains 

P1.

Figure 6.2  All Gates - Example Experiment

Figure 6.3  Circular Gating Logic - Example Experiment
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b. If necessary, you can select the Combo Population option from the drop-down menu to 
create a combination gate, using the Boolean relationships “AND”, “OR”, and “NOT” to 
produce a new gate. You can also select the population color or change the gate name.

 • “AND” indicates that all selections must be satisfied. For example, “P1 AND P2” means 
that the data for the newly added gate represent the intersection of P1 and P2.

 • “OR” indicates that only one of the selections needs to be satisfied. For example, “P1 OR 
P2” means that the data for the newly added gate represent the union of P1 and P2.

 • “NOT” indicates exclusion from the selection. For example, “NOT P1” means that the 
data for the newly added gate represent the events that are not part of P1.
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4 Select  to display the population hierarchy.

The Population Hierarchy function allows you to view how gates rank in relation to one 
another. To change the display color, double-click the default color and select the desired color 
from the drop-down color palette. To change the name of each gate, double-click the name of 
the desired gate. By hovering your mouse pointer over a combo population whose display name 
has just been changed, you can view its corresponding Boolean logical operation.

Creating and Adjusting Auto Gates

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 6, Creating and 
Adjusting Auto Gates for detailed instructions on the following procedures: 

 • Turning Auto Recalculate On/Off

 • Adjusting Autogate Movement and Extent

Setting Customized Parameters

Set custom parameter to create fluorescence calculations.

NOTE If you are using Conventional Mode, refer to the CytoFLEX Platform Instructions for Use manual, 

CHAPTER 6, Setting Customized Parameters for detailed instructions.
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1 Select Set Customized Parameter from the Settings menu. Or, right-click a test tube from the 

test tube menu and select Set Customized Parameter. The Set Customized Parameter window 
appears.

2 Select the Raw/Unmixed tab on the top of the Set Customized Parameter window as needed.

3 Enter a name for the parameter in the Name section.

4 Select the parameters for calculation from the Parameter dropdown menu.

5 Select the equation operations from the Open dropdown menu.

The new parameter name is displayed in the list of parameters and statistic items.
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Setting Custom Statistics

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 6, Setting Custom 
Statistics for detailed instructions.

Configuring Acquisition Settings

NOTE Settings can be imported from the Acquisition Settings Catalog. Refer to CHAPTER 6, Importing 

Instrument Settings.

If unmixing settings are desired, import the unmixing matrix from the Spectral Library or import the 

unmixing file. Refer to CHAPTER 7, Importing and Exporting Unmixing Matrix. Unmixing matrix can be 

imported before or after performing the sample acquisition to generate unmixed data.

Changing the Tube Name

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 6, Changing the Tube 
Name for detailed instructions.

Laser Settings

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 6, Laser Settings for 
detailed instructions.

NOTE Lasers can only be enabled and disabled in Conventional Mode.

Setting Laser Target Power Settings [CytoFLEX LX Only]

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 6, Setting Laser 
Target Power Settings [CytoFLEX LX Only] for detailed instructions.

NOTE Lasers can only be enabled and disabled in Conventional Mode.

Adjusting the Gain

While the instrument is in use, the signal value can be increased or decreased by adjusting the 
instrument’s gain configuration.

NOTE If you are using Conventional Mode, refer to the CytoFLEX Platform Instructions for Use manual, 

CHAPTER 6, Adjusting the Gain for detailed instructions.

1 Select  on the left side of the screen. The Acq. Setting window appears. 
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2 Select the Gain tab in the Acq. Setting window. 

Select or edit the instrument’s default gain settings using one of the following methods:

 • Edit the gain settings and select Set As Default to create a new default settings.

 • Select Default to return to your saved default settings.

 • Select QC Gain to use the instrument’s QC settings.

 • Select Assay Gain to use the instrument’s assay settings.

NOTE In cases where you do not specify your own default parameters, the Assay settings and default 

settings are identical.

3 Adjust the gain setting of each channel under the Gain tab in the Acq. Setting window. Raising 

the gain increases the signal. Lowering the gain reduces the signal.

NOTE Gain adjustments have a predefined range between 1 and 3,000. For fine adjustments, use the 

text box and manually enter the gain values as needed.

NOTE The * symbol next to the channel indicates that: 

 • The gain of the channel has been modified.

 • The gain of the channel is set to the minimum or maximum value. 

NOTE If you adjust the gain of a laser, the gain of all corresponding channels changes simultaneously.

If the gain of a channel has been modified, it cannot be modified by adjusting the corresponding 

laser’s gain directly.
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NOTE Optimize the gain settings according to your own experimental goals. The QC Gain values are 

only for reference.

NOTE Select Link to Setting from Catalog to apply the gain settings directly to skip adjusting the gain 

setting. Refer to Link to Acq. Setting.

Another option is to use the Gain Control button  on the tool-bar in the graphic control 
area to adjust the gain values for cell population data to their desired levels, directly on the 
plots where the data appears during data collection.

4 If necessary, change the coordinate display range and the plot type. 

Link to Acq. Setting

This operation will only affect gain settings, not threshold and width settings.

1 Select  on the left side of the screen. The Acq. Setting window appears. 
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2 Select Link to Setting from Catalog in the Acq. Setting window. The Acq. Setting Catalog window 

appears.

Or 

Right-click the desired tube and select Link to Setting from Catalog from the drop-down menu. 
The Acq. Setting Catalog window appears.
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3 Select the desired Item to link and select OK. The Information window appears.

NOTE Checking the Convert Unmixing Matrix by the Gain checkbox allows the unmixing matrix to 

automatically adjust by gain settings. 

4  Select OK.

5 Select Close to exit the Acq. Setting window.

Adjusting the Threshold

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 6, Adjusting the 
Threshold for detailed instructions.
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Setting Collection Conditions

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 6, Setting Collection 
Conditions for detailed instructions.

NOTE In the CytExpert for Spectral software, the Events to Record also includes a drop down menu where 

you can select to record either raw data or unmixed data.

Setting Plot Display Conditions

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 6, Setting Plot Display 
Conditions for detailed instructions.

Viewing Saturation [Without Plate Loader]

The saturation warning is an automatic iterative acquisition-and-check process. You can optimize 
the gain settings according to your own experiment goals to avoid signal saturation. 

NOTE The Saturation Warning function is enabled by default. You cannot enable or disable the function 

during the data acquisition.

NOTE The Saturation Warning function only applies to the fluorescence channels.

NOTE Adjust the gain settings according to your own experimental goals as necessary to avoid signal 

saturation. Refer to Adjusting the Gain.
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1 Confirm that the Saturation Warning function is enabled. If not, select Saturation Warning from 

the Advanced menu to enable it.

NOTE To disable the Saturation Warning function, select Saturation Warning from the Advanced menu 

The following system prompt appears, and select Yes. The saturation warning status displays on the 

top of the software screen.

2 Create a new experiment and new tube. Refer to Creating an Experiment.

3 Configure the acquisition settings. Refer to Configuring Acquisition Settings.

4 Load samples and record data as needed. Refer to Load Sample and Record Data.

5 When the acquired or recorded events reach 2,000, the confirmation window appears. 

NOTE The default saturation threshold is 5%.

NOTE The acquisition continues when the confirmation window appears.
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6 Select Ignore to close the confirmation window.

Or

Select Stop to stop the acquisition.

NOTE If you select Ignore, the confirmation window will no longer prompt.

7 When the acquisition completes, the Information window appears. Select OK.
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8 Right-click a tube and select View Saturation. The View Saturation window appears.

9 Select Close.
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Viewing Saturation [With Plate Loader]

The saturation warning is an automatic iterative acquisition-and-check process. You can optimize 
the gain settings according to your own experiment goals to avoid signal saturation. 

NOTE The Saturation Warning function is enabled by default. You cannot enable or disable the function 

during the data acquisition.

NOTE The Saturation Warning function only applies to the fluorescence channels.

NOTE Adjust the gain settings according to your own experimental goals as necessary to avoid signal 

saturation. Refer to Adjusting the Gain.

1 Confirm that the Saturation Warning function is enabled. If not, select Saturation Warning from 

the Advanced menu to enable it.

NOTE To disable the Saturation Warning function, select Saturation Warning from the Advanced menu 

The following system prompt appears, and select Yes. The saturation warning status displays on the 

top of the software screen.

2 Create a new experiment and new tube. Refer to Creating an Experiment.

3 Configure the acquisition settings. Refer to Configuring Acquisition Settings.

4 Load samples and record data as needed. Refer to Load Sample and Record Data.

5 If you are running a single well, proceed to Step 6. 

If you are running a set of wells, skip to Step 9.
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6 When the acquired or recorded events reach 2,000, the confirmation window appears. 

NOTE The default saturation threshold is 5%.

NOTE The acquisition continues when the confirmation window appears.

7 Select Ignore to close the confirmation window.

Or

Select Stop to stop the acquisition.

NOTE If you select Ignore, the confirmation window will no longer prompt until the software completes 

the current sample tube acquisition.

8 When the acquisition completes, the saturation information window appears. Select OK.
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The saturated icon appears in the Tube List next to the tube if the tube data acquired is 
saturated. Skip to Step 11.

9 When the auto recorded events reach 2,000, the confirmation window prompts. 

NOTE The default saturation threshold is 5%.

NOTE The acquisition continues when the confirmation window prompts.
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10 Select Ignore current well or Ignore whole plate to close the confirmation window.

Or

Select Stop to stop the acquisition.

NOTE If you select Ignore whole plate, the confirmation window will no longer prompt.

NOTE If you select Ignore current well, the following confirmation window appears when the current 

sample tube acquisition completes. The acquisition stops.

 • Select Ignore whole plate to continue the acquisition. The confirmation window will no longer 

prompt.

 • Select Resume to continue the acquisition. The confirmation window will prompt when the next 

tube is saturated.

 • Select Stop to stop the acquisition.
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11 Right-click a tube and select View Saturation. The View Saturation window appears.

12 Select Close.
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Load Sample and Record Data

Before Running Samples

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 6, Before Running 
Samples for detailed instructions.

NOTE The Detector Configuration function is only available in Conventional Mode. 

Sampling and Collecting Data [Without Plate Loader]

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 6, Sampling and 
Collecting Data [Without Plate Loader] for detailed instructions.

NOTE The Compensation function is only available in Conventional Mode. 

Sampling and Collecting Data [With Plate Loader]

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 6, Sampling and 
Collecting Data [With Plate Loader] for detailed instructions on the following procedures:

 • Creating a Heat Map [with Plate Loader]

 • Refreshing a Heat Map

 • Modifying Existing Heat Map Settings

 • Deleting an Existing Heat Map

 • Exporting a Heat Map

NOTE In the CytExpert for Spectral software, the Heat Map function is only available when the tube contains 

unmixed data.

Analyzing and Exporting Data

1 Select Raw/Unmixed located on the bottom of the plot area to open the raw/unmixed 

worksheet (see Figure 2.1 and Figure 2.2).
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2 Select the sample tube to be analyzed.

3 Establish new gates or adjust the position of existing gates. Refer to Creating Plots and Gates.

NOTE Changing a gate’s position does not affect the positions of other gates already established on a 

given sample tube. Each test tube individually records the positions of its associated gates. If you 

need to make a change that concerns all the tubes, you must select the gate, then right-click the 

correctly positioned gate and select Apply to All Tubes.

4 Select . The Gate Hierarchy screen appears.

5 Check the relationship between the parent and daughter gates in the Gate Hierarchy window. 

NOTE Newly added gates become subsets of populations displayed in plots with existing gates. Name 

and display color can be modified. Right-click directly on a gate plot to change the name and color.

NOTE Select No Color to leave the gated events uncolored while retaining the color of the parent 

populations. By default, the populations defined by a vertical gate, hinged gate, or four-quadrant 

gate are uncolored.
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6 Right-click the plot and select Bring population to front to make the display color of the specified 

gate appear in front of all other colors, or select Send population to back to hide the display 
color of the specified gate behind all other colors.

7 Select  in the plot area to generate a statistical table.

8 Right-click the table and select Statistics Setting to modify the settings of the statistics display 

parameters. The Statistics Setting window appears.
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The Statistics Setting window allows you to change the display of the header, statistical 
elements and cell populations included.
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The final generated plots appear as below.

9 Right-click a plot and select Export to Clipboard or Export to Graphic File from the drop-down 

menu to select an image to export.

 • Export to Clipboard copies the plot to the clipboard, allowing you to paste it directly into 
documents in common file formats.

NOTE Multiple plots can only be copied and pasted into Microsoft Word. If a single plot is copied, 

this can be pasted into both Microsoft Word or Microsoft PowerPoint.

 • Export to Graphic File saves the plot as an image file.

NOTE Export to Graphic File can export plots in two selectable file formats. BMP bitmap format 

and EMF vector format.
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10 To export statistics, right-click a statistical table to select any one of the available export 

options.

 • Export to CSV File exports individual tube statistics as a single CSV file.

 • Export All Samples to CSV File exports all tube statistics as a single CSV file.

 • Export to Clipboard copies the statistics of an individual sample to the clipboard, allowing 
you to paste them directly into a Microsoft Excel file or other file formats. 

 • Export All Samples to Clipboard assembles the statistics for all the sample tubes of an 
experiment and copies them together to the clipboard. From there they can be pasted as a 
group into a Microsoft Excel file or other file formats.

 • Copy converts a statistical table into an image format that can be pasted into documents.

11 Export the FCS file if necessary. Refer to Exporting FCS Files. 

NOTE Ensure that any storage devices used with the instrument are free from viruses. To guard against 

data loss, Beckman Coulter recommends backing up data on a frequent and regular basis. Beckman 

Coulter is not liable for any loss of data resulting from computer viruses or damage to hardware.
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Exporting FCS Files

Exporting Single Tube Files

NOTE If you are using Conventional Mode, refer to the CytoFLEX Platform Instructions for Use manual, 

CHAPTER 6, Exporting Single Tube Files for detailed instructions.

1 [Standard Experiment]: Right-click the desired tube from the test tube section of the screen and 

select Export FCS File (Raw) or Export FCS File (Unmixed). The Export FCS File window appears.

2 [Spectral Unmixing Experiment]: Right-click the desired tube and select Export FCS File from 

the drop-down menu. The Export FCS File window appears.
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3 Select the population from the Population drop-down menu.

4 Select Area and/or Height.

5 Select the FCS format next to File Version.

NOTE The default setting is FCS 3.1. 

6 Select OK. Specify the file path and file name, and select Save.
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Exporting Multiple FCS Files

NOTE This function is not available in spectral unmixing experiments.

1 Select File > Export FCS File (Raw) or Export FCS File (Unmixed). The Export FCS File window 

appears.

2 Select the desired tubes to export.

NOTE The Select All checkbox allows you to select all of the tubes listed.

3 Select Next.
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4 Select the population from the Population drop-down menu.

5 Select Area and/or Height.

6 Select the FCS format next to File Version.

NOTE The default setting is FCS 3.1. 
D17052AA   6-42



Data Acquisition and Sample Analysis

Analyzing and Exporting Data  6
7 Select  to specify the file path, and select Next. The following massage appears: Export was 

successful.

8 Select Close to exit the Export FCS File window.

Or

Select Back and repeat Steps 1-7 to continue exporting FCS files.

Exporting Plots or the Statistics Table of Multiple Tubes as Picture Files

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 6, Exporting Plots or 
the Statistics Table of Multiple Tubes as Picture Files for detailed instructions.
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Importing and Exporting Instrument Settings

The CytExpert for Spectral software supports importing and exporting instrument settings to 
facilitate the experiment process. Only instrument settings identical to the current configuration 
can be imported with current detector settings.

Select  to edit gain, threshold, and width. These can be imported from an experiment 
file or from a catalog of instrument settings.

NOTE If you are using Conventional Mode, refer to the CytoFLEX Platform Instructions for Use manual, 

CHAPTER 6, Importing and Exporting Instrument Settings for detailed instructions.

Importing Instrument Settings

1 Select the desired sample tube to import and select . The Acq. Setting window 

appears.

NOTE Instrument settings can only be imported into tubes where data has not yet been recorded.
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2 Select Import From File, locate the file with the required instrument settings, or select Import 

From Catalog to import the instrument settings.

[CytoFLEX LX Shown]

3 Select Close.

Exporting Instrument Settings

1 Select the desired sample tube to export and select . The Acq. Setting window 

appears.
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2 Select Export to File to export a current set of instrument settings. Specify the file path and file 

name and select Save. 

NOTE The generated file ends in *.acq.

Or 

Select Export to Catalog, give a name to the settings to be exported, and export the file to the 
software’s Acquisition Setting Catalog, then select OK. 

3 Select Close.

Importing and Exporting Unmixing Settings

The software supports unrestricted importing and exporting of unmixed data, regardless of 
whether the sample tube data has already been acquired. Imported unmixing values only cover 
channels identical with the current instrument configuration. The software automatically adjusts 
unmixing values according to differences in the gain level.

Printing Graphics

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 6, Printing Graphics 
for detailed instructions.

Saving the Experiment

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 6, Saving the 
Experiment for detailed instructions.

Concluding the Experiment

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 6, Saving the 
Experiment for detailed instructions.
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CHAPTER 7

Unmixing

Overview

Spectral unmixing is used to identify the fluorescence signal for each fluorospheres used in a given 
experiment. The spectral unmixing process is to disassemble sample raw data into single dye 
channels according to their spectral signatures. This chapter provides procedures for using the 
CytoFLEX mosaic Spectral Detection Module.

NOTE To switch between Spectral Mode and Conventional Mode, refer to CHAPTER 12, Switching between 

Spectral Mode and Conventional Mode.

Workflow:

This chapter contains information on:

 • Preparing the Spectral Unmixing Sample

 • Creating a Spectral Unmixing Experiment

 • Loading Sample and Recording Data

 • Calculating Unmixing Values

 • Confirming Unmixing Results

 • Saving the Spectral Unmixing Experiment

 • Adjusting Spectral Unmixing

 • Fine Adjustment

Preparing the Spectral Unmixing Sample

For the negative control sample and single positive control sample, you can use blood, cell lines, or 
dedicated compensation beads such as VersaComp Antibody Capture Beads. For details, refer to the 
appropriate reagent instructions for use. The negative control tube is used to determine the 
autofluorescence of the sample.

Prepare spectral 

unmixing 

samples

Ô

Create spectral 

unmixing 

experiment

Ô
Acquire and 

record data
Ô

Calculate 

spectral 

unmixing

Ô

Apply spectral 

unmixing to sample 

for data analysis
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Preparing the Spectral Unmixing Sample [Without Plate Loader]

To perform a spectral unmixing experiment, prepare:

 • A single positive control tube for each color present in the panel

 • A negative control tube

NOTE Users can add more than one single positive control tube or negative control tube as necessary.

Preparing the Spectral Unmixing Sample [With Plate Loader]

To perform a spectral unmixing experiment, prepare:

 • A single positive control well for each color

 • A negative control well

NOTE Users can add more than one single positive control tube or negative control tube as necessary.

Creating a Spectral Unmixing Experiment

Creating a Spectral Unmixing Experiment [Without Plate Loader]

1 Select File > New Spectral Unmixing or New Spectral Unmixing on the start page to create a new 

spectral unmixing experiment.

NOTE The file name of the newly created spectral unmixing experiment has a “.xitsp” suffix.
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2 Navigate to the desired file path and select Save. The Spectral Unmixing Setup window appears.

NOTE A Control is the reference material used for creating the unmixing matrix.

CAUTION

Risk of erroneous results. Select a negative control tube, according to which 

the fluorescence background will be set. If there is not a negative control tube 

available, then the single color tube must have a negative population.

3 Add a negative control tube. 

a. Select Add.

b. Edit the Tube name and Remark as needed.

c. Select the desired control type from the Set as Negative Control for drop-down menu.

NOTE The default control type is Sample and Single Stained. If you select Sample and Single 

Stained, the tube will appear in the unmixing matrix and be used for unmixing calculation. If 

you select Single Stained Only, the tube will not appear in the unmixing matrix and not be used 

for unmixing calculation.

NOTE To add more negative control tubes, repeat Steps a.-c. A maximum of 10 negative control 

tubes can be added for the spectral unmixing experiments.

NOTE To delete a tube, select the desired tube and select Delete.
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4 Add a single stained control tube.

a. Select Add.

b. Select the desired fluorescent tag from the Tube drop-down menu.

NOTE To manage the fluorescent tag, refer to CHAPTER 2, Fluorescent Tag Library.

c. Select the desired control type from the Negative Control Type drop-down menu.

NOTE The default control type is Internal Negative Control. The unstained control tube can be 

selected if needed. 

d. Edit the Label and Remark as needed. 

NOTE Label information is retained in the unmixing matrix. Label information will be applied to the 

corresponding channels when the unmixing matrix is imported for the use in other experiments.

NOTE To add more single stained control tubes, repeat Steps a.-d. A maximum of 60 single stained 

control tubes can be added for the spectral unmixing experiments.

NOTE To delete a tube, select the checkbox to the left of the desired tube and select Delete. 

NOTE To add multiple single stained control tubes, select Add Multiple Controls. The Add Single 

Stained Controls window appears.

Select the Use checkbox to add the desired tube. Select the desired control type from the 
Negative Control Type drop-down menu. Edit the Label and Remark as needed. Select OK.

NOTE The Select All checkbox allows you to select all of the tubes listed.
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5 Select OK. 

After confirmation, the software automatically generates the following unmixing spectral 
experiment.

6 Confirm that the gating and peak channel are appropriate. Use the pan tool to adjust the axis 

scale so that the sample signal appears in a suitable position. Adjust the gate so that it encloses 
the target cell population. Refer to CHAPTER 6, Creating Plots and Gates.

Creating a Spectral Unmixing Experiment [With Plate Loader]

1 Select File > New Spectral Unmixing or New Spectral Unmixing on the start page to create a new 

spectral unmixing experiment.

NOTE The file name of the newly created spectral unmixing experiment has a “.xitsp” suffix.
D17052AA   7-5



Unmixing

Creating a Spectral Unmixing Experiment  
2 Navigate to the desired file path and select Save. The Spectral Unmixing Setup window appears.

NOTE A Control is the reference material used for creating the unmixing matrix.

CAUTION

Risk of erroneous results. Select a negative control tube, according to which 

the fluorescence background will be set. If there is not a negative control tube 

available, then the single color tube must have a negative population.

3 Add a negative control tube. 

a. Select Add.

b. Edit the Tube name and Remark as needed.

c. Select the desired control type from the Set as Negative Control for drop-down menu.

NOTE The default control type is Sample and Single Stained. If you select Sample and Single 

Stained, the tube will appear in the unmixing matrix and be used for unmixing calculation. If 

you select Single Stained Only, the tube will not appear in the unmixing matrix and not be used 

for unmixing calculation.

d. Select the plate type, sampling sequence, mix and backflush settings for the tube.

e. Select Set As Sample Well to assign well location.

NOTE To add more negative control tubes, repeat Steps a.-e. A maximum of 10 negative control 

tubes can be added for the spectral unmixing experiments.
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4 Add a single stained control tube.

a. Select Add.

b. Select the desired fluorescent tag from the Tube drop-down menu.

NOTE To manage the fluorescent tag, refer to CHAPTER 2, Fluorescent Tag Library.

c. Select the desired control type from the Negative Control Type drop-down menu.

NOTE The default control type is Internal Negative Control. The unstained control tube can be 

selected if needed.

d. Edit the Label and Remark as needed.

NOTE Label information is retained in the unmixing matrix. Label information will be applied to the 

corresponding channels when the unmixing matrix is imported for the use in other experiments.

e. Select the plate type, sampling sequence, mix and backflush settings for the tube.

f. Select Set As Sample Well to assign well location.

NOTE To add more single stained control tubes, repeat Steps a.-f. A maximum of 60 single stained 

control tubes can be added for the spectral unmixing experiments.

NOTE To delete a tube, select the checkbox to the left of the desired tube and select Delete. 

NOTE To add multiple single stained control tubes, select Add Multiple Controls. The Add Single 

Stained Controls window appears.
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Select the Use checkbox to add the desired tube. Select the desired control type from the 
Negative Control Type drop-down menu. Edit the Label and Remark as needed. Select OK.

NOTE The Select All checkbox allows you to select all of the tubes listed.

5 If you need to add multiple single stained control tubes, select Add Multiple Controls. The Add 

Single Stained Controls window appears. 

Select the Use checkbox to add the desired tube. Select the desired control type from the 
Negative Control Type drop-down menu. Edit the Label and Remark as needed. Select OK.

NOTE The Select All checkbox allows you to select all of the tubes listed

Select the plate type, sampling sequence, mix and backflush settings for all the tubes added.
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6 Select OK.

After confirmation, the software automatically generates the following unmixing spectral 
experiment.

7 Confirm that the gating and peak channel are appropriate. Use the pan tool to adjust the axis 

scale so that the sample signal appears in a suitable position. Adjust the gate so that it encloses 
the target cell population. Refer to CHAPTER 6, Creating Plots and Gates.

8 Before acquiring data, ensure the plate has been loaded properly. Data can be acquired as a 

single well or as a set of wells. Refer to CHAPTER 6, Sampling and Collecting Data [With Plate 
Loader].

Loading Sample and Recording Data

Refer to CHAPTER 6, Load Sample and Record Data for detailed instructions on loading sample and 
recording data.

NOTE If you change the acquisition settings of a negative control tube, the new acquisition settings will apply 

to all relevant single stained control tubes without data. 
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Calculating Unmixing Values

1 Select  or select Spectral Unmixing from the Settings menu to calculate the spectral 

unmixing values. The following system prompt appears.

2 The Unmixing Result window appears.
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3 Select Save As to export the unmixing matrix as a .unmix file and specify where to save it.

NOTE The unmixing matrix can also be imported for use in other experiments.

4 Select Save to Library to save the unmixing settings in the spectral library. The Save to Spectral 

Library window appears.

5 Specify the Keyword and select OK.

NOTE The settings stored in the spectral library are specific to the detector configuration. The spectral 

library can only be applied when the detector configuration are the same.

6 Select Close.

NOTE At any time, saved spectral unmixing experiments can be reopened and the unmixing values can 

be recalculated.
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Confirming Unmixing Results

1 Select a sample tube from the tube list on the left side of the screen and the unmixing plots 

appear on the plot area.

NOTE The unmixing results appears on the right of the Name column. The  indicates that there is 

an unmixing gap. The  indicates that the unmixing gap should be recalculated and refreshed. 

Refer to Fine Adjustment. 

NOTE The software uses the positive-negative method to calculate the unmixing gap.
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2 Select  or select Spectral Unmixing from the Settings menu. The Unmixing Result window 

appears.

NOTE The Change button in the lower left of the Unmixing Result window allows you to change the 

unmixing algorithm. The two options currently offered are LSM Unmixing and Poisson Unmixing.

NOTE The Normalization Setting drop-down menu in the top right of the Unmixing Result window 

allows you to select the tube gain settings to apply to the unmixing matrix. 

NOTE The Signal drop-down menu in the top right of the Unmixing Result window allows you to select 

which signal type to use, Height or Area. 

NOTE In the Unmixing Details window:

 • The spectral signature chart displays the unmixing matrix values based on the peak channel. 

Use the Legends checkbox to choose which unmixing control’s spectral signature to show.

 • The similarity index is a number between 0-1. The CytExpert for Spectral software displays the 

value in orange as a visual clue. The darker the shade, the higher the similarity.

 • The complexity index is a measure of how distinguishable a collection of spectral signatures are 

from each other when unmixed together. The complexity index is used to assess the stability of 

a linear system.

NOTE In the Unmixing Matrix window, the CytExpert for Spectral software displays the unmixing values 

in either blue, or black, or orange, or red as a visual clue.

 • Blue denotes the value falls below 0, which requires special attention.

 • Black denotes the value falls within 0 - 100, which is acceptable.
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NOTE In the Fine Adjustment Matrix window:

 • The Use checkbox applies the fine adjustment to the selected sample.

NOTE The Fine Adjustment range is from -500 to 500 depending on the spillover percentage calculated. 

The CytExpert for Spectral software displays the value in either black, or orange, or red as a visual 

clue. 

 • Black denotes the value falls within 0 - 99.99, which is acceptable.

 • Orange denotes the value falls within 100 - 399.99, or -99.99 to -0.01, which requires special 

attention.

 • Red denotes the value is within 400 - 500 or -500 to -100, which is unacceptable.

3 If there is an unmixing gap,follow the procedure below:

a. Verify whether the allocated single stained control tube was prepared as required and 
correctly positioned.

b. Verify that the gating and population hierarchy in each tube were correct.

NOTE The minimum recommended number of events in the specified gate is 50.

c. Verify that the peak channel selected in each tube was appropriate. 

d. Repeat Calculating Unmixing Values to recalculate and export the unmixing results.

4 Optional: Use the Fine Adjustment function to adjust the unmixing gaps as needed. Refer to Fine 

Adjustment.

Saving the Spectral Unmixing Experiment

Selecting Save in the File menu allows you to save the experiment. 

Selecting Save As and saving the experiment under a different name allows you to create a backup. 

At any time, saved spectral unmixing experiments can be reopened and the unmixing values 
recalculated.

Concluding the Experiment

Conclude the experiment as follows:

 • Select Standby to return the instrument to the standby state.

 • Select File > Close Experiment to clear the experiment and return to the Start Page.

NOTE If changes were made to the experiment, the software prompts you to save the latest changes in 

the experiment before returning to the Start Page.
D17052AA   7-14



Unmixing

Adjusting Spectral Unmixing  7
 • Shut down the system. Refer to CHAPTER 9, Daily Shutdown.

Adjusting Spectral Unmixing

Importing and Exporting Unmixing Matrix

Importing Unmixing Settings from Unmixing Matrix Files

1 Create a new experiment or open a saved experiment. Refer to CHAPTER 6, Creating an 

Experiment.

2 Select the desired sample tube and select  or select Settings > Unmixing Matrix. The 

Unmixing Matrix window appears.
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3 Select Import and locate the path where unmixing matrix files are saved. Select the 

corresponding unmixing matrix file (.unmix) to import the unmixing values. 

NOTE To import unmixing values from the spectral library, refer to Importing Unmixing Settings from 

the Spectral Library.

Both methods allow you to apply the gain independent unmixing capability. For example, importing 

the unmixing values with or without recalculating the unmixing matrix based on the gain settings.

NOTE Fine adjustment matrix is included in the unmixing matrix, and can be imported with the 

unmixing matrix files (.unmix).

4 After opening the desired unmixing file, the Import Unmixing Matrix window appears.

Select one of the following:

 • Import unmixing matrix and convert based on the current gain.

 • Import unmixing matrix only.

 • Import unmixing matrix and gain.

NOTE

 • If the tube does not have any data when importing unmixing values calculated from other 

instrument settings, the software prompts you to select whether the gain settings must be 

imported as well. Select Yes to import fluorescence channel gains settings along with the rest 

of the data. Select No to allow the CytExpert for Spectral software to adjust the unmixing matrix 

values based on the current gain settings.

 • If the tube does have data when importing unmixing values from other instrument settings, the 

software prompts you to select whether the unmixing values are adjusted based on the current 

gain settings. 

 • It is important to note that automatic adjustments to unmixing values calculated from other 

instrument gain settings could result in incorrect unmixing. Always review the data after 

importing unmixing values to ensure the sample is unmixed properly.
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5 Select OK. The imported unmixing matrix appears in the Unmixing Matrix window. 

6 If necessary, select  to apply the unmixing values to the selected test tubes.

7 Select Close to exit the Unmixing Matrix window.

Importing Unmixing Settings from the Spectral Library

1 Create a new experiment or open a saved experiment. Refer to CHAPTER 6, Creating an 

Experiment.
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2 Select the desired sample tube and select  or select Settings > Unmixing Matrix. The 

Unmixing Matrix window appears.

3 Select . The Spectral Library window appears.
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4 In the Keyword/Controls column, the corresponding unmixing values can be selected for each 

channel. The unmixing values of the same keyword/controls can also be selected using the 
drop-down menus in the Keyword/Controls column.

5 Select OK. The imported unmixing matrix appears in the Unmixing Matrix window. 

6 If necessary, select  to apply the unmixing values to the selected test tubes.

7 Select Close.
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Exporting Unmixing Settings to Unmixing Matrix Files

1 [Standard Experiment]: Select the desired tube that contains the unmixing matrix and select 

 or select Settings > Unmixing Matrix. The Unmixing Matrix window appears.

[Spectral Unmixing Experiment]: Select the desired tube and select  or select Settings > 

Unmixing Matrix. The Unmixing Result window appears.
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2 [Standard Experiment]: Select Export. Specify a path and filename for the unmixing file you are 

saving and select Save.

[Spectral Unmixing Experiment]: Select Save as. Specify a path and filename for the unmixing 
file you are saving and select Save.

NOTE The generated file ends in .unmix.

3 Select Close.
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Exporting Unmixing Settings to Unmixing Matrix Files from the Spectral Library

1 Select Settings > Spectral Library. The Spectral Library window appears.

2 In the Keyword/Controls column, select the desired unmixing values to export.

3 Select Save as. The Select algorithm window appears.

Select one of the following:

 • LSM Unmixing

 • Poisson Unmixing

4 Select OK.
D17052AA   7-22



Unmixing

Adjusting Spectral Unmixing  7
5 Specify a path and filename for the unmixing matrix file you are saving, and select Save.

NOTE The generated file ends in *.unmix.

6 Select Close.

Managing Spectral Library

Unmixing values can be managed in the Spectral Library.

Importing Spectral Library Files

1 Select Settings > Spectral Library. The Spectral Library window appears.
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2 Select Import and locate the path where spectral unmixing settings are saved. Select the 

corresponding spectral library file to import.

3 Select Open to import.

4 Select Close.
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Exporting Spectral Library Files

1 Select Settings > Spectral Library. The Spectral Library window appears.

2 Select Export to specify a path and filename for the unmixing file you are saving.
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3 Select Save.

NOTE The generated file ends in .cfg.

4 Select Close.

Deleting Spectral Library Files

1 Select Settings > Spectral Library. The Spectral Library window appears.

2 In the Keyword/Controls column, the corresponding unmixing values can be selected for each 

channel. The unmixing values of the same keyword/controls can also be selected using the 
drop-down menus in the Keyword/Controls column.
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3 Select Delete. The following message appears:

4 Select Yes.

5 Select Close.

Fine Adjustment

The fine adjustment can be adjusted in an experiment in three ways: auto fine adjustment, manual 
fine adjustment, and fine adjustment matrix.

Auto Fine Adjusting

Select the populations that need to be adjusted in the bivariate plot. Select  from the graphic 
control area to use auto fine adjustment. 

NOTE Select Refresh All Unmixing Gaps  to recalculate and refresh all unmixing gaps after using the 

fine adjustment. 

NOTE The auto fine adjustment function is only available in the spectral unmixing experiment.

Manual Fine Adjustment

Select the populations that need to be adjusted in the bivariate plot. Select  from the graphic 
control area, then click and drag the mouse pointer inside the plot to adjust. In a standard 
experiment, you can drag the mouse pointer vertically and/or horizontally. In a spectral unmixing 
experiment, you can only drag the mouse pointer vertically.

NOTE Select Refresh All Unmixing Gaps  to recalculate and refresh all unmixing gaps after using the 

fine adjustment. 
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Fine Adjustment Matrix

1 [Standard Experiment]: Select the desired tube that contains the unmixing matrix and select 

 or select Settings > Unmixing Matrix. The Unmixing Matrix window appears.

[Spectral Unmixing Experiment]: Select the desired tube and select  or select Settings > 

Unmixing Matrix. The Unmixing Result window appears.
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2 Select the Fine Adjustment Matrix tab, and adjust the fine adjustment value as needed.

3 Select Close.

4 Select Refresh All Unmixing Gaps  to recalculate and refresh all unmixing gaps. 
D17052AA   7-29
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CHAPTER 8

Data Review

Overview

This chapter discusses how to use the Analysis screen to analyze data. Data can be analyzed using 
any computer equipped with the CytExpert for Spectral software. No online connection is required.

Workflow:

This chapter contains information on:

 • Copying Experiments and Importing Data

 • Setting the Plots and Statistics

 • Calculating Sample Volume and Concentration

 • Adjusting Unmixing Settings

 • Exporting Results

Copying Experiments and Importing Data

Copying a Previously Acquired Experiment

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 8, Copying a 
Previously Acquired Experiment.

Importing Previously Acquired Data

The CytExpert for Spectral software can import and analyze compatible FCS data files acquired by 
other CytoFLEX flow cytometers.

NOTE If you are using Conventional Mode, refer to the CytoFLEX Platform Instructions for Use manual, 

CHAPTER 8, Importing Previously Acquired Data for detailed instructions.

1 Create a new experiment or open a saved experiment. Refer to CHAPTER 6, Creating an 

Experiment.

Import experiment or data Ô Plot and configure statistics Ô Export results
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2 [Standard Experiment]: Select File > Import FCS File, specify the file path and select Open.

Imported data files appear in the Tube screen. 

The  symbol in front of each data tube indicates that the data tube is an imported data file. 
Imported data files are copied and saved in the folder where the current experiment data files 
are saved.

3 [Spectral Unmixing Experiment]: Right-click the desired tube and select Import FCS Files from 

the drop-down menu. Specify the file path and select Open.

Imported data files appear in the Tube screen. 

The  symbol in front of each data tube indicates that the data tube is an imported data file. 
Imported data files are copied and saved in the folder where the current experiment data files 
are saved.

Setting the Plots and Statistics

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 8, Setting the Plots 
and Statistics for detailed instructions on the following procedures:

 • Opening the Analysis Screen

 • Creating Histogram and Dot Plot Overlays

For configuring gates and generating statistics, refer to CHAPTER 6, Data Acquisition and Sample 
Analysis.

Calculating Sample Volume and Concentration

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 8, Calculating Sample 
Volume and Concentration for detailed instructions.

Adjusting Unmixing Settings

Data unmixing can be carried out at any time. You can select the desired tube in the tube list on the 

left side of the screen and select  or select Settings > Unmixing Matrix. Refer to CHAPTER 7, 

Adjusting Spectral Unmixing for detailed instructions on adjusting unmixing settings.
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Exporting Results

Refer to CHAPTER 6, Data Acquisition and Sample Analysis.
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CHAPTER 9

Daily Shutdown

Overview

This chapter provides procedures for shutting down the CytoFLEX instrument equipped with the 
CytoFLEX mosaic Spectral Detection Module.

Workflow:

This chapter contains information on:

 • Preparing the Cleaning Solution

 • Running Daily Clean

 • Shutting Down the Instrument

 • Auto Shutdown [CytoFLEX LX Only]

Preparing the Cleaning Solution

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 9, Preparing the Cleaning 
Solution for detailed instructions.

Running Daily Clean

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 9, Running Daily Clean for 
detailed instructions.

Shutting Down the Instrument

1 Shut down the Cytometer. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 

9, Shutting Down the Instrument for detailed instructions on shutting down the Cytometer.

2 Long press the soft button on the front of the Cytometer mosaic Spectral Detection Module to 

turn off the CytoFLEX mosaic Spectral Detection Module.

Prepare the cleaning solution Ô Clean the instrument Ô Turn the instrument off
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3 Optional: Turn off the main power switch on the left of the Cytometer mosaic Spectral 

Detection Module.

Auto Shutdown [CytoFLEX LX Only]

You can set up the system to automatically shutdown the Cytometer. 

To schedule an auto shutdown after acquisition, refer to the CytoFLEX Platform Instructions for Use 
manual, CHAPTER 6, Creating an Experiment.

To schedule an auto shutdown during Daily Clean, refer to the CytoFLEX Platform Instructions for Use 
manual, CHAPTER 11, Daily Clean [With Plate Loader].
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CHAPTER 10

Troubleshooting

Overview

IMPORTANT In addition to the information stated, never disassemble the instrument or have it repaired by 

unauthorized personnel. Beckman Coulter bears no responsibility for any problems arising from the 

unauthorized repair of the instrument. 

This chapter introduces solutions to common problems. If there is a problem, follow the 
information in this chapter to carry out self-inspection. If the problem cannot be resolved, contact 
us.

This chapter contains information on:

 • Precautions/Hazards

 • Disposal Precaution

 • Troubleshooting Table

 • Backup and Restore

Precautions/Hazards

Laser Related Hazards

Beckman Coulter design and manufacture of the instrument complies with the requirements 
governing the use and application of a laser specified in regulatory documents issued by the:

 • U.S. Department of Health and Human Services

 • Center for Devices and Radiological Health (CDRH)

 • International Electrotechnical Commission (IEC)

In compliance with these regulatory documents, every measure has been taken to ensure the health 
and safety of users and laboratory personnel from the possible dangers of laser use.

Use the instrument according to the information in the manuals.

Use controls or adjustments or performance of procedures other than those specified herein might 
result in hazardous radiation exposure.

To ensure your safety, the Cytometer lasers are covered with protective shields. Do not remove 
these shields.

No user-serviceable assemblies are accessible. Do not attempt to remove the laser or open it. The 
instrument has components that are dangerous to the operator. If any attempt has been made to 
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defeat a safety feature, or if the instrument fails to perform as described in its manuals, disconnect 
the power and contact us.

Laser Beam Hazards

The CytoFLEX Platform flow cytometer can be configured with up to 6 solid-state diode lasers that 
are capable of producing laser light at the following levels: 

 • 355 nm, 20 mW solid-state diode laser

 • 375 nm, 60 mW solid-state diode laser

 • 405 nm, 80 mW solid-state diode laser

 • 488 nm, 50 mW solid-state diode laser

 • 561 nm, 30 mW solid-state diode laser

 • 638 nm, 50 mW solid-state diode laser

 • 808 nm, 60 mW solid-state diode laser

A laser beam is a unique light source that shows characteristics different from conventional light 
sources. The safe use of the laser depends upon familiarity with the instrument and the properties 
of coherent, intense beams of light.

WARNING

Risk of personal injury. The laser beam can cause eye damage if viewed either 

directly or indirectly from reflective surfaces (such as a mirror or shiny metallic 

surfaces). To prevent eye damage, avoid direct exposure to the laser beam. Do not 

view it directly or with optical instruments.

Indirect contact with the laser beam from reflective surfaces (such as jewelry or a screwdriver) is 
called specular reflection and might also cause damage.

For these reasons, it is important to:

 • Limit access to the Cytometer to trained and experienced personnel.

 • Never attempt to remove a shield housing a laser and defeat interlocks.

 • Never remove a warning label.

 • Contact us if a label is missing or unclear.

Laser Warning Labels

WARNING

Risk of personal injury from radiation exposure. Never remove the shield 

surrounding a laser. Never remove covers and defeat interlocks.

CDRH-approved and IEC compliant labels are also placed near or on those covers that when 
removed might expose laser radiation. If necessary, a cover with a CDRH-approved or IEC compliant 
label must be removed by a qualified Beckman Coulter Representative only.
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Refer to the following figures for the locations of the CDRH-approved and IEC compliant labels:

See Figure 10.1 for the Laser Warning Label on the Cytometer optical bench.

See Figure 10.2 and Figure 10.3 for the Laser Warning Label on the optical bench (located Inside 
the Cytometer).

See Figure 10.4 for the Laser Warning Label on the 355 nm Laser.

See Figure 10.5 and Figure 10.6 for the Laser Warning Labels on the Cytometer Back Cover.

See Figure 10.7 for the Laser Warning Label on the CytoFLEX mosaic Spectral Detection Module 
Back Cover.

The laser product is classified as CLASS 1 when all protective measures are in place. This product 
complies with 21 CFR Parts 1040.10 and 1040.11 as well as EN60825-1. See Figure 10.1.

Figure 10.1  Laser Warning Label on the Laser Optical Bench [CytoFLEX LX]

Figure 10.2  Laser Warning Label within the Optical Bench (Located Inside the Cytometer) [CytoFLEX S]

LASER RADIATION
AVOID EXPOSURE TO BEAM
CLASS 3B LASER PRODUCT

CAUTION
CLASS 3B LASER RADIATION WHEN
OPEN AND INTERLOCKS DEFEATED

AVOID EXPOSURE TO BEAM
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Figure 10.3  Laser Warning Label within the Optical Bench (Located Inside the Cytometer) [CytoFLEX LX]

Figure 10.4  Laser Warning Label on the 355 nm Laser [CytoFLEX LX]
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Figure 10.5  Laser Warning Labels on the Cytometer Back Cover [CytoFLEX S]

Figure 10.6  Laser Warning Labels on the Cytometer Back Cover [CytoFLEX LX]

FSC5 4 3 1

WARNING

电压：100-240VAC
频率：50Hz/60Hz

WARNING

CLASS   1   LASER   PRODUCT
 PRODUIT   LASER   CLASSE   1
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Figure 10.7  Laser Warning Labels on the CytoFLEX mosaic Spectral Detection Module Back Cover

Disposal Precaution

WARNING

Risk of biohazardous contamination if you have skin contact with the waste 

container, its contents, and its associated tubing. The waste container and its 

associated tubing could contain residual biological material and must be handled 

with care. Clean up spills immediately. Dispose of the contents of the waste 

container in accordance with your local regulations and acceptable laboratory 

procedures.

Use universal precautions when working with pathogenic materials. Means must 

be available to decontaminate the instrument and to dispose of biohazardous 

waste.

Troubleshooting Table

Table 10.1 lists problems that you could encounter while running the CytoFLEX flow cytometer 
with the CytoFLEX mosaic Spectral Detection Module, the probable causes of each problem, and the 
corrective actions. These problems are listed alphabetically in the Index, under the primary entry 
“troubleshooting”.

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 10, Troubleshooting Table for 
detailed instructions on the Cytometer troubleshooting. 

3-638

6-8084-561

1-405

2-355

5-488

100-2
40V~

50/60H
z

T 5A L
250VA

C

CLASS  1  LASER  PRODUCT
COMPLIES  WITH  21   CFR  1040.  10  AND 
1040. 11  EXCEPT  FOR  CONFORMANCE  WITH 
IEC  60825-1  Ed. 3. ,    AS  DESCRIBED   IN 
LASER NOTICE NO. 56,    DATED MAY   8    2019.
MANUFACTURED

CLASS  1 LASER PRODUCT
PRODUIT LASER CLASSE 1
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Table 10.1  Troubleshooting [With CytoFLEX mosaic Spectral Detection Module]

Problem Probable Cause Corrective Action

The CytoFLEX mosaic 

Spectral Detection 

Module cannot be turned 

on.

 • The CytoFLEX mosaic 

Spectral Detection Module is 

turned off in the Cytometer 

menu. [CytoFLEX mosaic 88]

 • The power switch is in the off 

position and the Turn On 

selection will not function in 

the Cytometer menu. 

[CytoFLEX mosaic 88]

 • The power cable is not 

securely connected.

 • The fuse is blown.

1. Ensure the power switch is in the on 

position on the back of the CytoFLEX 

mosaic Spectral Detection Module.

2. Select Turn On in the Cytometer menu. 

[CytoFLEX mosaic 88]

3. Ensure that the power cable is securely 

connected to the back of the CytExpert 

mosaic Spectral Detection Module.

4. If the problem persists, contact us.

The CytExpert for 

Spectral software is not 

responsive after the 

software has been 

launched.

The digital signature validation is 

timing out and failing due to a 

malfunction in the DNS server or 

firewall.

1. Type Registry Editor from the Windows 

search bar to locate the Register Editor.

2. Select Register Editor to open the 

Register Editor window.

3. Select HKEY_CURRENT_USER > 

SOFTWARE > Microsoft > Windows > 

CurrentVersion > WinTrust > Trust 

Providers > Software Publishing. 

4. Double click  to open the Edit 

DWORD Value window.

5. Change the Value data to 23e00.

6. Select the Hexadecimal radio button.

7. Select OK.

8. Close the Registry Editor window.

NOTE Problems resulting from incorrect 

Registry Editor settings may require the 

operating system reinstallation.

The connection indicator 

light in the lower right 

corner of the software 

screen is gray and 

displays Disconnected.

 • Data connection error

 • FAPD data connection error

 • The CytoFLEX mosaic 

Spectral Detection Module is 

not turned on.

 • The CytoFLEX mosaic 

Spectral Detection Module’s 

power cable is disconnected.

1. Ensure that the network cable is securely 

connected to the back of the Cytometer 

and the back of the Workstation. Refer to 

Figure 1.3 or Figure 1.6.

2. Restart the software. Restart the 

Workstation. Refer to CHAPTER 4, 

Initializing the Instrument.

3. Turn on the CytoFLEX mosaic Spectral 

Detection Module using the power switch 

on the back of the CytoFLEX mosaic 

Spectral Detection Module.

4. Verify that the power cable is securely 

connected to the back of the CytoFLEX 

mosaic Spectral Detection Module.

5. If the problem persists, contact us.
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Backup and Restore

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 10, Backup and 
Restore.

Backup

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 10, Backup.

Restore

This software function is the same in both the CytExpert software and the CytExpert for Spectral 
software. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 10, Restore.

Log Cleanup

Use Log Cleanup to delete Experiment Operation Logs and System Operation Logs before a selected 
date.

NOTE These procedures are only available if you have the Electronic Record Management software option 

installed.

NOTE If you are using Conventional Mode, refer to the CytoFLEX Platform Instructions for Use manual, 

CHAPTER 10, Log Cleanup.

1 Ensure all experiment files are closed.
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2 Select Backup/Restore > Log Clean-up. The Log Clean-up window appears.

Backup the data and try again if the operation system prompts the following message:

3 Select the desired date and time. 
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4 Select Next. The Confirm window appears.

Close the experiment and try again if the operation system prompts the following message:

5 Select Yes. The Clean-up succeeded window appears.

6 Select Finish. 
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CHAPTER 11

Cleaning Procedures

Overview

This chapter describes how to carry out certain routine and nonscheduled cleaning procedures. 
Proper cleaning can help extend the service life of the instrument and ensure experimental 
accuracy. When conducting any cleaning, take all necessary biosafety precautions and use proper 
personal protective equipment. 

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 11, Cleaning Procedures for 
detailed instructions on the following procedures:

 • Routine Cleaning

— Daily Clean

— Daily Clean [With Plate Loader]

— Cleaning the Sample Station

— Deep Clean Procedure

— Cleaning the 4 L Sheath Fluid Container

— Cleaning the 4 L Waste Container

 • Nonscheduled Cleaning

— Surface Cleaning and Disinfection

— Preparing the Instrument for Transport or Storage

This chapter contains information on:

 • Preparing the Instrument for Transport or Storage

Preparing the Instrument for Transport or Storage

When the instrument is to be transported or is not to be used for 30 days or more, complete the 
emptying processes to prevent instrument damage and to reduce the possibility of biological 
contamination. Contact us if you have any questions.

1 Prepare the CytoFLEX for transportation or storage. Refer to the CytoFLEX Platform Instructions 

for Use manual, CHAPTER 11, Preparing the Instrument for Transport or Storage for detailed 
instructions.
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2 Power down the CytoFLEX mosaic Spectral Detection Module and disconnect all the cables.

3 If the CytoFLEX mosaic Spectral Detection Module is to be transported or stored, put the 

instrument into the Beckman Coulter supplied packing and comply with the requirements in 
APPENDIX A, Instrument Transportation and Storage, regarding correct placement during 
transportation and storage.

Lifting and Carrying Instructions [CytoFLEX S and CytoFLEX LX]

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 11, Lifting and Carrying 

Instructions for detailed instructions.

Lifting and Carrying Instructions [CytoFLEX mosaic Spectral Detection Module]

1 Position a person on the left and right sides of the CytoFLEX mosaic Spectral Detection Module. 
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Preparing the Instrument for Transport or Storage  11
2 Grasp the CytoFLEX mosaic Spectral Detection Module as shown in the figure below.

3 Gently lift the CytoFLEX mosaic Spectral Detection Module as shown in the figure below.

WARNING

Risk of personal injury. Use caution when lowering the CytoFLEX mosaic Spectral 

Detection Module to avoid pinching fingers.

4 Lower the CytoFLEX mosaic Spectral Detection Module to its designated location. 
D17052AA   11-3
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CHAPTER 12

Replacement/Adjustment Procedures

Overview

This chapter describes how to carry out certain routine and nonscheduled maintenance 
procedures. Proper maintenance can help extend the service life of the instrument and ensure 
experimental accuracy. When conducting any maintenance work, take all necessary biosafety 
precautions. 

IMPORTANT In addition to parts specifically discussed, for all replacement parts, use only parts provided by 

Beckman Coulter to ensure proper functioning of the instrument. Never disassemble any part of the 

instrument without prior authorization. Beckman Coulter assumes no responsibility for any instrument 

problems resulting from the use of any part not authorized by Beckman Coulter for use with the 

instrument. 

Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 12, Replacement/Adjustment 
Procedures for detailed instructions on the following procedures:

 • Routine Replacement/Adjustment

— Front Cover Removal and Reinstallation

— Right-Side Cover Removal and Reinstallation

— Filling the 4 L Sheath Fluid Container

— Replacing the 10 L Sheath Fluid Cubitainer

— Emptying the 4 L Waste Container

— Emptying the 10 L Waste Cubitainer

— Managing the Maintenance Reminder

NOTE If you have previously installed the CytExpert software, the Maintenance data will 

automatically synchronize between the CytExpert Software and the CytExpert for Spectral 

Software.

— Adding the Deep Clean Solution

— Replacing the Sheath Fluid Filter

— Unclogging the Sample Probe [With Sample Injection Mode Control Kit]

— Unclogging the Sample Probe [Without Sample Injection Mode Control Kit]

— Replacing the Sample Probe and/or the Sample Peristaltic Pump Tubing

— Replacing the Sample Probe Assembly [With Plate Loader]

— Changing the Sample Probe from the Single Tube Sample Station to the Plate Loader 
[CytoFLEX With Plate Loader]
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Switching between Spectral Mode and Conventional Mode  
— Changing the Sample Probe from the Plate Loader to the Single Tube Sample Station 
[CytoFLEX With Plate Loader]

— Inspecting the Liquid Flow Path for Leaks

— Priming the Flow Cell

— Replacing the Plate Holder [With Plate Loader]

— Plate Loader Module Removal and Reinstallation [With Plate Loader]

— Changing the Event Rate Setting

 • Nonscheduled Replacement/Adjustment

— Calibrating the Sample Flow Rate

— Calibrating the Sample Flow Rate [With Plate Loader]

— Setting Laser Delay

— Replacing the Fuse

— Replacing the Sheath Fluid Harness and/or Waste Harness

— Changing Sample Mixing and Backflush Settings

— Calibrating the Plate Position [With Plate Loader]

This chapter contains information on:

— Switching between Spectral Mode and Conventional Mode

Switching between Spectral Mode and Conventional Mode

The CytoFLEX flow cytometer equipped with a CytoFLEX mosaic Spectral Detection Module 
supports two work modes: Conventional Mode and Spectral Mode.

 • Spectral Mode: Attach the CytoFLEX mosaic Spectral Detection Module to the CytoFLEX flow 
cytometer to enable its spectral flow functionality and allow users to run more complex assays 
and use spectral unmixing technology for spectral overlap correction. Refer to Switching to 
Spectral Mode for detailed instructions on switching the instrument from Conventional Mode 
to Spectral Mode.

 • Conventional Mode: Adjust how the optical fibers are connected to the Cytometer to use the 
Cytometer’s optical components for collecting optical signals. Refer to Switching to 
Conventional Mode for detailed instructions on switching the instrument from Spectral Mode 
to Conventional Mode. 
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Switching between Spectral Mode and Conventional Mode  12
Switching to Conventional Mode

CAUTION

Risk of data integrity damage. 

 • Verify that the optical fibers are securely connected to the WDM. A loose 

connection can alter the optical path and affect fluorescence.

 • Do not kink the optical fibers.

1 Confirm that the instrument is in the standby state or that the instrument and CytoFLEX mosaic 

Spectral Detection Module are turned off.

2 Open the top cover.

Table 12.1  Optical Fibers with Indicators [CytoFLEX S]

Optical Fibers Indicator Name

Violet Violet fiber

Yellow Yellow fiber

Red Red fiber 

Blue Blue fiber

Table 12.2  Optical Fibers with Indicators [CytoFLEX LX]

Optical Fibers Indicator Name

1 Violet fiber

2 UV/NUV fiber

3 Red fiber

4 Yellow fiber

5 Blue fiber

6 IR fiber

6

1
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3 Locate the Forward Scatter Switch and move the FSC connector from the Spectral Port (1) to 

the Conventional Port (2).

[CytoFLEX LX Shown]
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Switching between Spectral Mode and Conventional Mode  12
4 Disconnect the rest of the optical fibers.

[CytoFLEX LX Shown]

[CytoFLEX S Shown]
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Replacement/Adjustment Procedures

Switching between Spectral Mode and Conventional Mode  
5 Remove the connector protective caps from the WDM optical fiber connectors, and connect 

them to the adapter optical fiber connectors.

[CytoFLEX LX Shown]

6 Connect the correct optical fibers to the corresponding WDMs. Ensure the indicator number or 

color of the optical fiber matches the corresponding WDM. Refer to Table 12.1 and Table 12.2.

7 Close the top cover.

LASER RADIATION
AVOID EXPOSURE TO BEAM
CLASS 3B LASER PRODUCT

CAUTION
CLASS 3B LASER RADIATION WHEN
OPEN AND INTERLOCKS DEFEATED

AVOID EXPOSURE TO BEAM

CytoFLEX S CytoFLEX LX
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Switching between Spectral Mode and Conventional Mode  12
8 Log out of the CytExpert for Spectral software. Refer to CHAPTER 4, Logging Out of the 

Software.

9 Log into the CytExpert software. Refer to the CytoFLEX Platform Instructions for Use manual, 

CHAPTER 4, Logging into the Software for detailed instructions. 

10 Initialize the instrument. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 

4, Initializing the Instrument for detailed instructions. 

NOTE If the instrument is turned off in Step 1, turn on the instrument. Refer to the CytoFLEX Platform 

Instructions for Use manual, CHAPTER 4, Turning On the Instrument for detailed instructions. 

11 Run QC. Refer to the CytoFLEX Platform Instructions for Use manual, CHAPTER 5, Quality Control 

for detailed instructions.

Switching to Spectral Mode

1 Confirm that the instrument is in the standby state or that the instrument is turned off.

2 Open the top cover.
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Switching between Spectral Mode and Conventional Mode  
3 Locate the Forward Scatter Switch and move the FSC connector from the Conventional Port (2) 

to the Spectral Port (1).

4 Disconnect the rest of the optical fibers. 

LASER RADIATION
AVOID EXPOSURE TO BEAM
CLASS 3B LASER PRODUCT

CAUTION
CLASS 3B LASER RADIATION WHEN
OPEN AND INTERLOCKS DEFEATED

AVOID EXPOSURE TO BEAM

CytoFLEX S CytoFLEX LX

p
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Replacement/Adjustment Procedures

Switching between Spectral Mode and Conventional Mode  12
5 Remove the connector protective caps from the adapter optical fiber connectors, and connect 

them to the WDM optical fiber connectors.

6 Connect the correct optical fibers to the adapter optical fiber connectors. Ensure the indicator 

number or color of the optical fiber matches the corresponding adapter optical fiber 
connectors. Refer to Table 12.1 and Table 12.2 

LASER RADIATION
AVOID EXPOSURE TO BEAM
CLASS 3B LASER PRODUCT

CAUTION
CLASS 3B LASER RADIATION WHEN
OPEN AND INTERLOCKS DEFEATED

AVOID EXPOSURE TO BEAM

CytoFLEX SCytoFLEX LX
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Switching between Spectral Mode and Conventional Mode  
7 Close the top cover.

8 Turn on the instrument and the CytoFLEX mosaic Spectral Detection Module. Refer to 

CHAPTER 4, Turning On the Instrument.

9 Log out of the CytExpert software. Refer to the CytoFLEX Platform Instructions for Use manual, 

CHAPTER 4, Logging Out of the Software for detailed instructions.

10 Log into the CytExpert for Spectral software. Refer to CHAPTER 4, Logging into the Software. 

11 Initialize the instrument. Refer to CHAPTER 4, Initializing the Instrument. 

12 Run QC. Refer to CHAPTER 5, Quality Control.
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APPENDIX A

Instrument Installation

Overview

[CytoFLEX S]: Your instrument may have been shipped directly to your laboratory, in which case 
you will need to set up and connect the Cytometer and the Workstation. Refer to this chapter for 
the instrument installation procedure.

[CytoFLEX LX]: The CytoFLEX LX is installed by your Beckman Coulter Service Representative. Do 
not open the box or crate. Wait for a qualified Beckman Coulter Service Representative.

[CytoFLEX mosaic 63/88]: The CytoFLEX mosaic 63/88 is installed by your Beckman Coulter Service 
Representative. Do not open the box or crate. Wait for a qualified Beckman Coulter Service 
Representative.

This chapter contains information on:

 • Instrument Transportation and Storage

 • Installation Environment Validation

 • Unpacking the Instrument and Inspecting the Materials for Defects or Omissions

 • Installing the Instrument and Connecting the Equipment

 • CytExpert for Spectral Software Installation Options

 • Installing the CytoFLEX for Spectral Software

 • Reinstalling the CytExpert for Spectral Software

 • Restoring the Cytometer and CytoFLEX mosaic Spectral Detection Module Configuration File

Instrument Transportation and Storage

Refer to CHAPTER 11, Preparing the Instrument for Transport or Storage, prior to transportation or 
storage.

Attention to the following items is required when transporting or storing the instrument:

 • Take caution to protect the instrument from exposure to rain or sunlight.

 • Always place the instrument on a flat, stable surface, and take note of the symbol for this side up.

 • Ambient temperature: -10 to 55 °C.

 • Ambient humidity: < 80% RH. 

 • To prevent extrusion, the load on top cannot exceed 100 kg.

Validate the environment Ô Open the package Ô Install the instrument Ô Prepare to boot
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Instrument Installation

Installation Environment Validation  
 • CytoFLEX S Cytometer gross weight 27 kg; transport the instrument using only appropriate 
equipment so as to guard against personal injury.

 • CytoFLEX LX Cytometer gross weight 103 kg; transport the instrument using only appropriate 
equipment so as to guard against personal injury.

 • CytoFLEX mosaic 63 gross weight 68 kg; transport the instrument using only appropriate 
equipment so as to guard against personal injury.

 • CytoFLEX mosaic 88 gross weight 71 kg; transport the instrument using only appropriate 
equipment so as to guard against personal injury.

Installation Environment Validation

IMPORTANT This instrument is intended for indoor use only.

Verify whether the installation environment satisfies the following requirements:

Worktable

CAUTION

Risk of instrument damage. Place the instrument on a level surface. Failing to do 

so places the system is in danger of toppling and can result in damage. Take all 

necessary precautions throughout the process of storing or transporting the 

instrument.

 • The tabletop must be smooth and level.

 • Minimum tabletop load bearing capacity [CytoFLEX S with CytoFLEX mosaic 63]: 90 kg.

 • Minimum tabletop load bearing capacity [CytoFLEX LX with CytoFLEX mosaic 88]: 140 kg.

 • The tabletop must not vibrate or shake.

 • Minimum tabletop dimensions [CytoFLEX S with CytoFLEX mosaic 63]: 120 cm x 80 cm; 
minimum vertical space above tabletop: 100 cm.

 • Minimum tabletop dimensions [CytoFLEX LX with CytoFLEX mosaic 88]: 200 cm x 80 cm; 
minimum vertical space above tabletop: 100 cm.

 • Position the instrument in such a manner that it will facilitate disconnection of the power cable 
at the instrument end.

Ventilation and Cleaning

IMPORTANT If necessary, use ventilation equipment, but airflow must not be allowed to blow directly on 

the system, as it can affect the reliability of the data.

 • Ensure that the working environment is well ventilated for proper heat dissipation. 

 • Maintain a clearance of at least 20 cm from the back of the instrument for heat dissipation.

 • Keep the environment as dust free as possible.
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Instrument Installation

Installation Environment Validation  A
 • Avoid direct exposure to sunlight.

 • Avoid placing near heat sources or exposing to drafts.

 • Avoid corrosives or flammable gases.

Power Source

DANGER

Risk of electric shock and/or instrument damage. Ensure that the power source is 

properly grounded. Improper grounding can cause electric shock and damage the 

system. Verify that the output voltage of the power outlet conforms to the system 

requirements and that a 5 A, time delay, T 5 AL 250 VAC fuse is installed. To 

prevent personal injury, Beckman Coulter recommends using a power source 

designed to protect against electrical shock.

CAUTION

Possible instrument damage could occur if you use an extension cord or a power 

strip to connect the Cytometer. Always plug the Cytometer into a dedicated outlet 

with an isolated ground.

The power source requirements are as follows:

 • This instrument has been tested to and meets all applicable requirements for CE Marking.

 • This instrument complies with the emission and immunity requirements described in 
IEC 61326-1.

 • This equipment has been designated and tested to CISPR 11 Class A. In a domestic environment 
it may cause radio interference, in which case, you may need to take measures to mitigate the 
interference.

 • It is advised that the electromagnetic environment should be evaluated prior to operation of 
the device.

 • Do not use this device in close proximity to sources of strong electromagnetic radiation 
(unshielded intentional RF sources), as these may interfere with the proper operation.

 • 100-240 volts, 50/60 Hz, 3-wire power cable, well grounded.

 • Amperage not less than 10 A.

 • The system requires a well-grounded power outlet (150 VA normal, 250 VA max) to provide the 
necessary power.

 • Distance from system to socket less than 1.5 m.

Power consumption of the Plate Loader is <30 W.
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Instrument Installation

Installation Environment Validation  
Temperature and Humidity

CAUTION

Risk of instrument damage and/or erroneous results. To ensure reliability, the 

system must be operated in the specified environment, within the required 

temperature and humidity ranges. If the ambient temperature or humidity level 

falls outside the ranges mentioned above, use appropriate air conditioning.

 • CytoFLEX S: Ambient temperature: 15-27°C with fluctuations of no more than <±2°C per hour. 

 • CytoFLEX LX: Ambient temperature: 15-30°C with fluctuations of no more than <±2°C per hour. 

 • CytoFLEX mosaic Spectral Detection Module: Ambient temperature: 15-30°C with fluctuations of 
no more than <±2°C per hour.

 • Relative humidity: 15% RH-80% RH, non-condensing.

Waste Disposal

WARNING

Risk of biohazardous contamination if you have skin contact with the waste 

container, its contents, and its associated tubing. The waste container and its 

associated tubing might contain residual biological material and must be handled 

with care. Clean up spills immediately. Dispose of the contents of the waste 

container in accordance with your local regulations and acceptable laboratory 

procedures.

The waste line from the Cytometer is connected to a waste container/cubitainer. Dispose of the 
system’s waste in accordance with your local regulations and acceptable laboratory procedures.

The waste line supplied with the instrument can be connected to an open drain. If you use an open 
drain, mechanically secure the waste tube into the drain so the tube cannot accidentally come out 
of the drain. This prevents spillage.
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Unpacking the Instrument and Inspecting the Materials for Defects or Omissions  A
Unpacking the Instrument and Inspecting the Materials for Defects or 

Omissions

CAUTION

Possible instrument damage could occur if you uncrate the instrument, install it, 

or set it up especially when you are in doubt of an instrument damage during 

shipment. Keep the instrument in its package until your Beckman Coulter 

Representative unpacks it for installation and setup.

When you receive your instrument, carefully inspect all cartons. If you see signs of mishandling or 
damage, file a claim with the carrier immediately. If separately insured, file the claim with the 
insurance company.

Take care to store the instrument in a suitable environment where it can remain in the proper 
position.

[CytoFLEX S and CytoFLEX LX]: Check that the following components on the packing list are present:

 • Cytometer

 • Cables

 • Computer

 • Mouse

 • Keyboard

 • Monitor

 • Fluid Container holder

 • Sheath fluid container [CytoFLEX S]

 • Waste container

 • Sheath fluid tubing

 • Waste tubing

 • USB configuration key

 • Software USB

NOTE For the computer related components, refer to the manufacturer’s manual.

[CytoFLEX mosaic Spectral Detection Module]: Check that the following components on the packing 
list are present:

 • CytoFLEX mosaic

 • Ethernet cable

 • Power cable

 • FSC cables

 • USB configuration key

 • Software USB
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Installing the Instrument and Connecting the Equipment  
 • Optical Fibers

 • Top Cover and hinge board

 • WDM Fixed block

 • Cable ties

 • FSC connect box

 • FSC cable strain relief bush

 • Connector protective covers

 • Laser cover [CytoFLEX mosaic 88]

 • Fiber digital wire clips [CytoFLEX mosaic 88]

Installing the Instrument and Connecting the Equipment

CAUTION

Risk of personal injury. Do not transfer the instrument from one location to 

another after the instrument installation is completed by service.

Installing the Instrument and Connecting the Equipment [CytoFLEX S]

Refer to the CytoFLEX Platform Instructions for Use manual, APPENDIX A, Installing the Instrument 
and Connecting the Equipment [CytoFLEX] for detailed instructions. For connecting the 
instrument, refer to Figure 1.3.

Installing the Instrument and Connecting the Equipment [CytoFLEX LX]

The CytoFLEX LX must be must be installed by a trained Beckman Coulter service engineer. For 
connecting the instrument, refer to Figure 1.6.

Installing the CytoFLEX mosaic Spectral Detection Module

The CytoFLEX mosaic Spectral Detection Module must be installed by a trained Beckman Coulter 
service engineer. For connecting the instrument, refer to Figure 1.3, Figure 1.6 and Figure 1.10.
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CytExpert for Spectral Software Installation Options  A
CytExpert for Spectral Software Installation Options

CytExpert for Spectral software has two installation options upon install.

 • CytExpert for Spectral User Management software option. User Login is required to run the 
system. Contains features and functionality that facilitates user and role management.

 • CytExpert for Spectral Electronic Record Management software option. User Login is required 
to run the system. Contains features and functionality that facilitates compliance with 21 CFR 

Part 11 guidelines for Electronic Records and Signatures.

Installing the CytoFLEX for Spectral Software

The CytExpert for Spectral software is installed by Beckman Coulter service.
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Reinstalling the CytExpert for Spectral Software  
Reinstalling the CytExpert for Spectral Software

IMPORTANT The CytExpert software and the CytExpert for Spectral software can be installed on the same 

computer, but you cannot use the CytExpert for Spectral software and the CytExpert software together.

Use this procedure to:

 • Change the software option installed. Refer to CytExpert for Spectral Software Installation 
Options for the differences between each software option available.

 • Reinstall the same version of software.

 • Upgrade your software to a higher version.

NOTE If you are using Conventional Mode, refer to the CytoFLEX Platform Instructions for Use manual, 

APPENDIX A, Reinstalling the CytExpert Software.

CAUTION

Risk of data loss. Reinstalling the CytExpert for Spectral software could overwrite 

your database. Ensure you backup your database prior to software reinstallation.

Uninstalling the Software

IMPORTANT Ensure you backup all of your data before uninstalling the software.

1 Backup your CytExpert for Spectral data if you previously had the User Management or 

Electronic Record Management software option installed. Refer to CHAPTER 10, Backup and 
Restore.

2 Insert the software USB into the computer.

NOTE If the Autoplay window appears, select Open folder to view files.
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Reinstalling the CytExpert for Spectral Software  A
3 Select CytExpert for Spectral Setup_x.x.x.exe. The Welcome to the CytExpert for Spectral Setup 

Wizard window appears.

A User Account Control message may display the message Do you want to allow this app to make 
changes to your device? Select Yes to continue.
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Reinstalling the CytExpert for Spectral Software  
4 Select Next. The Change your installation of CytExpert for Spectral screen appears.

5 Select Remove. The Begin remove of CytExpert for Spectral screen appears.
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Reinstalling the CytExpert for Spectral Software  A
6 Select Remove. The Removing Progress window appears.
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Instrument Installation

Reinstalling the CytExpert for Spectral Software  
IMPORTANT If you select Yes to remove the CytExpert for Spectral settings, CytExpert for Spectral 

database, cytometer configuration, and temporary files, your settings, database, configuration files, and 

temporary files will be overwritten and you will need to reinstall your cytometer configuration and restore 

any databases you might have.

7 The message Would you like to remove CytExpert for Spectral settings, CytExpert for Spectral 

database, cytometer configuration and temporary files? appears. Select No.
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Reinstalling the CytExpert for Spectral Software  A
8 When software removal is complete, the software displays the message CytExpert for Spectral 

has been removed successfully.

9 Select Close.
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Reinstalling the CytExpert for Spectral Software  
Reinstalling the CytExpert for Spectral Software

1 Insert the software USB into the computer.

NOTE If the Autoplay window appears, select Open folder to view files.

2 Select CytExpert for Spectral Setup_x.x.x.exe. The Welcome to the CytExpert for Spectral Setup 

Wizard window appears.

A User Account Control message may display the message Do you want to allow this app to make 
changes to your device? Select Yes to continue.
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Reinstalling the CytExpert for Spectral Software  A
3 Select Next. The Beckman Coulter License Terms window appears.

4 Read the Beckman Coulter Customer End User License Agreement.

5 Select the I accept the terms of this agreement checkbox.

NOTE The checkbox is not selectable until you scroll all the way to the end of the agreement.
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Reinstalling the CytExpert for Spectral Software  
6 Select Next. The Choose a file location window appears.

7 Select Next. The Installation Options window appears.

8 Select the desired installation option. Refer to CytExpert for Spectral Software Installation 

Options.
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Reinstalling the CytExpert for Spectral Software  A
9 Select Next. The Begin installation of CytExpert for Spectral window appears.

10 Select Install to begin installing the software. The Installation Progress window appears.
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Reinstalling the CytExpert for Spectral Software  
11 If the following software prompt appears, select OK.

NOTE The term “device” in this message refers to the cytometer.

12 Wait for the software to finish installing. The install complete window appears. 

13 Select Close to finish the CytExpert for Spectral software installation.
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Restoring the Cytometer and CytoFLEX mosaic Spectral Detection 

Module Configuration File

1 Insert the software USB into the computer.

NOTE If the Autoplay window appears, select Open folder to view files.

2 Open the CytExpert for Spectral software. Refer to CHAPTER 4, Logging into the Software.

3 Select Advanced > Restore Configuration. The Restore Configuration window appears.

NOTE Ensure the experiment is closed.

4 Select  and browse to the desired configuration file folder from your Software USB.

5 Open the Cytometer configuration file CytExpert for Spectral_x.x.xxx_Config_Backup_.bak.
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Restoring the Cytometer and CytoFLEX mosaic Spectral Detection Module Configuration File  
6 Select Execute. The Restore Configuration window appears.

7 Select Yes to start restore the configuration.

8 Select Finish.

NOTE If the CytExpert software is installed, its configuration will automatically synchronized with the 

restored configuration. Restart the CytExpert software to apply the restored configurations.

9 Select OK.
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APPENDIX B

CytExpert for Spectral Electronic Record
Management

Overview

IMPORTANT You must have the CytExpert for Spectral Electronic Record Management software option 

installed to use the features listed below. Refer to APPENDIX A, CytExpert for Spectral Software 

Installation Options.

Beckman Coulter’s CytoFLEX with CytExpert for Spectral software version 1.0 and higher contains 
features and functionality that facilitates compliance with 21 CFR Part 11 guidelines for Electronic 
Records and Signatures. This electronic record management includes controls for user 
identification, permissions, electronic signatures, data integrity, operation and experiment logs 
and audit trails. CytExpert for Spectral software version 1.0 and higher contains a database that uses 
checksum matching to prevent tampering of the records and files that are indexed in the Closed File 
System.

This chapter contains information on:

 • Software Menu

 • Experiment Management

 • Log

 • Electronic Signature

 • User Management

Software Menu

The CytExpert for Spectral Electronic Record Management software option includes additional 
software menu items that are not available in the CytExpert for Spectral User Management 
software option. Refer to Figure 2.5 and Figure 2.6 for comprehensive software menu trees and 
details on which menu item applies to each software option. 

NOTE If your CytoFLEX instrument is not equipped with a CytoFLEX mosaic Spectral Detection Module or if 

you are using Conventional Mode, refer to the CytoFLEX Platform Instructions for Use manual, APPENDIX 

B, Software Menu.
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CytExpert for Spectral Electronic Record Management

Experiment Management  
Experiment Management

CAUTION

Risk of file corruption. Do not add, delete, or modify data from the Windows 

Explorer directory. Manage all data changes using Experiment Explorer to ensure 

file indexing remains intact.

Closed File System

Refer to the CytoFLEX Platform Instructions for Use manual, APPENDIX A, Closed File System for 
detailed instructions.

Experiment Directory Management

Refer to the CytoFLEX Platform Instructions for Use manual, APPENDIX A, Experiment Directory 
Management for detailed instructions.

Folder Hierarchy Management

Refer to the CytoFLEX Platform Instructions for Use manual, APPENDIX A, Folder Hierarchy 
Management for detailed instructions.
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CytExpert for Spectral Electronic Record Management

Log  B
Experiment Related Operations

The Experiment Explorer dialog appears in place of the Windows File Explorer in the following 
operations: New/Open Experiment, New/Open Spectral Unmixing, Save As, Save As Template, 
Recent Template, and New Experiment from Template.

Importing an Experiment/Template

Refer to the CytoFLEX Platform Instructions for Use manual, APPENDIX B, Importing an Experiment/
Template for detailed instructions on importing experiment (.xit), spectral unmixing (.xitsp), or 
experiment from template (.xitm) files into the system.

Exporting an Experiment/Template

Refer to the CytoFLEX Platform Instructions for Use manual, APPENDIX B, Exporting an Experiment/
Template for detailed instructions on exporting experiment (.xit), spectral unmixing (.xitsp), or 
experiment from template (.xitm) files from the system.

Log

Refer to the CytoFLEX Platform Instructions for Use manual, APPENDIX B, Log for detailed instructions 
on the following: 

 • Experiment Operation Log

 • System Operation Log

 • User Management Operation Log
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Electronic Signature  
Electronic Signature

Refer to the CytoFLEX Platform Instructions for Use manual, APPENDIX B, Electronic Signature for 
detailed instructions on the following procedures:

 • Signing Experiments

 • Rejecting Experiment

 • Setting the Signature Retention Period

 • Signature Setting

 • Printing an Experiment Signature

User Management

User Administration

Logging In and Out of the Software

Refer to CHAPTER 4, Logging into the Software and CHAPTER 4, Logging Out of the Software.

Locking the Account

Refer to CHAPTER 4, Locking the Account.

Role Management

Refer to CHAPTER 2, Role Management.

User Management

Refer to CHAPTER 2, User Management.

Account Policies

Refer to CHAPTER 2, Account Policies.
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APPENDIX C

Sample Injection Mode Control Kit

Overview

The Sample Injection Mode Control Kit is a mechanical knob installed by your service engineer that 
enables users to switch between the Plate Loader sample injection mode and the Semi-Automatic 
or manual sample injection mode. The switch eliminates the need to manually re-route the tubing.

Refer to the CytoFLEX Platform Instructions for Use manual, APPENDIX C, Sample Injection Mode 
Control Kit for detailed instructions on the following procedures:

 • Performance Characteristics [With the Sample Injection Mode Control Knob]

 • Sample Injection Mode Control Kit Components

 • Switching the Sample Probe from the Single Tube Sample Station to the Plate Loader [With 
Sample Injection Mode Control Knob]

 • Switching the Sample Probe from the Plate Loader to the Single Tube Sample Station [With 
Sample Injection Mode Control Knob]
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Overview  
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APPENDIX D

Deep Well Plate

Specimen Collection Plate Specifications

Refer to the CytoFLEX Platform Instructions for Use manual, APPENDIX D, Specimen Collection Plate 
Specifications for detailed instructions.
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Specimen Collection Plate Specifications  
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APPENDIX E

Cyber Security

Overview

The following procedures are the only validated and approved recommendations for cyber privacy 
and security. Contact your IT professional for assistance.

 • Changes below require Administrator level Windows access.

 • Before connecting to an external device such as a hard drive, USB, or DVD/CD, verify it does not 
have a virus or malware.

NOTE Beckman Coulter recommends using multiple anti-virus software to ensure that all viruses or 

malware can be identified.

 • Close all unnecessary applications while operating the CytExpert for Spectral software.

CAUTION

Risk of security vulnerabilities and privacy issues. Use the USB and Ethernet ports 

with caution. Unauthorized or improper use of these ports will lead to potential 

information security risks. Beckman Coulter recommends disabling all the unused 

USB and Ethernet ports on the instrument computer. Ensure that only trusted and 

authorized devices are connected to the active ports.

To prevent unauthorized access and data breaches, Beckman Coulter 

recommends checking the use of the USB and Ethernet ports on a regular basis.

CAUTION

System integrity could be compromised and operational failures could occur if:

 • You introduce software that is not authorized by Beckman Coulter into your 

computer. Only operate your system’s computer with software authorized by 

Beckman Coulter.

 • You apply domain policies which alter the default configuration.

 • You alter the system in a manner other than the approved changes outlined 

below.

IMPORTANT Beckman Coulter Life Sciences has assembled a global product security team to assess 

vulnerabilities and determine responses in a coordinated Vulnerability Disclosure (CVD) process. If you 

encounter a potential threat to cyber security, please contact us via 

https://www.beckman.com/about-us/compliance/coordinated-vulnerability-disclosure.
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Drive Encryption  
This chapter contains information on:

 • Drive Encryption

 • Protection from Malware Software

 • Security Updates

 • User Management

 • System Hardening

 • Remote Access

Drive Encryption

Your Windows 10 system is equipped with BitLocker. Use BitLocker disk encryption software to 
prevent unauthorized access to your hard drive, refer to BitLocker Keys. For instructions on 
BitLocker Encryption or BitLocker Decryption, see Enabling BitLocker or BitLocker Decryption.

IMPORTANT BitLocker is the only approved encryption method.

BitLocker Keys

CAUTION

Risk of data loss. Store your BitLocker key in a safe place. For instructions on 

saving your BitLocker key, refer to Backing Up Your Recovery Key. If you lose your 

BitLocker Key, you will lose access to your entire hard drive including all of your 

data. Beckman Coulter is not responsible for security keys and will not be able to 

recover your data off your hard drive. Work with your IT department in creating 

and storing the keys in a safe place.

Changing Encryption Strength Level for BitLocker

BitLocker defaults to XTS-AES 128-bit encryption method. To alter the encryption, follow the steps 
below before enabling BitLocker. Changes to the encryption level will only impact the encryption 
of new volumes. Work with your IT department to change the Encryption Strength Level.
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Changing the encryption strength for BitLocker

1 Type gpedit.msc from the Windows search bar to locate the gpedit Control Panel. 

2 Click gpedit.msc. The Local Group Policy Editor window appears.
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Drive Encryption  
3 Navigate to Computer Configuration > Administrative Templates > Windows Components > 

BitLocker Drive Encryption. 

4 Double-click “Choose drive encryption method and cipher strength (Windows 10.....)”.
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Drive Encryption  E
5 Select Enabled and use the dropdown arrows to select the encryption method for the operating 

system drive, fixed data drive, and for the removable data drives.

NOTE The default is set to XTS-AES 128-bit. 

6 Select Apply. 

7 Select OK and close all windows. 

8 Restart the computer and proceed to Enabling BitLocker.
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Drive Encryption  
Enabling BitLocker

1 Type Manage BitLocker from the Windows search bar to locate the Manage BitLocker Control 

Panel.
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Drive Encryption  E
2 Double-click Manage BitLocker to open the BitLocker Drive Encryption window.

3 Select Turn on BitLocker from the Control Panel screen.
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Drive Encryption  
4 BitLocker verifies that your PC meets the requirements.

5 Select Print the recovery key to back up the recovery key. For instructions, refer to Backing Up 

Your Recovery Key.
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6 Select Next.

7 Select “Encrypt used disk space only (faster and best for new PCs and drives)”, then select Next. 
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Drive Encryption  
IMPORTANT The system check ensures that BitLocker can read the recovery and encryption keys correctly 

before encrypting the drive. This check might take some time, but it is recommended to ensure that your 

selected unlock method works without requiring the recovery key.

8 Select “Run BitLocker system check”, then select Start encrypting.

NOTE BitLocker restarts your computer before encrypting.

9 Select Restart now to start the BitLocker Encryption.

10 Enter your password in the Password screen.

NOTE After logging in you will see a Window that says Encrypting in Progress.
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11 Open the Manage BitLocker Control Panel from the Windows search bar. 

12 Under Operating System Drive, you will see the BitLocker is Encrypting the drive.
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13 Once the BitLocker has encrypted the drive, the BitLocker will be on.
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Backing Up Your Recovery Key

IMPORTANT The Back Up Your Recovery Key to your Microsoft Account is not supported at this time. 

IMPORTANT The Recovery Key can only be saved to a USB or external drive. You cannot save to a location 

on your PC.

1 Type Manage BitLocker from the Windows search bar to locate the Manage BitLocker Control 

Panel.
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2 Double-click Manage BitLocker to open the BitLocker Drive Encryption window. 

3 Select “Backup your recovery key”. The following window appears.
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IMPORTANT The Recovery Key can only be saved to a USB or external drive. You cannot save to a location 

on your PC.

4 Select a destination to save the Recovery Key. 

 • Save to a file: Select “Save to a file”. The following screen appears. 
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 • Print the recovery key: Select “Print the recovery key”. The following screen appears. 

1. Select “Microsoft Print to PDF”, and then select Print.

2. Select the location that you want the file saved. In the File name, type BitLocker Key and 
in the Save as type, ensure that it is listed as .pdf.

5 Select Save then select Finish.
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BitLocker Decryption

IMPORTANT Turning off the BitLocker feature decrypts all the data on the drive. Decrypting your operating 

system means that you have removed BitLocker from your system. The BitLocker key will change each 

time BitLocker is re-enabled. Only the latest BitLocker key will work. Previous BitLocker keys will be 

invalid and will not unlock the system. Please note this is a time-consuming process. However, you can 

also suspend BitLocker instead of decrypting the drive, see Suspending BitLocker Drive Encryption.

Turning off BitLocker

1 Type Manage BitLocker from the Windows search bar to locate the Manage BitLocker Control 

Panel.
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2 Double-click Manage BitLocker to open the BitLocker Drive Encryption. 

3 Select Turn off BitLocker. 
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The following message appears.

IMPORTANT Drive decryption might take a long time, but you can keep using your PC during the decryption 

process.

4 Select Turn Off BitLocker. The BitLocker Drive Decryption screen displays.
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After the decryption has completed, the following screen displays. 
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Suspending BitLocker Drive Encryption

IMPORTANT Suspending BitLocker Drive Encryption is a temporary method for removing BitLocker 

protection without decrypting the Windows drive. Use Suspend BitLocker only if you need to update the 

BIOS firmware or Windows boot loader/startup files that requires access to the drive in a pre-boot 

environment. This will help prevent BitLocker from locking the drive and can avoid a lengthy decryption 

process. 

Suspending BitLocker Protection

1 Type Manage BitLocker from the Windows search bar to locate the Manage BitLocker Control 

Panel.
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2 Double-click Manage BitLocker to open the BitLocker Drive Encryption window. 

3 Select Suspend Protection.
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A confirmation message “Do you want to suspend BitLocker protection?” displays. 

IMPORTANT If you choose to suspend BitLocker, your data will not be protected.

4 If you want to proceed, select Yes and the following popup information will display. 

If you do not want to proceed, select No. 

NOTE There are certain situations where you may want to suspend BitLocker such as updating your PC’s 

firmware, hardware, or operating system. If you forget to resume BitLocker after these updates are 

completed, BitLocker will automatically resume the next time you restart your PC. 
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Restarting BitLocker Protection 

1 Type Manage BitLocker from the Windows search bar to locate the Manage BitLocker Control 

Panel.

2 Double-click Manage BitLocker to open the BitLocker Drive Encryption window.
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3 Select Resume Protection.

Recovering Your BitLocker Key

There might be situations where the BitLocker Key is requested from your computer, such as:

 • Your drive is placed onto another computer

 • Computer requests your recovery key; it may be due to one of the following but is not limited to:

— Hardware changes

— Firmware changes

— Other Windows updates
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BitLocker Recovery

1 BitLocker Recovery window will be displayed upon powering on your system. 
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2 Enter your key from your saved text file or printed copy, then select Enter. 

3 Windows will reboot your computer. 

Protection from Malware Software

CAUTION

The instrument workstation will be vulnerable to malware, viruses, and 

unauthorized access if the instrument PC is connected directly to the laboratory 

network without installation of all approved OS and malware patches.

IMPORTANT Only the version of the Trellix® Application Control (Version 8.4.1) has been validated to work 

with the CytoFLEX instrument.

For more information on Configuration of Trellix Application Control, refer to Trellix Application 
Control Guide.
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Installing Trellix Application Control

IMPORTANT The Trellix Application Control Software (Version 8.4.1), which has been proved compatible 

with the software, should be purchased separately and downloaded from Trellix.

The following procedure can assist you to install the Trellix Application Control software. For more 
instructions, access the Trellix for help.

1 Unzip the Trellix Application Control file SOLIDCORxxx-xxx_WIN.zip

2 Right-click Setup-win-8-10-2012-amd64-xxx.exe, and select Run as administrator. The Trellix 

Installer opens.
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3 Select Next. The License Agreement displays.

Read the license agreement and select I accept the terms in the license agreement, then select 
Next. 
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4 Enter the username and the serial number. Select Next.

If you select Install without license key, follow the procedures below to add the license key after 
the installation. 

a. Right-click  on your desktop, and select Run as administrator. 
D17052AA    E-30



Cyber Security

Protection from Malware Software  E
The following window displays.

b. Enter cd C:\Program Files\McAfee\Solidcore.
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c. Enter the license key in the console. 

The license key is added.
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5 Select the destination folder and select Next.
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6 Select Install. The system starts to install Trellix Solidifier
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7 Wait for the Trellix Solidifier to finish installing. Select Finish.

Enabling Trellix Application Control

The enabled Trellix Application Control Software prevents your system from executing 
unauthorized applications on your instrument workstation. 
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IMPORTANT Ensure all the necessary applications have been installed prior to enabling the Trellix 

Application Control.

1 Right-click  on your desktop, and select Run as administrator. The following window 

displays. 

2 Enter cd C:\Program Files\McAfee\Solidcore.
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3 Enter sadmin so in the console to scan the system and create an allowlist. The solidification 

process takes about 30 minutes depending on your system size and CPU performance.
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4 Enter sadmin enable to enable the Trellix Application Control.

IMPORTANT Beckman Coulter recommends setting a password to manage the authority of 

enabling/disabling the Trellix Application Control.

5 Enter sadmin passwd to set a password to lock the Trellix Application Control authority.

6 Restart the system.
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Exporting the Certificate

Follow procedures below to export the certificate of CytExpert for Spectral software into your PC.

1 Right-click on the application CytExpert.exe, and select Properties. The following window 

displays.
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2 Select the Digital Signatures tab. Then select the signature and select Details to view the 

signature information.

The Digital Signature Details window displays.
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3 Select View Certificate.

4 Select the Details tab and then select Copy to File. 
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The Certificate Export Wizard window appears.
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5 Select Next to export the certificate.
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6 Select Base-64-encoded X.509 and then select Next.
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7 Select a destination to save the certificate and then select Save.
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8 Select Next.
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9 Select Finish when the success message displays.

Importing BEC Certificate

Follow the procedures below to add the certificate of CytExpert for Spectral software into the 
Trellix Certificate list. All the certified applications will be regarded as trusted and authorized by 
the Trellix Application Control.

IMPORTANT Trellix Application Control recognize only X.509 certificates.

1 Copy the certificate BEC.cer from the CytExpert for Spectral software disk into your instrument 

PC. 
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2 Right-click  on your desktop, and select Run as administrator. The following window 

displays. 

3 Enter sadmin cert add C:\BEC.cer to add the certificate.

Switching Trellix Application Control to Update Mode

The update mode allows the Trellix Application Control to scan the instrument workstation and add 
the newly-installed application into the allowlist automatically. Switch the Trellix Application 
Control to the update mode when you execute scheduled or emergency changes on your 
instrument workstation.
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1 Right-click  on your desktop, and select Run as administrator. The following window 

displays. 

2 Enter sadmin bu to switch the Trellix Application Control to Update Mode.

3 Execute scheduled or emergency changes, patch installations, or software updates for your 

instrument workstation.
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4 Enter sadmin eu to exit the Update Mode.

Disabling Trellix Application Control

IMPORTANT Disabling Trellix Application Control is a temporary method in exceptional cases, for example, 

Windows or firmware changes. This will help stop Trellix Application Control from blocking unauthorized 

applications. Beckman Coulter recommends enabling the Trellix Application Control in most cases.

All the applications installed in this mode will not be included in the Trellix allowlist.

1 Right-click  on your desktop, and select Run as administrator. The following window 

displays. 
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2 Enter sadmin disable in the console.

3 Select Enter.

4 Restart the System.

5 Enter sadmin status to view the status of Trellix Application Control.
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Security Updates

WARNING

Risk of software incompatibility. Only security updates posted to the Beckman 

Coulter website should be installed on the instrument controller PC. Do not install 

patches from any other source.

Install the update on one instrument and verify functionality before installing on 

other instruments.

IMPORTANT For information on the currently supported Windows build and security updates, consult the 

Release Notes of the latest validated update posted to the website. Refer to Downloading Security 

Updates.

IMPORTANT Before installing the security updates, ensure you have a recent backup of the instrument 

database and experiment files (see CHAPTER 10, Backup and Restore) and the current BitLocker key (see 

Backing Up Your Recovery Key). Ensure the backups are saved to an encrypted external media or 

secured network drive.

Enabling System Protection

1 In the Start Menu, type Restore to locate the Create a Restore Point.
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2 Double-click Create a Restore Point to open the System Properties window.
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3 Select Configure.

The following window appears.
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4 Select Turn on system protection, then select Apply.

5 Close the System Properties window by selecting OK.

Creating a Restore Point

A restore point is used to remove all software and update installations that occurred after it was 
created. If installing an update on your PC causes any loss of functionality, the restore point can be 
used to place the system back into the operable state present before the update installation. In all 
cases, a system restore with any restore point would not cause loss of any data (i.e., LMD files) on 
the system. 

CAUTION

Risk of unexpected software modification. To ensure a system recovery point is 

available that is indicative of the most recent software configuration, the user 

should create a system restore point immediately prior to running the security 

update installer. Otherwise, a user would need to utilize the most recent 

automatically created restore point which might be up to 72 hours old and not 

include all recent software modifications.

1 In the Start Menu, type Restore to locate the Create a Restore Point.
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2 Double-click Create a Restore Point to open the System Properties window.

3 Select Create.
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4 Type a name for the restore point and select Create.

5 Wait for the restore point creation to complete and then select Close.

6 Close the System Properties window by selecting OK.

Downloading Security Updates

In order to download and install security updates, you will need to access the Beckman Coulter 
website at www.beckmancoulter.com.

IMPORTANT Account registration is required for new users.

1 Go to www.beckmancoulter.com.

2 Using the menu bar in the in the upper right hand corner of the screen, hover over Login, then scroll 

down to select Software Downloads.

3 To search by product:

a. Select Research & Discovery from the Market Segment dropdown menu. 

b. Select Flow Cytometry from the Product Line. dropdown menu.

c. Select Instruments from the Product Series dropdown menu.

d. Select CytoFLEX mosaic from the Product dropdown menu.

4 Select Search.

IMPORTANT Print out the Release Notes for each update as they will not be available when the next update 

is released. The Component Name section of the release notes identifies the Microsoft updates that are 

included in the download. This information may be requested by your IT team and will be needed to 

recover from a failed update.

5 Each security update is cumulative and only the most recent validated set of updates will be 

available for download. Select the first file in the results to view the release notes and then 

select .   

If more than one update is listed in the search results, select , and repeat this step for 

each update. 
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If the security updates cannot be not downloaded directly to the instrument controller system, 
transfer the downloaded files via an encrypted external media or secured network drive to the 
instrument controller PC.

Notification Options

To receive notification when a new security update is validated and available for download, you 
must sign up for an account on www.beckmancoulter.com and follow the procedure for setting up 
subscriptions. 

Sign up for subscriptions as outlined below:

 • Select the Document Language consistent with your IFU language. 

 • Select Research & Discovery from Market Segment. 

 • Select Flow Cytometry from Product Line. 

 • Select Instruments from Product Series. 

 • Select CytoFLEX mosaic from Product.

If you do not sign up for product notifications, you will have to check periodically for newly released 
security updates, see Downloading Security Updates.

NOTE Beckman Coulter will only validate and post updates for Windows 10 LTSC 2019.

Installing the Security Updates

CAUTION

Risk of software incompatibility. Beckman Coulter can only support security 

updates on unmodified systems. Application of domain policies or other 

configuration changes may impact compatibility.

IMPORTANT If more than one update is available for your product, install the updates in the order indicated 

by the sequence number as outlined in the file naming convention below.

RSU-<Operating System> <Product Name>-<Year><Month>_<Sequence #>_<Sequence Revision#>

Example: RSU-W10LTSC-CytoFLEX for Spectral-2025Feb_1_0

1 Ensure you have a recent copy of your BitLocker key, refer to Backing Up Your Recovery Key. 

2 Login to Windows as a user with Administrator access.

3 Close all program and save open files.
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4 Power down the instrument. 

5 Open the first security update file (For example: RSU-W10LTSC-CytoFLEX for Spectral-

2025Feb_1_0) on the Instrument Controller PC by double-clicking on the file. The BOSS SUPP 
Package Setup window appears. 

If the Microsoft Windows Defender Smart Screen prompt appears, select More Info and Run 

Anyway to launch the installer.

A User Account Control message may display the message Do you want to allow this app to make 
changes to your device? Select Yes to continue.

NOTE The security update installer will automatically detect and install only the necessary updates.
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6 Select Next. The Begin installation of BOSS SUPP Package window appears.

7 Select Install to begin installing the security updates. The Installing Progress window appears. 

This process may take several minutes.
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8 Wait for the security updates to finish installing. The install complete window appears.

9 Select Finish. When prompted to restart the system, select Yes.
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10 Wait while the system completes the installation of the security updates. This process may take 

several minutes and will return you to the Windows login screen.

11 Install any additional downloaded security updates (sequence numbers above 1) by repeating 

Steps 5 to 9.

12 Verify functionality of instrument software before installing security updates on any other 

system. If functionality is impaired, see Recovering from Failed Security Updates.

Recovering from Failed Security Updates

These steps below should only be followed if the instrument software or operating system 
functionality is impaired after a security update was applied.

1 Power down the instrument and close all programs. Do not turn your workstation off.

2 In the start menu, type view update and select View your Update History.

3 Select Uninstall Updates.

4 Highlight the update listed under Microsoft Windows that matches the cumulative security 

update KB number in the release notes. Refer to Component Name section of the Release Notes, 
see Step 5, Downloading Security Updates.

5 Select Uninstall and select Yes when prompted to verify the uninstall. This process may take 

several minutes to complete.

6 When prompted to restart, select Restart Now.
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7 Once the PC has been rebooted, login and verify Microsoft update has been removed by 

repeating Steps 2 and 3. Verify the KB selected in Step 4 is no longer listed. 

8 Power on the instrument and verify restored software functionality.

 • If software functionality has been restored, continue using your instrument without the 
update installed. Contact us for troubleshooting the update incompatibility.

 • If software functionality has not been restored and the PC was not provided by Beckman 
Coulter, contact laboratory IT for system restore options.

 • If software functionality has not been restored and the PC was provided by Beckman 
Coulter, contact us for system restore.

User Management

CAUTION

Risk of unauthorized access and modification. CytoFLEX workstation transmits 

unencrypted data to any network printer. To avoid unauthorized access to 

transmitted data, ensure adequate network protection mechanism are in place.

CAUTION

Risk of unauthorized access and modification. To protect your workstation from 

unauthorized access and modification, please refer to the following 

recommendations.

Beckman Coulter recommends that you use role-based access control policies to manage user 
accounts on workstations. Assigning appropriate roles to users accessing workstations is the 
responsibility and obligation of workstation administrators. Table E.1 is a good practice 
recommended by Beckman Coulter to manage user accounts according to the use requirements of 
the workstation and combined with Windows built-in user groups.
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System Hardening

Enabling Automatic Log-Off

IMPORTANT Automatic log-off can protect your instrument PC from unauthorized operation when you leave 

the PC temporarily. Follow the steps below to enable the Screen Saver protection. 

Enabling Screen Saver Protection

1 Type Edit group policy from the Windows search bar to locate the Edit group policy editor.

Table E.1  Role-based Access Control Policies

Requirements for Using a 

Workstation

Windows Built-in User Groups Role Example

Responsible for the daily maintenance 

of the workstation and have full control 

authority over the workstation. Can 

install, uninstall software, install 

security updates, restore the system, 

and manage user accounts on 

workstation.

Administrators 1. IT Administrator

2. Device Administrator

The workstation is used daily to control 

the cytometer to complete collection, 

QC, analysis and other work. 

User 1. Operator

2. Experimenter
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2 Select Edit group policy. The Local Group Policy Editor window displays.
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3 Navigate to User Configuration > Administrative Templates > Control Panel > Personalization.
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4 Select Enable screen saver. The following window appears.

5 Select Enabled and Apply.

6 Select OK to close the Enable screen saver window.
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7 Select Password protect the screen saver from the Local Group Policy Editor window.
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8 Select Enabled and Apply.

9 Select OK to close the window.
D17052AA    E-69



Cyber Security

System Hardening  
10 Select Screen saver timeout from the Local Group Policy Editor window.
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The Screen saver timeout window appears.
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11 Select Enabled and Apply.

12 Select OK to close the window.

Setting Lock Screen 

1 Type Lock screen settings from the Windows search bar to locate Screen saver settings.
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The Settings window appears.
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2 Scroll down to the bottom and select Screen saver settings. The Screen Saver Settings window 

appears.

3 Select Apply.

4 Select OK to close the window.

Setting Account Lockout Policy

1 Type Local Security Policy from the Windows search bar to locate the Local Security Policy.
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2 Double-click Local Security Policy to open the Local Security Policy window.
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3 Navigate to Security Setting > Account Policies > Account Lockout Policy. Configure the Security 

Settings as below.

NOTE You must configure the Account lockout threshold first.

Setting Password Policy

1 Type Local Security Policy from the Windows search bar to locate the Local Security Policy.
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2 Double-click Local Security Policy to open the Local Security Policy window.
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3 Navigate to Security Setting > Account Policies > Password Policy.

4 Customize the password policy according to the following. 

 • Enforce password history: 10 passwords remembered

 • Maximum password age: 90 days

 • Minimum password age: optional

 • Minimum password length: 10 characters

 • Password must meet complexity requirements: enabled

The password must contain all four of the following character types:

— letter in upper case (A -Z)

— letter in lower case (a -z)

— numbers (0-9)

— distinctive character (i.e.,,!, @, #, $,%, ^, &).

 • Store passwords using reversible encryption: optional
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Disabling Remote Access

1 Type Control Panel from the Windows search bar to locate the Control Panel app.

2 Select Control Panel to open the Control Panel window.
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3 Type System from the search bar to locate Allow remote access to your computer.

4 Select Allow remote access to your computer. The System Properties window appears.
D17052AA    E-80



Cyber Security

System Hardening  E
5 Select Don’t allow remote connections to this computer from the Remote tab.

6 Select OK to close the window.

Disabling Auto Play

1 Type Auto Play settings from the Windows search bar to locate the Auto Play settings.
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2 Select Auto Play settings. The Settings window appears.
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3 Select Off to turn off Auto Play.

4 Close the window.

Disabling Unnecessary Services

It is recommended to disable all the unnecessary services while operating the CytExpert for 
Spectral software. 

Table E.2  List of Unnecessary Services

Bluetooth Support Service Microsoft FTP Service (If 

available)

Windows Media Player Network 

Sharing Service

Geo-location Service Microsoft iSCSI Initiator Service Windows Mobile Hotspot Service

Infrared Monitor Service Remote Procedure Call (RPC) 

Locator

WinHTTP Web Proxy 

Auto-Discovery Service

Internet Connection Sharing Routing and Remote Access Xbox Live Game Save

Link-Layer Topology Discovery 

Mapper

SSDP Discovery Xbox Live Networking Service

LxssManager (If available) UPnP Device Host
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1 Type Computer Management from the Windows search bar to locate the Computer Management 

App. 

2 Select Computer Management. 
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3 Navigate to Services and Applications > Services.

4 Double-click the service you want to disable.
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The following window appears.
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5 Select Disabled from the Startup type dropdown.

6 Select Apply.

7 Select OK to close the window.
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Disabling Unauthorized Applications

1 Type Edit group policy from the Windows search bar to locate the Local group policy editor 

control panel.

The Local Group Policy Editor window displays.
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2 Navigate to Computer Configuration > Administrative Templates > Windows Components > 

Store.

3 Select Disable all apps from Windows Store. 
D17052AA    E-89
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The following window appears.

4 Select Enabled and Apply.

5 Select OK to close the window.

6 Disable the following applications. Refer to Steps 3-5.

 • Turn off Automatic Download and Install of updates.

 • Turn off the offer to update to the latest version of Windows.

 • Turn off the Store application.
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Enabling SMB Digitally Sign Communications

The Server Message Block (SMB) protocol provides the basis for file and print sharing and many 
other networking operations, such as remote Windows administration. To prevent man-in-the-
middle attacks that modify SMB packets in transit, follow the instructions below to enable the SMB 
Digitally Sign Communications.

1 Type Edit group policy from the Windows search bar to locate the Local group policy editor 

control panel.

The Local Group Policy Editor window displays.
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2 Navigate to Computer Configuration > Windows Settings > Security Settings > Local Policies > 

Security Options.

3 Select Microsoft network server: Digitally sign communications (always). 
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The following window appears.

4 Select Enabled and Apply. The Confirm window appears.

5 Select Yes. Then select OK to close the window.
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Enabling Audit Object Access

This audit object access policy allows the Windows system to record an event for the CytoFLEX 
mosaic database if the security auditing setting for both the CytExpert for Spectral database and 
CytExpert for Spectral service database are enabled. When the CytExpert for Spectral database files 
and/or the CytExpert for Spectral service database are deleted, an event will be automatically 
created in the Windows security logs.

1 Type Local Security Policy from the Windows search bar to locate the Local Security Policy 

control panel.

2 Double-click Local Security Policy to open the Local Security Policy window.
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3 Navigate to Security Settings > Local Policies > Audit Policy.

4 Double-click Audit object access to open the Audit object access Properties window.
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System Hardening  
5 Select Success and Failure, and select OK to confirm.

The security setting for audit object access is enabled.

6 Close the Local Security Policy window.
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7 Navigate to Windows (C:) > ProgramData > Beckman Coulter > CytExpert for Spectral > 

Database.
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8 Right-click the CytExpert.db database file, and select Properties from the drop-down menu to 

open the CytExpert.db Properties window.
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9 Select the Security tab, and select Advanced.

The following window appears.
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10 Select the Auditing tab and select Add.

NOTE You must be an administrator or have been given the appropriate privileges to view the auditing 

properties of this object.

The following window appears.
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11 Configure the security settings as below. 

a. Click Select a principal. The Select User or Group window appears.

b.  Enter Everyone in the object name field and select OK.
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c.  Select the Type All.

d.  Select Show advanced permissions. The following window appears.
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e.  Set the advanced permissions and Select OK.

The security settings for CytoFLEX for Spectral database is enabled.

12 Select OK. 
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Viewing Windows Security Logs

1 Type Event Viewer from the Windows search bar to open the Event Viewer window.

2 Navigate to Windows Logs > Security.
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3 Select Find from the right Actions area and type CytExpert.db to quickly find the security logs 

for CytExpert for Spectral database.

Type CytoCtrlService.db and select Find Next to quickly find the security logs for the 
CytoCtrlService database.

Enabling Installation Restriction

1 Type Edit group policy from the Windows search bar to locate the Edit group policy editor control 

panel.
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2 Select Edit group policy editor. The Local Group Policy Editor window displays.

3 Navigate to Computer Configuration > Administrative Templates > Windows Components > 

Windows Installer.
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4 Select Allow user control over installs. 

The following window appears.

5 Select Disabled and Apply.

6 Select OK to close the window.
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7 Disable Always install with elevated privileges. Refer to Steps 3-5.

Enabling Microsoft Defender Firewall

IMPORTANT The Instrument cannot work properly if the necessary network ports are disabled. The 

communication between the CytExpert for Spectral software and the Instrument requires the following 

network ports to be enabled.

Outbound:

 • TCP/192.168.76.18:1521

 • TCP/192.168.76.18:1522

 • TCP/192.168.76.18:1523

 • TCP/192.168.76.18:1524

 • TCP/192.168.76.18:1525

 • TCP/192.168.76.18:60298

1 Type Windows Defender Firewall from the Windows search bar to locate the Windows Defender 

Firewall app. 
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2 Select Turn Windows Defender Firewall on or off.

3 Select Turn on Windows Defender Firewall for both Private network and Public network settings.

4 Select OK.
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Enabling Microsoft Defender

1 Type Windows Defender settings from the Windows search bar.

2 Double-click Windows Defender settings to open the Windows Security window.

3 Select Virus & threat protection, and select Manage settings. The Virus & threat protection 

settings window appears.
D17052AA    E-110



Cyber Security

System Hardening  E
4 Ensure the Real-tine protection is on.

Enabling Network Time Protocol

To ensure the accuracy of date and time information included in logs, follow the instructions below 
to enable the Network Time Protocol.
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1 Type Change the date and time from the Windows search bar.

2 Double-click Change the date and time.
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The Date and Time Settings window appears.

NOTE Ensure that the Set time zone automatically and Set time zone automatically are on.
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3 Select Add clocks for different time zones to access the Date and Time window.

The Date and Time window displays.
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4 Select the Internet Time tab from the Date and Time window, and then select Change settings 

from the Internet Time tab.

The Internet Time Settings window displays.
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5 Select Synchronize with an internet time server, and select OK. The PC is set to automatically 

synchronize with the internet time server.

Remote Access

IMPORTANT Use BeckmanConnect for remote control over the CytoFLEX instrument. For instructions on 

using BeckmanConnect, refer to the BeckmanConnect website.
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APPENDIX F

Table of Hazardous Substances

Table of Hazardous Substances

The Hazardous Substances Names and Concentration is shown in Table F.1 and Table F.2.

NOTE Refer to the CytoFLEX Platform Instructions for Use manual, APPENDIX H, Table of Hazardous 

Substances for the tables of hazardous substances of the CytoFLEX S and CytoFLEX LX.
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ble F.1  Table of Hazardous Substances Name and Concentration [CytoFLEX mosaic 63]

子电气产品号码 
EP Part Number: D10641                        

产品名称 Product Name: CytoFLEX mosaic Spectral Detection Module 63
产品型号 Product Model Number: CytoFLEX mosaic

部件名称

Component Name

有毒有害物质或元素 Hazardous Substances Nam

铅 

(Pb)

汞 

(Hg)

镉 

(Cd)

六价铬 

(Cr6+)

多溴联苯 

(PBB)

多溴二苯醚

(PBDE)

邻苯二甲 
二乙酯

(DEHP)

属件 Metal Part O O O O O O O

料件 Plastic Part O O O O O O O

璃制品 Glass Part O O O O O O O

胶制品 Rubber Part O O O O O O O

刷电路板 Printed Circuit 
ssembly

O O O O O O O

属（底盘/螺钉/组件/护罩）
etal (Chassis/Screw/
ubassemblies/Shields)

O O O O O O O

缆及连接器 Wire/Cable/
onnectors

O O O O O O O

他电子件 Other Electrical O O O O O O O

签 Labeling O O O O O O O

装材料 Package O O O O O O O

his table is prepared in accordance with the provisions of SJ/T 11364

：表示该有毒有害物质在该部件所有均质材料中的含量均在GB/T 26572标准规定的限量要求以下

: 表示该有毒有害物质至少在该部件的某一均质材料中的含量超出GB/T 26572标准规定的限量要求

企业可在此处，根据实际情况对上表中打“×”的技术原因进行进一步说明)

: Indicates that the toxic or hazardous substances contained in all of the homogenous materials for this part is below the limit r

: Indicates that the toxic or hazardous substance contained in at least one of the homogenous materials used for this part in ab

Enterprise may further provide in this box technical explanation for marking “X” based on their actual conditions)
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ble F.2  Table of Hazardous Substances Name and Concentration [CytoFLEX mosaic 88]

子电气产品号码 
EP Part Number: D10638                        

产品名称 Product Name: CytoFLEX mosaic Spectral Detection Module 88
产品型号 Product Model Number: CytoFLEX mosaic

部件名称

Component Name

有毒有害物质或元素 Hazardous Substances Nam

铅 

(Pb)

汞 

(Hg)

镉 

(Cd)

六价铬 

(Cr6+)

多溴联苯 

(PBB)

多溴二苯醚

(PBDE)

邻苯二甲 
二乙酯

(DEHP)

属件 Metal Part O O O O O O O

料件 Plastic Part O O O O O O O

璃制品 Glass Part O O O O O O O

胶制品 Rubber Part O O O O O O O

刷电路板 Printed Circuit 
ssembly

O O O O O O O

属（底盘/螺钉/组件/护罩）
etal (Chassis/Screw/
ubassemblies/Shields)

O O O O O O O

缆及连接器 Wire/Cable/
onnectors

O O O O O O O

他电子件 Other Electrical O O O O O O O

签 Labeling O O O O O O O

装材料 Package O O O O O O O

his table is prepared in accordance with the provisions of SJ/T 11364

：表示该有毒有害物质在该部件所有均质材料中的含量均在GB/T 26572标准规定的限量要求以下

: 表示该有毒有害物质至少在该部件的某一均质材料中的含量超出GB/T 26572标准规定的限量要求

企业可在此处，根据实际情况对上表中打“×”的技术原因进行进一步说明)

: Indicates that the toxic or hazardous substances contained in all of the homogenous materials for this part is below the limit r

: Indicates that the toxic or hazardous substance contained in at least one of the homogenous materials used for this part in ab

Enterprise may further provide in this box technical explanation for marking “X” based on their actual conditions)
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Abbreviations

The following list is a composite of the symbols, abbreviations, acronyms, and reference 
designators either used in this manual or related to the information in it. When the same 
abbreviation (or reference designator) is used for more than one word (or type of component), all 
meanings relevant to this manual are included, separated by semicolons.

' — foot

“ — inch

% — percent

°C — degrees Celsius

°F — degrees Fahrenheit

± — plus or minus

< — less than

> — greater than

≤ — less than or equal to

μ — micron

μL — microliters

μm — micrometer

A — ampere

AC — alternating current

APC — Allophycocyanin

APC-A700 — Allophycocyanin-Alexa 
Fluor 700 tandem dye

APC-A750 — Allophycocyanin-Alexa 
Fluor 750

APC-Cy7 — Allophycocyanin-Cyanin 7

API — Application Programming Interface

Acq. — Acquisition

BCI — Beckman Coulter Incorporated

BMP — bitmap

BP — band-pass filter

CDRH — Center for Devices and Radiological 
Health

CFSE — carboxyfluorescein succinmidyl ester

cm — centimeters

CSV — comma separated value

CV — coefficient of variation

DNA — deoxyribonucleic acid

DW — deep well

ECD — Energy Coupled Dye

EFUP — Environmentally friendly Use Period

EMC — Electromagnetic Compatibility

EMF — enhanced metafile format

EMR — electromagnetic radiation

FAPD — Fiber Array Photo Detector

FCS — flow cytometry standard

FITC — Fluorescein isothiocyanate

FLn — Fluorescence Number

FSC — forward scatter

GB — gigabyte

GHz — gigahertz

Gr Wt — gross weight

H — humidity

Hz — hertz
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Abbreviations

  
IEC — International Electrotechnical 
Commission

IR — infrared

kg — kilograms

KO — Krome Orange

LED — light emitting diode

L — liter

LJ — Levey-Jennings

LWH — length, width, height

m — meter

MB — megabyte

MFI — median fluorescence intensity

MHz — megahertz

min — minute

mL — milliliter

mm — millimeter

mW — milliwatt

NA — numerical aperture

NaClO — sodium hypochlorite solution

NaN3 — sodium azide

nm — nanometer

Nt Wt — net weight

PB — Pacific Blue dye

PC5 — Phycoerythrin-Cy5 tandem dye

PC5.5 — Phycoerythrin-Cy5.5 tandem dye

PC7 — Phycoerythrin-Cy7 tandem dye

PE — Phycoerythrin

PEEK — polyether ether ketone

PerCP — Peridinin-Chlorophyll

PI — Propidium Iodide

PN — part number

QC — quality control

RAM — random access memory

rCV — robust coefficient of variation

RH — relative humidity

RoHS — Restriction of Hazardous Substances 
Directive

RPTM — real-time messaging protocol

S/N — serial number

SNR — signal to noise ratio

SSC — side scatter

USB — universal serial bus

UV — ultraviolet

V — volts

VA — volt-ampere

VAC — voltage alternating current

VSSC — violet side scatter

WDM — wavelength division multiplexer

W — watts
D17052AA   Abbreviations-2



Index

create, 7-2, 7-5
data, 6-33
routine maintenance, 12-1

Symbols
’

define, Abbreviations-1
"

define, Abbreviations-1
°C

define, Abbreviations-1
°F

define, Abbreviations-1
μ

define, Abbreviations-1
μL

define, Abbreviations-1
μm

define, Abbreviations-1
±

define, Abbreviations-1
<

define, Abbreviations-1
>

define, Abbreviations-1
≤

define, Abbreviations-1

Numerics
10 L sheath fluid cubitainer

replacing, 12-1
10 L waste cubitainer (CytoFLEX LX)

emptying, 12-1
4 L sheath fluid container

to clean, 11-1
4 L sheath fluid container (cleaning)

routine maintenance, 11-1
4 L waste container

to clean, 11-1
4 L waste container (cleaning)

routine maintenance, 11-1
4 L waste container (CytoFLEX)

emptying, 12-1

A
A

define, Abbreviations-1
about this manual, xxvii
AC

define, Abbreviations-1
account

locking, 4-6
unlock, 2-30

account menu, 2-25
account policies, 2-36
acoustic noise level, 1-13
Acq.

define, Abbreviations-1
acquisition screen, 2-4

collection, 2-6
navigation, 2-5
plot area, 2-10
status bar, 2-12
test tubes, 2-8

acquisition settings
to configure, 6-19

add
plate type

plate type

add, 2-40
add a plate type, 2-40
adding

Deep Clean solution, 12-1
standardization item, 5-23

adjust
spectral unmixing, 7-15

adjust compensation
manually, 7-27

adjust spectral unmixing, 7-15
adjusting

autogate movement, 6-17
gain, 6-19
    Index-1



Index

  
spectral unmixing, 7-15, 7-27
threshold, 6-23
unmixing settings, 8-2

adjusting auto gates, 6-17
adjustment

nonscheduled, 12-2
routine, 12-1

advanced menu, 2-25
alerts

caution define, v
important define, v
note define, v
warning define, v

analysis
screen, 8-1

analysis screen, 2-13
to open, 8-2

analyzing
data, 6-33

APC
define, Abbreviations-1

APC-A750
define, Abbreviations-1

APC-Cy7
define, Abbreviations-1

API
define, Abbreviations-1

applying
standardization in QC, 5-32, 5-35

auto fine adjustment, 7-27
auto gates

adjusting, 6-17
creating, 6-17

auto recalculate
turn off, 6-17
turn on, 6-17

auto shutdown, 9-2
auto startup, 9-2
autogate

adjusting movement, 6-17
automated software feature, 3-4

B
backflush settings

to change, 12-2
backup, 10-8
band-pass filter, Abbreviations-1
BCI

define, Abbreviations-1

beam shaping
laser, 3-2

Beckman Coulter Customer Support Center, 
contacting, ii

BMP
define, Abbreviations-1

bold face font
conventions, xxix

BP
define, Abbreviations-1

C
calculate

unmixing values, 7-10
calculate unmixing values, 7-10
calculating

concentration, 8-2
sample volume, 8-2
unmixing values, 7-10

calibrating
plate position [with plate loader], 12-2
sample flow rate, 12-2
sample flow rate with plate loader, 12-2

call center, contact information, ii
caution

define, v
CDRH

define, Abbreviations-1
CFSE

define, Abbreviations-1
change

event rate setting, 12-2
password, 2-32

change the event rate setting, 12-2
changing

mixer and backflush settings, 12-2
tube name, 6-19

changing sample probe
from plate loader to single tube sample 

station, 12-2
from single tube sample station to plate 

loader, 12-1
channel

to set, 6-7
characteristics

performance, 1-16
check

waste and reagent levels (10 L fluid 
cubitainers), 4-1
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Index

  
waste and reagent levels (4 L fluid 
containers), 4-1

cleaning
4 L sheath fluid container, 11-1
4 L waste container, 11-1
nonscheduled, 11-1
routine, 11-1
sample station, 11-1
surfaces, 11-1

cleaning solution
to prepare, 9-1

cleaning the 4 L sheath fluid container
routine maintenance, 11-1

cleaning the 4 L waste container
routine maintenance, 11-1

cleaning the sample station
routine maintenance, 11-1

closed file system
electronic record management, B-2

cm
define, Abbreviations-1

collecting
data, 6-33
QC data, 5-7
QC data with plate loader, 5-11

collection
acquisition screen, 2-6

collection conditions
to set, 6-24

compensation
to manually adjust, 7-27

components
Cytometer, 1-2
Fluid Containers/Cubitainers, 1-2
fluidics system, 1-6
instrument, 1-1
main, 1-2
optical, 1-4
plate holder, 1-6
plate loader, 1-6
sample injection mode control kit, C-1
Workstation, 1-2

concentration
calculation, 8-2
sample volume, 8-2

concluding
experiment, 6-46, 7-14

configuration
system, 1-7

configuring

acquisition settings, 6-19
confirm

unmixing results, 7-12
confirm unmixing results, 7-12
confirming results, 5-15
connecting the instrument, A-6
contact information, Beckman Coulter 

Customer Support Center, ii
Conventional Mode, 12-2
conventions

bold face font, xxix
the term press, xxix
the term select, xxix

conventions used, 1-xxix
copying

experiments, 8-1
previously acquired experiment, 8-1

create
spectral unmixing experiment, 7-2

create a new experiment from a template
start page operations, 2-3

create a new screen
start page operations, 2-3

create a spectral unmixing experiment
start page operations, 2-3

create spectral unmixing experiment, 7-2
creating

dot plot overlays, 8-2
heat map (plate loader), 6-33
histogram overlays, 8-2
Levey-Jennings charts, 5-18
new experiment, 6-1
new experiment with plate loader, 6-1, 6-2
plots and gates, 6-8
spectral unmixing experiment, 7-2
spectral unmixing experiment with plate 

loader, 7-5
users, 2-28

creating auto gates, 6-17
credential file

export, 2-35
CSV

define, Abbreviations-1
custom statistics

setting, 6-19
customer-replaceable parts

ordering, F-1
customized parameters

setting, 6-17
CV
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define, Abbreviations-1
cyber security, E-52

backing up your recovery key, E-13
BitLocker decryption, E-17
BitLocker encryption, E-6
BitLocker keys, E-2
changing encryption strength, E-2
disabling Trellix application control, E-50
drive encryption, E-2
enabling Trellix application control, E-35
exporting certificate, E-39
good practices in cyber security, E-1
Importing certificate, E-47
installing Trellix Application Control, E-28
malware detection software, E-27
operating system patching, E-57, E-62
recovering your BitLocker key, E-25
remote access, E-116
suspending BitLocker drive encryption, E-21
switching Trellix Application control to 

update mode, E-48
user management, E-63

CytExpert
installation options, A-7

CytExpert for Spectral software
reinstall, A-8

CytExpert nano certificate, E-39
Cytobank, 2-18, 2-19
Dimensions, 1-13
instrument specifications

dimensions, 1-13
CytoFLEX mosaic 63, 1-2, 1-3
CytoFLEX mosaic 88, 1-3
Dimensions, 1-13
instrument specifications

dimensions, 1-13
Dimensions, 1-13
instrument specifications

dimensions, 1-13
Cytometer, 1-2, 1-3
Cytometer cannot be turned on, 10-7
cytometer menu, 2-21

D
daily shutdown

routine maintenance, 11-1
daily shutdown with plate loader

routine maintenance, 11-1
daily start up

routine maintenance, 11-1
daily start up with plate loader

routine maintenance, 11-1
data

analyzing, 6-33
collecting, 6-33
exporting, 6-33
sampling, 6-33
to import, 8-1

data sheets, material safety
how to order, 1-18

data storage
description, 3-4

Deep Clean
procedure, 11-1
routine maintenance, 11-1

Deep Clean solution
to add, 12-1
to prepare, 12-1

default password, 2-28
define

%, Abbreviations-1
caution, v
important, v
note, v
quality control (QC), 5-1
symbols, -vii
warning, v

delete
plate type

plate type

delete, 2-41
spectral library files, 7-26

delete a plate type, 2-41
delete spectral library files, 7-26
deleting

heat map (plate loader), 6-33
standardization items, 5-37
users, 2-29

detector (WDM)
optical components, 1-4

detector unit
wavelength division multiplexor (WDM), 1-4

disinfection
surfaces, 11-1

disposal
precaution, 10-6
waste, A-4

DNA
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define, Abbreviations-1
document overview, xxvii
dot plot overlays

to create, 8-2
downloading security updates, E-57
drive decryption

enabling BitLocker, E-17
drive encryption, E-2

BitLocker keys, E-2
BitLocker recovery, E-25
changing encryption strength level for 

BitLocker, E-2
enabling BitLocker, E-6

dual-parameter plots, 2-39
duplicate

plate type
plate type

duplicate, 2-40
duplicate a plate type, 2-40
duplicating

standardization item parameters, 5-37
DW

define, Abbreviations-1

E
ECD

define, Abbreviations-1
edit

plate type
plate type

edit, 2-40
edit a plate type, 2-40
editing

standardization item parameters, 5-37
EFUP

define, Abbreviations-1
electronic devices

fuse, 1-8, 1-10
load button, 1-8, 1-10
power switch, 1-8, 1-10

electronic record management
closed file system, B-2
electronic signature, B-4
experiment directory management, B-2
experiment management, B-2
experiment operation log, B-3
experiment related operations, B-3
exporting an experiment/template, B-3
folder hierarchy management, B-2

importing an experiment/template, B-3
log, B-3
software menu, B-1
system operation log, B-3
user management, B-4
user management operation log, B-3

electronic signature
electronic record management, B-4
retract, B-4

EMC
define, Abbreviations-1

EMF
define, Abbreviations-1

emptying
10 L waste cubitainer (CytoFLEX LX), 12-1
4 L waste container (CytoFLEX), 12-1

EMR
define, Abbreviations-1

environment validation
installation, A-2

environment validation (installation)
power source, A-3
temperature and humidity, A-4
worktable, A-2

event rate setting
change, 12-2

exit the software
start page operations, 2-3

experiment
concluding, 6-46, 7-14
sign, B-4

experiment (new)
creating, 6-1

experiment directory management
electronic record management, B-2

experiment management
electronic record management, B-2

experiment operation log
electronic record management, B-3

experiment related operations
electronic record management, B-3

experiment saving, 6-46
experiment selection

start page, 4-7
experiment settings, 2-45
experiment signature

print, B-4
experiments

to copy, 8-1
export
    Index-5
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credential file, 2-35
spectral library files, 7-25
unmixing settings to unmixing matrix 

files, 7-20
unmixing settings to unmixing matrix files 

from the spectral library, 7-22
export spectral library files, 7-25
exporting

data, 6-33
FCS files, 6-39
heat map (plate loader), 6-33
instrument settings, 6-44, 6-45
plots of multiple tubes as picture files, 6-43
results, 8-3
standardization item, 5-37
statistics table of multiple tubes as a picture 

file, 6-43
unmixing settings, 7-20

exporting and experiment/template
electronic record management, B-3

exporting unmixing settings to unmixing 
matrix files, 7-20

exporting unmixing settings to unmixing 
matrix files from the spectral 
library, 7-22

F
FAPD

define, Abbreviations-1
FCS

define, Abbreviations-1
FCS files

exporting, 6-39
files menu, 2-20
fine adjustment, 7-27

auto fine adjustment, 7-27
fine adjustment matrix, 7-28
manual fine adjustment, 7-27

fine adjustment matrix, 7-28
FITC

define, Abbreviations-1
FLn

define, Abbreviations-1
flow cell

to prime, 12-2
Fluid Containers, 1-2, 1-3
Fluid Containers/Cubitainers

component, 1-2
fluidics system, 1-6

fluidics module
fluidics system, 1-6

fluidics system
components, 1-6
Fluid Containers/Cubitainers, 1-6
fluidics module, 1-6

fluorescent light (FL)
collection, 3-2

folder hierarchy management
electronic record management, B-2

four-quadrant gates
for dual-parameter plots, 2-40

front cover
removal, 12-1

FSC
define, Abbreviations-1

functions
software, 2-1

fuse
electronic devices, 1-8, 1-10
to replace, 12-2

G
gain

to adjust, 6-19
gate settings, 2-47
gates

to create, 6-8
gates for dual-parameter plots

four-quadrant gates, 2-40
lasso gates, 2-40
polygon gates, 2-40
rectangle gates, 2-40

gates for single-parameter plots
line-segment gates, 2-40
vertical gates, 2-40

GB
define, Abbreviations-1

Ghz
define, Abbreviations-1

Gr. Wt.
define, Abbreviations-1

graphic and gating styles, 2-39
graphics

printing, 6-46

H
H
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define, Abbreviations-1
hazard

laser, 10-1
hazards

laser beam, 10-2
radiation, 10-2

hazards/precautions, 10-1
heat map (plate loader)

creating, 6-33
deleting, 6-33
exporting, 6-33
modifying, 6-33
refreshing, 6-33

help menu, 2-26
help, Beckman Coulter Customer Support 

Center, ii
histogram

types of display, 3-4
histogram overlays

to create, 8-2
how to

use your manual, xxvii
humidity and temperature

installation environment validation, A-4
Hz

define, Abbreviations-1

I
IEC

define, Abbreviations-2
import

spectral library files, 7-23
unmixing settings from the spectral 

library, 7-17
unmixing settings from unmixing matrix 

files, 7-15
import and export unmixing matrix, 7-15
import spectral library files, 7-23
import unmixing settings from the spectral 

library, 7-17
import unmixing settings from unmixing 

matrix files, 7-15
important

define, v
importing

data, 8-1
instrument settings, 6-44
lot-specific target values, 5-4
previously acquired data, 8-1

standardization item, 5-37
importing an experiment/template

electronic record management, B-3
information

ordering, 1-12
initializing the instrument, 4-7
inspecting materials

unpacking, A-5
inspection

liquid flow tubing, 12-2
pre-boot, 4-1

inspection when unpacking, A-5
installation

environment validation, A-2
instrument, A-1
software, A-7

installation category, 1-13
installation environment validation

ventilation and cleaning, A-2
installation options

CytExpert, A-7
installing

Plate Loader module, 12-2
installing security updates, E-62
installing the instrument, A-6
installing the instrument and connecting the 

equipment, A-6
unpacking inspection, A-6

instrument
components, 1-1
initializing, 4-7
inspecting materials, A-5
installation, A-1
installing, A-6
maintenance, 12-1
shut off, 9-1
transportation and storage, A-1
unpacking, A-5, A-6

instrument characteristics, 1-13
instrument components

Cytometer, 1-2
Fluid Containers/Cubitainers, 1-2
Workstation, 1-2

instrument configuration
unpacking inspection, A-5

instrument settings
exporting, 6-45
importing, 6-44
importing and exporting, 6-44

instrument specifications, 1-13
    Index-7
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instrument transport or storage
to prepare, 11-1

IR
define, Abbreviations-2

items
adding for standardization, 5-23
deleting for standardization, 5-37
duplicating for standardization, 5-37
editing for standardization, 5-37
exporting for standardization, 5-37
importing for standardization, 5-37

K
kg

define, Abbreviations-2
KO

define, Abbreviations-2

L
L

define, Abbreviations-2
laser

hazards, 10-1
settings, 6-19
target power settings (CytoFLEX LX 

only), 6-19
laser beam

hazards, 10-2
laser delay

to set, 12-2
laser lines, 1-14
laser target power settings (CytoFLEX LX 

only), 6-19
laser wavelength, 1-14
lasso gates

for dual-parameter plots, 2-40
launching the software, 2-1
LED

define, Abbreviations-2
Levey-Jennings charts

to create, 5-18
light collection, separation and measurement

description, 3-2
line segment gates

for single-parameter plots, 2-40
liquid flow tubing

inspection, 12-2
liquid flow tubing inspection

routine maintenance, 12-2
LJ

define, Abbreviations-2
load button

electronic devices, 1-8, 1-10
load sample and record data, 7-9
locking

account, 4-6
log

electronic record management, B-3
user management operation, 2-39

log in
software, 4-3

log menu, 2-26
lot-specific target values

to import, 5-4
LWH

define, Abbreviations-2

M
m

define, Abbreviations-2
main components, 1-2
maintenance

instrument, 12-1
See also routine maintenance; nonscheduled 

maintenance
maintenance reminder

to manage, 12-1
malware detection software, E-27
manage

spectral library, 7-23
manage spectral library, 7-23

delete spectral library files, 7-26
export spectral library files, 7-25
import spectral library files, 7-23

management
user, E-63

managing
maintenance reminder, 12-1

manual
about, xxvii
adjust compensation, 7-27

manual fine adjustment, 7-27
manuals

updating, iii
material safety data sheets, 1-18
material safety data sheets (MSDS/SDS)

how to order, 1-18
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maximum altitude, 1-13
MB

define, Abbreviations-2
menu

account, 2-25
acquisition and analysis screen, 2-20
advanced, 2-25
cytometer, 2-21
files, 2-20
help, 2-26
log, 2-26
QC/Standardization, 2-24
settings, 2-24
signature, 2-26
software, 2-18

menu tree
software, 2-18

MFI
define, Abbreviations-2

MHz
define, Abbreviations-2

min
define, Abbreviations-2

mixer settings
to change, 12-2

mL
define, Abbreviations-2

mm
define, Abbreviations-2

modifying
heat map (plate loader), 6-33
users, 2-30
well settings with plate loader, 6-7

modifying well settings, 6-7
applying existing well settings to additional 

wells, 6-7
moving well location [with plate loader], 6-7

movement
adjusting for autogates, 6-17

moving
well location [with plate loader], 6-7

MSDS (material safety data sheets)
how to order, 1-18

multiple tube plots
export as picture files, 6-43

multiple tube statistics table
export as picture files, 6-43

mW
define, Abbreviations-2

N
NA

define, Abbreviations-2
NaClO

define, Abbreviations-2
NaN3

define, Abbreviations-2
navigation

acquisition screen, 2-5
QC screen, 2-17

new experiment
creating, 6-1

new experiment with plate loader
creating, 6-1, 6-2

nm
define, Abbreviations-2

nonscheduled cleaning, 11-1
nonscheduled maintenance

adding the Deep Clean solution, 12-1
calibrating the sample flow rate, 12-2
calibrating the sample flow rate with plate 

loader, 12-2
preparing the instrument for storage or 

transport, 11-1
replacing the fuse, 12-2

nonscheduled replacement/adjustment, 12-2
note

define, v
Nt. Wt.

define, Abbreviations-2

O
open a spectral unmixing experiment

start page operations, 2-3
open an experiment

start page operations, 2-3
open software, 4-3
opening

analysis screen, 8-2
operating system patching, E-52
optical

components, 1-4
optical bench

optical component, 1-4
optical components

detector (WDM), 1-4
optical bench, 1-4
optical fiber, 1-4
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optical fiber, 1-4
ordering

customer-replaceable parts, F-1
ordering information, 1-12
overlay dot plots, 2-39
overlay histograms, 2-39
overview

document, xxvii

P
page setup settings, 2-47
parameters

description, 3-4
duplicating standardization items, 5-37
editing standardization items, 5-37
TIME, 3-4

password
change, 2-32
default, 2-28
forgot password, 2-33
reset, 2-31

PB
define, Abbreviations-2

PC5
define, Abbreviations-2

PC5.5
define, Abbreviations-2

PC7
define, Abbreviations-2

PE
define, Abbreviations-2

PEEK
define, Abbreviations-2

PerCP
define, Abbreviations-2

performance characteristics, 1-16
sample injection mode control knob, C-1

performing
daily quality control, 5-1

PI
define, Abbreviations-2

picture files
to export, 6-43

plate holder
components, 1-6

plate holder with plate loader
replacing, 12-2

plate loader
components, 1-6

Plate Loader module
installing, 12-2
removing, 12-2

plate loader PEEK tubing
replacing, 12-1

plate loader PEEK tubing (replacing)
routine maintenance, 12-1

plate position [with plate loader]
calibrating, 12-2

plate type, 2-40
add, 2-40

plate type library, 2-40
add a plate type, 2-40
delete a plate type, 2-41
duplicate a plate type, 2-40
edit a plate type, 2-40

plot area
acquisition screen, 2-10

plot display conditions
to set, 6-24

plot settings, 2-46
plots

dual-parameter, 2-39
overlay dot plots, 2-39
overlay histograms, 2-39
single-parameter, 2-39
to create, 6-8
to set, 8-2
types of display, 3-4

PN
define, Abbreviations-2

policies
account, 2-36

pollution degree, 1-13
polygon gates

for dual-parameter plots, 2-40
position

sample tube holder, 1-6
power source

installation environment validation, A-3
power source inspection

pre-boot, 4-2
power switch

electronic devices, 1-8, 1-10
pre-boot inspection, 4-1

check waste and reagent levels (10 L fluid 
cubitainers), 4-1

check waste and reagent levels (4 L fluid 
containers), 4-1
    Index-10



Index

  
power source inspection, 4-2
workstation connections inspection, 4-2

precaution
disposal, 10-6

precautions
safety, -vi

precautions/hazards, 10-1
preparation process

QC sample (CytoFLEX Daily IR QC 
Fluorospheres), 5-3

QC sample (CytoFLEX Daily IR QC 
Fluorospheres) with plate loader, 5-4

QC sample (CytoFLEX Daily QC 
Fluorospheres), 5-18

QC sample (CytoFLEX Ready to Use Daily QC 
Fluorospheres), 5-3, 5-4

prepare
unmixing sample, 7-1

preparing
Deep Clean solution, 12-1
instrument for storage or transport, 11-1
QC sample, 5-3
QC sample with plate loader, 5-3
spectral unmixing sample, 7-2
Standardization sample, 5-18
the cleaning solution, 9-1

preparing QC sample
required materials, 5-3, 5-18

preparing QC sample with plate loader
required materials, 5-3

press
conventions, xxix

previously acquired data
to import, 8-1

previously acquired experiment
to copy, 8-1

priming
flow cell, 12-2

print
experiment signature, B-4

printing
graphics, 6-46

procedure
Deep Clean, 11-1

product description, 1-1

Q
QC

applying standardization, 5-32, 5-35

define, Abbreviations-2
result manager, 5-18
standardization, 5-19

QC data
collecting, 5-7

QC data with plate loader
collecting, 5-11

QC experiment screen, 2-16, 2-17
QC menu tree

software, 2-19
QC report screen, 2-16
QC sample

preparation, 5-3
QC sample (CytoFLEX Daily IR QC 

Fluorospheres)
preparation process, 5-3

QC sample (CytoFLEX Daily IR QC 
Fluorospheres) with plate loader

preparation process, 5-4
QC sample (CytoFLEX Daily QC Fluorospheres)

preparation process, 5-18
QC sample (CytoFLEX Ready to Use Daily QC 

Fluorospheres)
preparation process, 5-3, 5-4

QC sample with plate loader
preparation, 5-3

QC screen
navigation, 2-17

QC software menu tree, 2-19
QC/Standardization menu, 2-24
Quality Control, 5-2
quality control, 5-2

perform daily, 5-1
quality control (QC)

define, 5-1

R
radiation

hazards, 10-2
RAM

define, Abbreviations-2
rCV

define, Abbreviations-2
reagent

limitations, 1-18
reagent levels (10 L fluid cubitainers)

check, 4-1
reagent levels (4 L fluid containers)

check, 4-1
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reagent limitations, 1-18
recovery key, E-13
rectangle gates

for dual-parameter plots, 2-40
refreshing

heat map (plate loader), 6-33
reinstall

CytExpert for Spectral software, A-8
removal procedures

front cover, 12-1
right-side cover, 12-1

removing
Plate Loader module, 12-2

replacement
nonscheduled, 12-2
routine, 12-1

replacing
10 L sheath fluid cubitainer, 12-1
fuse, 12-2
plate holder with plate loader, 12-2
plate loader PEEK tubing, 12-1
sample peristaltic pump tubing for sample 

loading, 12-1
sheath fluid filter, 12-1
sheath fluid harness and/or waste 

harness, 12-2
replacing the peristaltic pump for sample 

loading
routine maintenance, 12-1

replacing the sample probe for plate loader
routine maintenance, 12-1

replacing the sheath fluid filter
routine maintenance, 12-1

required materials
QC sample preparation, 5-3, 5-18
QC sample preparation with plate loader, 5-3

reset
password, 2-31

restore, 10-8
result manager

QC, 5-18
results

confirming, 5-15
to export, 8-3

retention period
setting, B-4

retract
electronic signature, B-4

RH

define, Abbreviations-2
right-side cover

removal, 12-1
RoHS

define, Abbreviations-2
role management, 2-36
routine cleaning, 11-1
routine maintenance

cleaning the 4 L sheath fluid container, 11-1
cleaning the 4 L waste container, 11-1
cleaning the sample station, 11-1
daily startup and shutdown, 11-1
daily startup and shutdown with plate 

loader, 11-1
Deep Clean, 11-1
liquid flow tubing inspection, 12-2
replacing the plate loader PEEK tubing, 12-1
replacing the sample peristaltic pump 

tubing for sample loading, 12-1
replacing the sheath fluid filter, 12-1

routine replacement/adjustment, 12-1
RPTM

define, Abbreviations-2
running

system startup program, 4-7
system startup program with plate 

loader, 4-7

S
S/N

define, Abbreviations-2
safety

precautions, -vi
sample

checks before running, 6-33
flow, description, 3-1

sample acquisition position
sample tube holder position, 1-6

sample flow
description, 3-1

sample flow rate
calibrating, 12-2

sample flow rate with plate loader
calibrating, 12-2

sample injection control knob
performance characteristics, C-1

sample injection mode
selecting, 4-6
to use manual injection mode, 4-6
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to use plate loader injection mode, 4-7
to use semi-automatic injection mode, 4-6

sample injection mode control kit
components, C-1

sample loading position
sample tube holder position, 1-6

sample peristaltic pump tubing
to replace, 12-1

sample peristaltic pump tubing for sample 
loading

to replace, 12-1
sample peristaltic pump tubing for sample 

loading (replacing)
routine maintenance, 12-1

sample probe
to unclog, 12-1

sample probe change
from plate loader to single tube sample 

station, 12-2
from single tube sample station to plate 

loader, 12-1
sample probe for plate loader

replacing, 12-1
sample probe for sample loading

to replace, 12-1
sample probe for sample loading (unclogging)

routine maintenance, 12-1
sample probe switch

from plate loader to single tube sample 
station, C-1

from single tube sample station to plate 
loader, C-1

sample station, 1-6
to clean, 11-1

sample station (cleaning)
routine maintenance, 11-1

sample tube holder position
sample acquisition position, 1-6
sample loading position, 1-6
standby position, 1-6

sample wells with plate loader
setting, 6-2

sampling
data, 6-33

save
spectral unmixing experiment, 7-14

save spectral unmixing experiment, 7-14
saving

experiment, 6-46
screen

acquisition, 2-4
analysis, 2-13, 8-1, 8-2
QC experiment, 2-16, 2-17
QC report, 2-16
software, 2-2
Spectral Unmixing experiment, 2-14

SDS (safety data sheets)
how to order, 1-18

SDS/MSDS, 1-18
select

conventions, xxix
selecting

proper sample injection mode, 4-6
service, contact information, ii
setting

channel, 6-7
collection conditions, 6-24
custom statistics, 6-19
customized parameters, 6-17
laser delay, 12-2
laser target power settings (CytoFLEX LX 

only), 6-19
plot display conditions, 6-24
retention period, B-4
sample wells with sample wells, 6-2
signature, B-4
the plots and statistics, 8-2

settings
acquisition, 6-19
experiment, 2-45
gate, 2-47
laser, 6-19
page setup, 2-47
plot, 2-46
software, 2-45
tube, 2-46

settings menu, 2-24
sheath fluid cubitainer 10 L

replacing, 12-1
sheath fluid filter

to replace, 12-1
sheath fluid filter (replacing)

routine maintenance, 12-1
shut off

the instrument, 9-1
shutdown

automatic, 9-2
shutdown daily

routine maintenance, 11-1
shutdown daily with plate loader
    Index-13
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routine maintenance, 11-1
side scatter (SS)

collection, 3-2
sign

experiment, B-4
signals

processing of, operation principles, 3-3
signature

setting, B-4
signature menu, 2-26
single-parameter plots, 2-39
SNR

define, Abbreviations-2
software

functions, 2-1
launching, 2-1
log in, 4-3
main screen, 2-2
open, 4-3
to start, A-19

software installation, A-7
starting the software, A-19

software menu, 2-18
acquisition and analysis screen menu, 2-20
electronic record management, B-1

software menu tree, 2-18
software operations

create a new experiment, 2-3
software screen, 2-2

start page, 2-2
start page operations, 2-3

software settings, 2-45
specifications

characteristics, 1-13
instrument, 1-13

specimen
See sample

spectral library
manage, 7-23

spectral library files
delete, 7-26
export, 7-25
import, 7-23

spectral mode, 12-2
spectral unmixing

adjust, 7-15
to adjust, 7-15, 7-27

spectral unmixing controls
spectral unmixing experiment screen, 2-15

spectral unmixing experiment
create, 7-2
save, 7-14
to create, 7-2

spectral unmixing experiment screen, 2-14
spectral unmixing controls, 2-15

spectral unmixing experiment with plate loader
creating, 7-5

spectral unmixing sample
prepare, 7-2

SSC
define, Abbreviations-2

Standardization
loading standardization sample, 5-19
Target value, 5-19

standardization, 5-18
applying in QC, 5-32, 5-35

standardization item
adding, 5-23
deleting, 5-37
exporting, 5-37
importing, 5-37

standardization item parameters
duplicating, 5-37
editing, 5-37

Standardization sample
preparation, 5-18

standardization target library
deleting standardization target 

settings, 5-37
duplicate standardization target 

settings, 5-37
editing standardization target settings, 5-37
exporting standardization target 

settings, 5-37
importing standardization target 

settings, 5-37
standby position

sample tube holder position, 1-6
start page

main software screen, 2-2
selecting experiments, 4-7

start page operations
create a new experiment from a 

template, 2-3
create a spectral unmixing experiment, 2-3
exit the software, 2-3
main software screen, 2-3
open a spectral unmixing experiment, 2-3
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Beckman Coulter, Inc.

SOFTWARE END-USER LICENSE AGREEMENT

IMPORTANT: READ THIS END-USER LICENSE AGREEMENT:

THIS END-USER LICENSE AGREEMENT (“Agreement”) GOVERNS THE USE OF CERTAIN COMPUTER 
PROGRAMS ASSOCIATED WITH THE CORRESPONDING PRODUCT (“Product”) OF BECKMAN COULTER, INC. OR 
ITS AFFILIATES (“BCI”). YOUR USE OF SUCH COMPUTER PROGRAMS, YOUR PURCHASE OF THE PRODUCT, 
AND/OR YOUR USE OF THE PRODUCT CONSTITUTES ASSENT AND ACCEPTANCE OF THIS AGREEMENT BY 
YOU (collectively “You” or “Your”) AND SIGNIFIES YOUR AGREEMENT TO BE BOUND BY THE TERMS AND 
CONDITIONS OF THIS AGREEMENT. IF YOU DO NOT AGREE WITH ALL OF THE TERMS AND CONDITIONS OF 
THIS AGREEMENT, YOU DO NOT HAVE THE RIGHT TO AND MAY NOT USE THE COMPUTER PROGRAMS 
PROVIDED. 

1. GRANT OF LICENSE. Subject to all of the terms and conditions of this Agreement, BCI grants to You a 
non-exclusive, non-sub licensable license to use the computer programs provided by BCI (“Programs”) 
in connection with and/or installed on the Product, and the associated user documentation 
(“Documentation”) (together with the Programs referred to herein, collectively, as the (“Software”)), 
only in accordance with the Documentation (“License”). You have no right to receive, use or examine any 
source code or design documentation relating to the Programs. The Software is licensed and not sold. As 
between the parties, BCI and its licensor retains all right, title and interest in and to the Software and any 
and all derivative works, except as expressly and unambiguously licensed herein, and BCI reserves all 
rights in the Software not granted to You. Except as otherwise expressly provided under the Agreement, 
You shall only use the Software for Your internal research and development purposes. 

2. USE RESTRICTIONS. You shall not (and shall not allow others to), directly or indirectly:

a. use (including make any copies of) the Programs beyond the scope of the license granted under 
Section 1.; 

b. modify, translate, adapt, or otherwise create derivative works or improvements, whether or not 
patentable, of the Programs or any part thereof; 

c. combine the Programs or any part thereof with, or incorporate the Programs or any part thereof in, 
any other programs; 

d. reverse engineer, disassemble, decompile, decode, or otherwise attempt to derive or gain access to 
the source code of the Programs or any part thereof; 

e. reverse engineer, disassemble, decompile, decode, or otherwise attempt to derive or gain access to 
the object code of the Programs or any part thereof; 

f. remove, delete, alter, or obscure any trademarks or any copyright, trademark, patent, or other 
intellectual property or proprietary rights notices provided on or with the Software, including any 
copy thereof; 

g. rent, lease, lend, sell, sub license, assign, distribute, publish, transfer, or otherwise make available 
the Programs, or any features or functionality of the Programs, to any third party for any reason, 
whether or not over a network or on a hosted basis, including in connection with the Internet or any 
web hosting, wide area network (WAN), virtual private network (VPN), virtualization, time-sharing, 
service bureau, software as a service, cloud, or other technology or service; 

h. use the Software in, or in association with, the design, construction, maintenance, or operation of 
any hazardous environments or systems;

i. use the Software in violation of any law, regulation, or rule; or 

j. use the Software for purposes of competitive analysis of the Programs, the development of a 
competing software product or service, or any other purpose that is to BCI’s commercial 
disadvantage.
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3. TERMINATION. The License is effective until terminated. You may terminate the Agreement and the 
License at any time by destroying all copies of the Programs. The License will terminate automatically 
without notice if You fail to comply with any provision of this Agreement. Within fourteen (14) days 
following termination, You shall cease all use of, and, destroy all copies of the Software in Your 
possession or control and so certify to BCI in writing. Except for the License, the terms of this Agreement 
shall survive termination. Termination is not an exclusive remedy and all other remedies will be 
available to BCI whether or not the License is terminated.

4. SOFTWARE SUPPORT. Please refer to the BCI support number provided in the Documentation for the 

Product for information regarding support of the Product. 

5. DISCLAIMER OF WARRANTY. THE SOFTWARE IS PROVIDED TO YOU “AS IS” AND WITH ALL FAULTS AND 
DEFECTS WITHOUT WARRANTY OF ANY KIND. TO THE MAXIMUM EXTENT PERMITTED UNDER 
APPLICABLE LAW, BCI, ON ITS OWN BEHALF AND ON BEHALF OF ITS AFFILIATES AND ITS AND THEIR 
RESPECTIVE LICENSORS AND SERVICE PROVIDERS, EXPRESSLY DISCLAIMS ALL WARRANTIES, 
WHETHER EXPRESS, IMPLIED, STATUTORY, OR OTHERWISE, WITH RESPECT TO THE SOFTWARE, 
INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, 
TITLE, AND NON-INFRINGEMENT, AND WARRANTIES THAT MAY ARISE OUT OF COURSE OF DEALING, 
COURSE OF PERFORMANCE, USAGE, OR TRADE PRACTICE. WITHOUT LIMITATION TO THE FOREGOING, 
BCI PROVIDES NO WARRANTY OR UNDERTAKING, AND MAKES NO REPRESENTATION OF ANY KIND 
THAT THE LICENSED SOFTWARE WILL MEET YOUR REQUIREMENTS, ACHIEVE ANY INTENDED RESULTS, 
BE COMPATIBLE, OR WORK WITH ANY OTHER SOFTWARE, APPLICATIONS, SYSTEMS, OR SERVICES, 
OPERATE WITHOUT INTERRUPTION, MEET ANY PERFORMANCE OR RELIABILITY STANDARDS OR BE 
ERROR FREE, OR THAT ANY ERRORS OR DEFECTS CAN OR WILL BE CORRECTED.

6.  LIMITATION OF LIABILITY. TO THE FULLEST EXTENT PERMITTED UNDER APPLICABLE LAW:

a. IN NO EVENT WILL BCI OR ITS AFFILIATES, OR ANY OF ITS OR THEIR RESPECTIVE LICENSORS OR 
SERVICE PROVIDERS, BE LIABLE TO YOU OR ANY THIRD PARTY FOR ANY USE, INTERRUPTION, 
DELAY, OR INABILITY TO USE THE SOFTWARE; LOST REVENUES OR PROFITS; DELAYS, 
INTERRUPTION, OR LOSS OF SERVICES, BUSINESS, OR GOODWILL; LOSS OR CORRUPTION OF DATA; 
LOSS RESULTING FROM SYSTEM OR SYSTEM SERVICE FAILURE, MALFUNCTION, OR SHUTDOWN; 
FAILURE TO ACCURATELY TRANSFER, READ, OR TRANSMIT INFORMATION; FAILURE TO UPDATE OR 
PROVIDE CORRECT INFORMATION; SYSTEM INCOMPATIBILITY OR PROVISION OF INCORRECT 
COMPATIBILITY INFORMATION; OR BREACHES IN SYSTEM SECURITY; OR FOR ANY 
CONSEQUENTIAL, INCIDENTAL, INDIRECT, EXEMPLARY, SPECIAL, OR PUNITIVE DAMAGES, 
WHETHER ARISING OUT OF OR IN CONNECTION WITH THIS AGREEMENT, BREACH OF CONTRACT, 
TORT (INCLUDING NEGLIGENCE), OR OTHERWISE, REGARDLESS OF WHETHER SUCH DAMAGES 
WERE FORESEEABLE AND WHETHER OR YOU WERE ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES;

b. IN NO EVENT WILL THE COLLECTIVE AGGREGATE LIABILITY OF BCI AND ITS AFFILIATES, 
INCLUDING ANY OF THEIR RESPECTIVE LICENSORS AND SERVICE PROVIDERS, UNDER OR IN 
CONNECTION WITH THIS AGREEMENTOR ITS SUBJECT MATTER, UNDER ANY LEGAL OR EQUITABLE 
THEORY, INCLUDING BREACH OF CONTRACT, TORT (INCLUDING NEGLIGENCE), STRICT LIABILITY, 
AND OTHERWISE, EXCEED TWO HUNDRED AND FIFTY DOLLARS (US$250); AND

c. THE LIMITATIONS SET FORTH IN THIS SECTION 6. SHALL APPLY EVEN IF YOUR REMEDIES UNDER 
THIS AGREEMENT FAIL OF THEIR ESSENTIAL PURPOSE.

7. U.S. GOVERNMENT RIGHTS. The Software is commercial computer software, as such term is defined in 
48 C.F.R. §2.101. Accordingly, if You are the US Government or any contractor therefor, You shall receive 
only those rights with respect to the Software as are granted to all other end users under license, in 
accordance with 

a. 48 C.F.R. §227.7201 through 48 C.F.R. §227.7204, with respect to the Department of Defense and their 
contractors, or

b. 48 C.F.R. §12.212, with respect to all other US Government licensees and their contractors.
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8. EXPORT REGULATION. The Software may be subject to US export control laws, including the US Export 
Administration Act and its associated regulations. You shall not, directly or indirectly, export, re-export, 
or release the Software to, or make the Software accessible from, any jurisdiction or country to which 
export, re-export, or release is prohibited by law, rule, or regulation. You shall comply with all applicable 
federal laws, regulations, and rules, and complete all required undertakings (including obtaining any 
necessary export license or other governmental approval), prior to exporting, re-exporting, releasing, or 
otherwise making the Software available outside the US.

9. INTELLECTUAL PROPERTY RIGHTS. You acknowledge and agree that the Software is provided under 
license, and not sold, to You. You do not acquire any ownership interest in the Software under this 
Agreement, or any other rights thereto, other than to use the same in accordance with the license 
granted and subject to all terms, conditions, and restrictions under this Agreement. BCI shall retain its 
entire right, title, and interest in and to the Software and all intellectual property rights arising out of or 
relating to the Software, except as expressly granted to You in this Agreement. You shall use 
commercially reasonable efforts to safeguard all Software (including all copies thereof) from 
infringement, misappropriation, theft, misuse, or unauthorized access.

10. THIRD PARTY COMPONENTS; ADDITIONAL TERMS. The Software may contain or be delivered with one 
or more components, which may include third-party components, identified by BCI in the 
Documentation, readme.txt file, third-party click-accept or elsewhere (e.g., on www.beckman.com or 
attached to this Agreement as an appendix) (the “Identified Component(s)”) as being subject to different 
license agreement terms, disclaimers of warranties, limited warranties or other terms and conditions 
(collectively, “Additional Terms”) than those set forth herein. You agree to the applicable Additional 
Terms for any such Identified Component(s).

11. MISCELLANEOUS. You may not assign this Agreement or any of Your rights hereunder without BCI's 
prior written consent and any attempt to do so without such consent shall cause this Agreement and any 
of Your associated rights hereunder to be null and void. No failure to exercise any right hereunder will 
operate as a waiver thereof. If any provision of this Agreement shall be adjudged by any court of 
competent jurisdiction to be unenforceable or invalid, that provision shall be limited or eliminated to the 
minimum extent necessary so that this Agreement shall otherwise remain in full force and effect and 
enforceable. This Agreement shall be construed in accordance with the laws of the State of California and 
the United States without regard to conflicts of laws provisions thereof and without regard to the United 
Nations Convention on Contracts for the International Sale of Goods. The sole and exclusive jurisdiction 
and venue for any actions related to the subject matter hereof shall be the state and U.S. federal courts 
located in the County of Orange, California. You irrevocably submit to the jurisdiction of such courts and 
consent to venue in such forum with respect to any action or proceeding that relates to this Agreement. 
The prevailing party in any action to enforce this Agreement shall be entitled to recover its reasonable 
costs and expenses including reasonable attorneys' fees. No amendment to or modification of this 
Agreement will be binding unless in writing and signed by a duly authorized officer of BCI. This 
Agreement is in the English language only, which language shall be controlling and any revision of this 
Agreement in any other language shall not be binding. Both parties agree that this Agreement is the 
complete and exclusive statement of the mutual understanding of the parties relating to the subject 
matter of this Agreement.
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